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Welcome

WELCOME TO THE SQL SENTRY USER GUIDE!

Thank you for installing SQL Sentry. To get up and running in no time, please review the SQL
Sentry Quick Start Guide.

If you have any technical questions, or  for help with installation or configuration issues, please
don’t hesitate to contact us:

Email: support@salsentry.net

Phone: 704-895-6241
Toll Free: 855-775-7733

Support Forum: http://forum.sqglsentry.net/



mailto:support@sqlsentry.net
http://forum.sqlsentry.net/
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Installation and Maintenance

INSTALLATION AND MAINTENANCE
INSTALLATION

Please refer to the SQL Sentry Quick Start Guide for detailed instructions on installation and
setup of the SQL Sentry Client and the SQL Sentry Monitoring Service.

MAINTENANCE

Just as with any other SQL Server database, it is important that regular maintenance activities be
performed on the SQL Sentry database to ensure optimal performance. Please see the Repository
Maintenance topic for more details and recommendations.
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SQL Sentry Client

SQL SENTRY CLIENT OVERVIEW

The SQL Sentry  Client provides a  seamless experience for  SQL Server monitoring  and
optimization, query tuning, alerting, and job scheduling, all within the same thin client interface.

This section discusses the different elements of the SQL Sentry Client.

o Client Interface
¢ Navigator Pane
e Event View Pane
¢ Actions Pane
e Settings Pane
e Menus
e User Preferences
e License Management
e Security
e SQL Sentry Client Security
e Role Based Security
e Navigator
e Shared Groups
o Default Site
o Computers
e Connections
e Contact Management
¢ Monitoring Service
e Monitoring Service Settings
e Site Configuration
e Connections List

e Clustering

e Actions Log
e Service Configuration Utility

e Monitoring Service Logon Account
e Common Tasks
e Reporting

e Adding Notes
e \Watching Connections and Objects

e Connect to Installation

Client Interface

CLIENT INTERFACE

The SQL Sentry Client interface is divided up into three main areas. The first area, positioned
along the left side of the Client by default, contains the Navigator and Event View panes. The
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second area, positioned along the right side of the Client by default, contains the Actions and
Settings panes. The Workspace area occupies the center position. The SQL Sentry Client has
been designed with an enhanced multiple document interface (MDI). All panes are movable,
dockable, and resizable. The panes can also be set to auto-hide when not in use to allow for a
larger viewable Workspace area.

5 % i ¥ -
! -

WORKING WITH PANES

Both the Navigator and Event View panes and the Actions and Settings panes can be enabled
or disabled. In addition, the pushpin feature can be used to auto-hide the panes allowing for a
larger Workspace area. These panes can also be docked or undocked allowing the workspace
to be customized to best fit your work  style. In the event that the panes are closed they can
easily be restored from the View menu.

WORKSPACE LAYOUT

The dimensions of the Client Panes and Workspace Area are saved automatically when you
close the Client. The default configuration can be restored by selecting the Reset Layout
option from the Tools menu.

STATUS BAR

At the bottom of the SQL Sentry Client is a status bar divided into four sections. Each displays
information including:

. The current status for the active view (left)

] The current progress for the active view (middle)

. The current location of the active window relative to the navigation tree (right)

] The console alert status indicator (red - errors, yellow - warnings, green - all ok)
Jump to:

¢ Navigator Pane
e Event View Pane
o Actions Pane

e Settings Pane

e Menus

e User Preferences
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¢ License Management

Navigator Pane

NAVIGATOR PANE

The Navigator is the tree-view pane positioned on the left side of the client by default. The
various nodes within the Navigator are used as the starting point in directing many functions of
the SQL Sentry Client, such as viewing an Event Manager Calendar, or a Performance Advisor
Dashboard. The Navigator nodes are also used as the starting point to access the various
levels of Actions and Settings within  the Alerting and Response System . Right clicking on a
node will access its context menu.

NAVIGATOR PANE OVERVIEW

NAVIGATOR PANE ELEMENTS

Each object in your SQL Sentry Enterprise will have an associated icon. Several of the node
icons in the Navigator pane will vary based on conditions, such as  connection status, or
watched status.

CONNECTION STATUS

f@ A green arrow indicates that the Connection has an Online status.

A red circle indicates that the Connection has an Offline status.

F@ A red exclamation point indicates that the connection requires attention. Often
- associated with the SQL Server Agent being offline.

Connection Status is determined by the SQL Sentry Monitoring Service's _ ability to collect
information from the Connection. If a Connection has a green arrow this indicates that the
Connection has an  Online Status. If a connection has ared circle this indicates that a
Connection has an offline status.
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The following is a simplified  version of how Connection Status information is obtained and
displayed in the SQL Sentry Client.

1. The SQL Sentry Monitoring Service first gathers Connection Status information.
2. This Connection Status information is written to the SQL Sentry database.

3. The SQL Sentry Client retrieves this Connection Status information from the database
and displays it.

You can select any Connection node to access additional status information. A tool tip will
display the status (Offline/Online), the Last Monitoring Service  Connection Time, and any
applicable error information.

WATCHED STATUS

A Connection must first be setto ‘'Watched' before SQL Sentry will  begin monitoring it. To
'Watch'a Connection use the right-click context menu ofthe Connection (Watch ->
Connection -> Event Manager/Performance Advisor). Youcan also hide unwatched
Connections so they will not display in the Navigator Pane in the User Preferences (Tools ->
User Preferences -> Navigator -> Hide Unwatched Connections). For more information
about watching Connections and objects see the Watching Connections and Objects topic.

A grayed-out icon indicates that the Connection/object is not being watched.

A colored icon indicates that Connection/object is being watched.

CONNECTION ICONS
The different types of Connections are represented with  different icons. Refer to  the table

below.
SQL Server Connection
Ei SharePoint Server Connection
_{f:@ Analysis Services Connection
@ Windows Task Scheduler Connection
@ Oracle Database Connection

RED TEXT IN THE NAVIGATOR PANE

If the label text for a node is red this indicates that an event object has a recent failure. Failures
cascade from the object level up to the highest group level containing the object. You can clear
a job failure through the right-click context menu of the job, by selecting Cleared Failed Status.

ADDITIONAL INFORMATION

For additional information about the Specific nodes displayed in the Navigator Pane see the
Navigator topic.

Event View Pane

EVENT VIEW PANE
The Event View pane is used to filter what is shown in the Event Manager Calendar view.
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Removing Filters

Any filter settings can be removed from the active view by clickihg Remove Filter. This button
is not available on Custom Event Views and other views containing multiple connections, to
ensure a filter is always applied to these views and thus minimize the chance of overloading the
SQL Sentry Client with too much event data.

Saving a Filter as a View
To save the active filter settings to a Custom Event View, select Save View As ("Working With
Custom Event Views' in the on-line documentation) from the File menu.

PROPERTIES TAB

The Properties Tab displays basic descriptive information about the current view. Additionally,
this tab provides controls to set the default time slice for this view. This allows you to specify the
number of days, amount of time, and  start time shown for this view every time it is opened.
When a Performance Monitor is placed on a Custom Event View, it is applied to all monitorable
objects within the view. The View Totals box, at the bottom, allows you to see exactly how many
objects will be monitored.

The following are descriptions of the View Totals values.

e Connections - The total number of SQL Server instances and Windows Task Schedulers
associated with the view.

¢ Objects From Connections - Gives a count of all objects from those connections that meet
the filter criteria.

* Individual Objects - The number of objects added by the Edit Individual Objects button.
* Total Objects - The total objects in the view.

e Total Monitored Objects - The total amount of objects that actually have Performance
Monitors attached to them.

e Total Monitorable - The total number of those objects which can have Performance
Monitors attached to them (SQL Agent Jobs, Reporting Services Reports, and Windows
Tasks).

Actions Pane

ACTIONS PANE

The Actions pane is displayed on the right side  of the SQL Sentry  Client by default. The
Actions pane is used to configure Actions in response to Conditions being met, as part of the SQL
Sentry Alerting and Response System.

Actions can be defined in response to certain Conditions being met within your environment. You
can choose from a variety of Actions, depending on which Condition is being responded to.

All Actions work on the principle of inheritance. This means that if you configure an  Action in
response to a Condition being met at the Global level ( Shared Groups), it will be automatically

passed down to all applicable objects below it. This allows you to define Global Actions for the
most common issues across your environment once, and have those passed down to every
monitored server automatically. You can further refine  Actions at each level as needed. For a
visual representation of how inheritance works within SQL Sentry see the Alerting and Response
System Hierarchy diagram ('Alerting and Response System' in the on-line documentation).
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Each Action that you configure in your environment will have an associated behavior. The
behavior controls how the Action will be carried out relative to any inherited Actions. There are
three Action behaviors available: Override Inherited Actions, Combine with Inherited Actions,
and Disabled. For a complete explanation and example usage scenario for each behavior see the
Action Behavior (‘Actions’ in the on-line documentation) section topic.

VIEW

The Actions pane is displayed on the right side of the screen by default. If you do not see the
Actions pane, use the View menu. (View -> General Actions/Failsafe Actions/Audit Actions)

Each Condition type has an associated Actions tab where Actions can be configured in response
to Conditions being met.

The Actions pane sections:

Inherited - This section displays the configured Actions that are being inherited by the currently

selected object.
¢ Configured Actions in the Inherited Section have a Status column which indicates if they

apply to the currently selected object.
¢ Configured Actions with a Status of Enabled have Green text.

e Configured Actions with a Status of Disabled are grayed out.

Explicit - This section displays the configured Actions that are explicitly set at the current object

level.
e An Action that is Explicitly disabled will have Red text.

e Configured Actions with a Status of Enabled have Green text.

Settings Pane

SETTINGS PANE

The Settings pane is where settings are configured for connections, sources, and objects. This
tab is also where performance counter thresholds are configured when a counter is selected.
Settings can be configured globally, at the connection level, or at the object level, and just like
Actions they work on the principle of inheritance. See Actions Pane for more information.

i

CONNECTION SETTINGS

Connection settings can be applied at the global level or for an individual connection. To adjust
the settings at the global level, select the devices node and then  select the Settings tab to
display. There arethree types of settingsfor a connection; Maintenance Window ,
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Miscellaneous and Synchronization.

MAINTENANCE WINDOW SETTING

Maintenance Window settings allow a time frame to be specified where Failsafe Notifications
('Recommended Global Conditions' in the on-line documentation) will be disabled while
daily maintenance activities take place on  that connection. This  will prevent excessive
notifications that may occur ifa watched connection is temporarily inaccessible during these
activities. Log Actions will still be enabled during this window, but any Execute or Send Actions
will not fire.

MISCELLANEOUS SETTING (SQL SERVER 2005 AND ABOVE)

Auto-enable SQL Server Agent Tokens

On SQL Server 2005 and above, SQL Server Agent Tokens are disabled as a security
measure. They must be enabled to allow  SQL Sentry to watch  Alerts on these servers.
Selecting True allows SQL  Sentry to automatically enable  these tokens when an  Alert is
watched on a 2005 and above server. More information can be found in  SQL Server Books
Online.

Auto-Recycle large SQL Server Agent Logs
This setting determines whether or not  to automatically recycle large agent log files in SQL
Server 2005 and above.

Maximum Queue Length
This setting specifies the maximum number  of jobs that can be queued at one time on this
server. See Job Queuing for more information. The default setting is 5.

Collect Memory by Category Data (SSAS)

This setting is used to provide more detail than the basic Cleaner memory data, but is higher
overhead to collect. Use caution when enabling to ensure it does not impact performance .
The default value for this setting is False.

SYNCHRONIZATION

Synchronization Type

This setting refers to how the SQL Sentry Client will respond if it discovers the data in the SQL
Sentry repository is not up  to date. The defaultis to show a message box warning of the
condition and asking if the SQL Sentry Client should synchronize the information itself.

Synchronization Threshold
The amount of time that must pass since the last successful synchronization by the SQL Sentry
Monitoring Service before the Client attempts to synchronize directly with the target.

I, IMPORTANT: This situation may suggest that the SQL Sentry Monitoring Service is not retrieving data from this
connection. If this is the case, verify that the SQL Sentry Monitoring Service is running, and check for any entries
in the Failsafe log.

EVENT OBJECT SETTINGS

To display the Settings for an object type, select the object in either the  Navigator or on the
Calendar, then select the Settings tab. For each category in  the drop-down list for the  job,
global settings are displayed. This means that it will be automatically inherited by all SQL Agent
Jobs unless overridden at the individual connection or job level.


http://msdn.microsoft.com/en-us/library/ms130214.aspx
http://msdn.microsoft.com/en-us/library/ms130214.aspx
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[# NOTE: Not all event types have object settings, for example, Maintenance Plans or SQL Server Agent Log.

Queuing Settings

For SQL Server Agent Jobs only, the Settings screen is used to  configure a job’s behavior
when queuing another job, or when it is queued by another job. See Job Queuing for more
information.

RUNTIME THRESHOLDS SETTINGS

In the Runtime Thresholds section, a value for Minimum Runtime Threshold Percent and
Maximum Runtime Threshold Percent can be specified. For the global Minimum Threshold,
10% is usually a good starting value, and for the Maximum Threshold, 250% is usually a good
starting value. This means that anytime a job runs for less than 10% or longer than 250% of it's
average runtime a notification will be  sent. If too many messages are  being received, these
settings can be adjusted as needed.

Explicit time-based thresholds can also be specified. Anytime an explicit time-based threshold
is specified it  will override the percentage based thresholds for that object. Time-based
thresholds are usually less  valuable at the global level, particularly the Minimum  Runtime
Threshold which doesn't have much value at all globally. Explicit runtime thresholds tend to be
more applicable at the actual connection or object level for overriding the global percentage
thresholds on a case-by-case basis.

[# NOTE: One notification will  be sent once the Maximum Runtime Threshold has beenmetanda separate
notification will be sent once it has completed.

For example, consider a job that has a great deal of volatility in runtime such as a transaction
log backup, which can run for anywhere between 30 seconds and 30 minutes, and it's average
runtime is 5 minutes. To avoid unnecessary percentage-based threshold notifications for the
job, one option would be to setits Maximum Runtime Threshold to "35 Minutes" and
Minimum Runtime Threshold to "20 Seconds". This can be done by selecting either the job's
node in the Navigator or an instance of the job on the calendar, then follow the same steps as
above to access and change the job's runtime threshold settings.

[ NOTE: Runtime Threshold messages for Reporting Services Reports  completing in less than two minutes, and
DTS packages will not be processed until they are complete.

GENERAL EVENT SOURCE SETTINGS

Auto-watch New Objects

This setting determines whether or not SQL  Sentry will automatically watch any new objects
that appear for this event source. It is highly recommended that Auto-watch is set to True
for all sources at the global level , so that no new objects will slip through the cracks and be
missed by SQL Sentry. The default setting is True.

Maximum Rows to Synchronize

Use this setting to adjust the amount of historical data to collect from this source at any given

time. This setting is most applicable during the initial synchronization process, to prevent tens
or hundreds of thousands of rows from being synchronized from an existing server, which can
cause contention issues with the SQL Sentry database. The default setting is 5000.

Missed Run Threshold
The setting determines how much time must pass in order for an object run to be considered
missed. The default value for this setting is 5 minutes.
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PERFORMANCE COUNTER SETTINGS

The Performance Counter Settings screen is used to set the minimum and maximum values for
the counter thresholds of that particular counter. These will be used to trigger the Performance
Counter: Threshold Min and Max conditions if any actions are enabled for them. This option is
only available when selecting a specific performance counter from the Navigator Pane. There
can be only one minimum and one maximum value for a given counter, regardless of how many
objects are linked to the counter.

BLOCKING SQL SETTINGS

Collection Settings
The Minimum Block Duration setting determines how long blocking must occur before the
blocking condition is triggered. The default for this setting is 5 seconds.

TOP SQL SETTINGS

Runtime Thresholds

The Maximum Runtime Threshold value is used when triggering the Top SQL: Runtime
Threshold Max condition. The default value is set to 1 hour at the global level and is set at lower
levels to be inherited by the parent. At each level, this value can be overridden or changed.

TOP SQL SOURCE SETTINGS

Collection Settings

The Minimum Duration setting determines the required duration fora Top SQL event to be
collected. The default settingis 5 seconds. For safety reasons, it cannot  be reduced below
100ms unless one of the CPU, Reads or Writes filters is >0.

The Minimum CPU, Minimum Reads, and Minimum Writes settings can also be used to filter
the Top SQL events collected. These settings are 0 by default.

The Collect Trace Events, Collect Statement Events, and Collect Execution Plans settings
specify whether or not these are collected. All are set to True by default.

e |f Collect Trace Events is disabled, SQL Sentry will not start a trace or collect any Top SQL
events from a monitored target.

¢ |f Collect Statement Events is disabled, statement-level information will not be available in
the Plan Explorer Statements Tree when viewing a query plan.

» |f Collect Execution Plans is disabled, Top SQL event collection will occur as normal,
however query plan information will not be automatically collected for those events. Plan
information can still be collected on demand from within a Plan Explorer session, however.

i‘-. WARNING: On systems with very high transac tion volumes that also make extensive use of scalar functions,
enabling Collect Statement Events may cause a negative impact on the performance of the monitored target,
regardless of the effective Top SQL filter settings or the number of events actually collected. See also:
Performance impact: SQL trace and user defined scalar functions

The Running Events Polling Interval setting specifies how often the service checks for running
events, primarily for the purpose  of capturing query plan information.  This setting does not
impact the actual Top SQL events collected. The default is setting is 5 seconds.


http://sqlblog.com/blogs/linchi_shea/archive/2009/06/15/performance-impact-sql-trace-and-user-defined-scalar-functions.aspx
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DEADLOCK SOURCE SETTINGS

Collection Settings
This setting determines if the deadlock statement collection is enabled. The default value is
True.

SQL SERVER AGENT JOB SETTINGS

Queuing Settings
These settings are used to determine the behavior of a job when itis queuing other jobs or
when the job is being queued. For more information see Job Queuing.

SSAS SETTINGS

Collection Settings
The Minimum Duration value is the amount of time required for a statement to be logged. The
default for this setting is 1 second.

The Collect MDX/DMX/XMLA Events setting determines  whether or not the command
collection is enabled. The default setting is True.

Menus

MENUS

The menus and toolbars are used to operate the SQL  Sentry Client. The options available
within the menus will vary depending on the active window. For more  information about the
toolbars see the Performance Advisor toolbar ('SQL Sentry Performance Advisor'in the
on-line documentation) topic and the Event Manager toolbar topic.

Following are descriptions of the commands found in the various SQL Sentry menus.

The File Menu:

Item Hotkey Description

New Connection n/a Add a new connection to the Navigator Pane.

New Plan Explorer Session n/a Opens a new Plan Explorer Session.

Connect to Installation... n/a Specify the SQL  Sentry repository and  authentication
information for the console.

Save Ctrl+S Save changes to the active window.

Save View As n/a Rename and save the active view.

Open n/a Open Execution Plan files.

Close Ctrl+W Close the active window.

Export Data Ctrl+E Export Event Manager List Views and various tabs of
Performance Advisor.

Page Setup n/a Set the page options for printing.

Print n/a Print the active window.

Print Preview n/a Preview the active window for printing, exporting and send
email options.

Exit Ctr+Q Exit the SQL Sentry Client.
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Item

Description

Navigator View the Navigator Pane
Event View View the Event View Pane (‘Navigator Pane' in the on-line documentation)

General Actions

View the General Actions Pane

Settings

View the Settings Pane

Failsafe Actions

View the Failsafe Actions Pane (‘Alerting and Response System' in the on-
line documentation)

Audit Actions

View the Audit Actions Pane (‘Alerting and Response System'in the on-
line documentation)

Start Page

View the Start Page

The Calendar Menu:

Item

Show Conflicts

Description

Explore conflicts for specified time range.

View Style

Select the view style for Event Manager Calendar.

The Reports Menu:

Item

Event Manager

Description

Event Manager associated reports.

Performance Advisor

Performance Advisor associated reports.

General

General reports.

Report Deployment Settings

SQL Server Report Server location that you wish to deploy your reports.

Deploy Reports

Deploys the reports to  the location specified in  the Report Deployment
Settings.

Import Reports

Used to import future  reports created by the  SQL Sentry development
team.

The Tools Menu:

Item

Hotkey Description

User Preferences Ctrl+O Set the SQL Sentry Client User Preferences.

Find Object Ctrl+F Object search tool, used to find  Event Objects within
the SQL Sentry Client.

Manage Response Rulesets n/a Opens all Response Rulesets for editing.

Reset Event View Filter n/a Restores Event view Filter settings to default.

Reset Layout n/a Restores the Layout to default.

The Window Menu:

Item

Cascade

Description

Cascade active windows in the workspace view.

Tile Vertical

Tile active windows vertically in the workspace view.

Tile Horizontal

Tile active windows horizontally in the workspace view.

Tabbed

Display active windows on tabs in the workspace view.

Show Tabs on Multiple Line

Allows multiple rows of tabs to be displayed.

Auto-Rotate Performance Advisor Tabs Auto-rotates through the active Performance Advisor windows
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Item Description

when enabled. The rotation does not change the active tab of
a Performance Advisor window. Therefore, whichever tab is
selected as active will be refreshed as the windows rotate.

Active Windows Name All the Active Windows are listed here.

The Help Menu:

Item Hotkey Description

SQL Sentry Help Ctrl+H or F1 Opens the SQL Sentry User Guide.

SQL Sentry Quick Start Guide Ctrl+F Opens the SQL Sentry Quick Start Guide.

Setup Wizard n/a Starts the SQL Sentry Setup Wizard.

Check for Updates n/a Connects with  SQL Sentry's  online repository and
verifies that you have the latest version.

Manage Licenses n/a Opens the License Entry window wher e you can view
and manage SQL Sentry Licenses.

Start Remote Session n/a This is used to enter a Pin to launch a support session.

About n/a Displays current version, licensing information,
expiration.

[ NOTE: If a menu item is not applicable to the active selection, the item will be grayed out.

User Preferences

USER PREFERENCES

User Preferences allow you to customize the behavior and appearance of your SQL Sentry
Client. These settings will not affect those of other users. To review the user preferences set in
your SQL Sentry Client, select User Preferences from the Tools Menu. The Restore Defaults
command will reset all User Preferences to the default value.

CALENDAR

Settings Description

Calendar Refresh Interval Set the refresh rate for the Calendar

Show Events As Conflicts After Specify the duration that two or more event instances must
overlap before being shown as a conflict

Show Popups For Set the persistence of popup messages on the calendar

Default days for Global and Group views Set the default number  of days to display ~ when opening
these views

Persist Calendar Filter Between Views Select to save the filter settings between views

Auto-scroll Calendar to Current Time Select to enable Auto-Scroll for the Calendar after there has
been no user activity for a period of time.

Maximum rows to return for calendar/list views Limiting this value helps to avoid delays in loading views due
to a large volume of data.

Show Running and Historical Events in Recurring | This value determines what events will appearin the

Window if Duration Exceeds Recurring Window at the top of the Calendar view.

Default interval when using Jump To Set the time interval which will be shown  when using Jump

Instance context menus To Instance context menus

NAVIGATOR
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Settings Description

Highlight Event Failures in Navigator for Set the length of time to display
failed events in  red within the
Navigator. If  you enable the
Until Cleared option failures will
remainin red until they are

manually cleared.

Refresh Failures in Navigator Every Specify how often the Navigator
pane will be refreshed to  show
failures.

Show Failures for Unwatched Objects Enable this setting  to display

unwatched objects in red within
the Navigator pane after failure.

Hide Unwatched Connections Enable this  setting to hide
unwatched connections in the
Navigator pane.

Hide Unregistered Connections Enable this setting to  hide the
<UNASSIGNED> node so only
connections registered under
SQL Servers or Devices for the
SQL Sentry Client are shown.

Show SQL Servers Node Enable this setting to show the
SQL Servers Node which
mirrors  the  SQL  Server
registrations of the user.

Default Root Node for SQL Server Objects Select the default root node in
the Navigator that will be used
when "Jumping To" event
objects from the Calendar or
elsewhere in the SQL Sentry
Client.

Default Event View Style Select the default view to show
when opening an  Event
Manager Calendar.

Prompt me to select a product when left-clicking to open a node Determines whether or not to
prompt for the product to use
when opening a connection.
When unchecked the default
view for device/connection
nodes will be used.

Default view for Device/Connection nodes Determines what action SQL
Sentry will take when you click
on a Device or

Connection node.

Auto-synch Navigator with the selected tab Enable this settingto synch
objects selected in  the current
tab with the Navigator pane.

Auto-synch Settings/Actions with the selected tab Enable this settingto synch
objects selected in  the current
tab with the Set tings and
Actions Pane.

Single-click opens new tabs Enabling this setting  will allow
the opening of new tabs with a
single click.

Persist last "Jump To Time" value Enable this setting, and each

time the Jump to Time context
menu item is used, the previous
time selection will be highlighted
by default.

Show warning when Alert watch fails due to disabled SQL Agent Alert If enabled, SQL Sentry will warn
Tokens. you if you try to watch an Alert
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Settings Description

on a SQL Server 2005 and
above connection and don't
have Agent Tokens enabled.

Automatically clear open failures if a subsequent run is successful If enabled, SQL Sentry will clear
the failed object automatically if
the job has been successfully
run again after the failure
occurred.

Synchronize SQL Server registrations any time a registration group is | If enabled, SQL Sentry  will
expanded synchronize registered servers
under the SQL  Servers node
any time a registration group is
expanded. When not  checked,
the option to "Synchronize SQL
Server Groups..." can be used in
the Navigator pane to do this.

Manually manage folders for Reporting Services Allows you to create and
manage folders  beneath the
Reporting Services node.

COLORS

Most of the elements in the calendar view may have their colors customized. Beside each color
selection is a Pick button. When you select a Pick button, the Color palette is displayed. The
Default button is used to reset all colors to their defaults.

GRAPHS
Item Description
Maximum rows to return for runtime graphs Limits the amount of data shown in runtime
graphs for performance reasons.
Maximum rows to return for performance graphs Limits the amount of data shown in
performance graphs for performance reasons.
UPDATES

You may choose whether or not SQL  Sentry will automatically check for updates on  startup.
The default is checked. An Internet connection is required.

CLIENT ALERTS
Item Description
Disable Status Popups If enabled console  alert status message  popups will not be
displayed.
Client Alert Recurrence Interval This setting controls the recurrence interval for alert popups.
PERFORMANCE ADVISOR

Description

Show options on Quick Trace launch When checked, certain options are available
when a Quick Trace is launched manually.
When unchecked, the last options configured
will be used. Options include duration, rows to
collect, etc.
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Tab Auto-rotation Frequency When used in conjunction with "Window >
Auto-rotate Performance Advisor Tabs," it
determines how often the tab changes.

Performance Advisor Overview Refresh Interval Used to configure how often data is refreshed.
Performance Advisor Overview Skin Used to select the skin for overview.
Warn on Actual Plan Execution If this option is enabled, when the Actual Plan

command is selected the user will be asked to
'Confirm Query Execution' before the Plan will
be collected. You can disable these warnings
by unselecting this setting.

License Management

LICENSE MANAGEMENT
MANAGE LICENSES

You can manage your licenses within the SQL Sentry Client with the Manage Licenses command,
which can be found through the  Help Menu (Help menu -> Manage Licenses). The Manage
Licenses command will bring up the License Entry window.

Select Edit to update the license. Select Clear to clear the existing text. To enter a new license,
you can either copy and paste the license text into the window, or drag-and-drop a license file into
the space provided. Click Save to apply the license.

The SQL Sentry Client will be restarted to ensure that the new license settings take effect.

LICENSE OVERVIEW

If you would like to view additional license information such as the number of licenses applied
throughout the environment, you can use the About command, which can be found through the
Help Menu (Help menu - About).

To get an overview of how your licenses are  applied throughout your environment you can also
use the Connections node, which can be found in the SQL Sentry Monitoring Service group in the
Navigator Pane.

Double-clicking the Connections node will bring up the Connections Workspace Area, which will
list every connection that SQL Sentry has ever monitored. The two columns on the far right of the
connections list indicate whether the connection is currently being watched by Event  Manager
(EM), or by Performance Advisor (PA). A check mark indicates that the connectionis  currently
being watched. An empty check box indicates that the connection is not being watched.

If you would like to reclaim a license, click on the checkbox to stop watching that connection. That
license can then be applied to another connection as needed.

CHANGE HARDWARE KEY

The primary license contact may update the hardware key at any time by visiting the Customer
Portal. If you are planning on moving the repository database, please see the Relocating the SQL
Sentry Repository Database topic.

SEE ALSO
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Connections
Relocating the SQL Sentry Repository
Removing Connections

5.2  Security

SQL Sentry Client Security

SQL SENTRY CLIENT SECURITY

SQL Sentry supports the ability to restrict server visibility  within the SQL Sentry Client. Users
can be assigned to a Windows or SQL Server Authentication account (hereafter referred to as
an account), and users can be added to groups. Both users and groups can be assigned a
limited set of visible connections, effectively restricting what the logged-in user can  see. To
assign an account to a user:

1. Double-click on the user you wish to assign an account to, or select Open from the
context menu. If no user exists you can double-click on the Users node to create a new
user.

2. On the properties tab, the Login is the account that will be associated with rights in the
SQL Sentry Client.

3. To associate a user with an account, enter the account name in the Login field and save
the user.

The Rights tab, visible on both the User or Group editors, controls which connections are visible
to that user or group. To assign rights to a user or group:

1. On either the user or group editor, click the Rights tab at the top of the editor. This will list
the assigned connections for that user or group.

2. Select Add to open the list of available connections.

Select the connection(s) to configure rights for from the list.

4. The connections will be added to the Rights tab with checkboxes to Allow or Deny
visibility.

5. After saving the changes, the Login will only be able to see the connections in the Rights
tab that have Allow visibility. If no connections exist in the Rights tab, the user or group
can see all connections, unless they are a member of another group that has a restricted
set of visible connections.

w

Membership of the sysadmin fixed server role is needed to do the following actions (both
outlined above):

1. Edit the login associated with a user
2. Assign rights to users and groups

To ensure that a user has rights to login to the SQL Sentry database, but does not have rights
to modify their own permissions, add the user to the allow_all database role of the SQL Sentry
repository, and ensure the user is not a member of the db_datawriter role.

APPLICATION OF USERS/GROUPS RIGHTS:
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Scenario:

e There are 100 servers.
e There are 20 users.

e There needs to be two different groups Group A (10 Users) and Group B (10 Users)
with visibility to different servers.

¢ Group A should have access to servers 1-50
¢ Group B should have access to servers 51-100

¢ One of the users (AllIButOne) should have access to all but one of the servers allowed in
Group A and Group B.

Setup:

1. Add the 20 users in the console (Logins must be unique if provided).

2. Create a Group A with rights to servers 1-50 by adding them on the Rights tab and
checking Allow

3. Create a Group B with rights to servers 51-100 by adding them on the Rights tab and
checking Allow

4. Add the users to their respective groups on the Groups -> Properties tab.
Create user AllIButOne and add to both groups.

6. On the Rights tab for the AlIButOne select Deny for the server the user should not be
able to access.

o

SQL Sentry will check groups for restricted connections first. After the group membership has
been evaluated, user connection restrictions are evaluated.

NOTE: The Deny overrides any Allow that is configured through a group.

Role Based Security

ROLE BASED SECURITY OVERVIEW

In order to provide a more secure environment and still allow non System Administrators to take
advantage of SQL Sentry's many features, roles are placed on the SQL Sentry database during
its installation or upgrade. Users can be placed in these roles allowing them access to the
features they need while restricting access to  other features that may be above and beyond
their particular responsibility.

SETTING UP ROLE BASED SECURITY

Role Based Security is  primarily configured through T-SQL  statements or by using SSMS
to setup database roles in  SQL Server. First make the person a Useronthe SQL Sentry
Repository database and add them to the allow_all role. This provides full access to the SQL
Sentry repository.

From here you can add the User to any of the custom deny_ roles to restrict that User's access
to the different functions of SQL Sentry . The role names are self-explanatory. Typically there is
a role to deny updating the specified information, and one to deny reading the information at all.
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Role Description

allow_all

Provides full access to SQL Sentry 's features. Place all non - sa
Users in this role, then add to deny roles to restrict access.

deny_actions_read

Denies the ability to view all General, Failsafe, and Audit actions.

deny_actions_update

Denies the ability to make changes to any actions, but allows the
viewing of those settings, making them "read-only".

deny_appsettings_update

Denies any changes made under the SQL Sentry Monitoring
Service > Settings node.

deny_contact_read

Denies the ability to view information about Users.

deny_contact_update

Denies the ability to update information for individual Users, but
allows viewing the information, making it "read-only".

deny_contactgroup_read

Denies the ability to view information about Groups.

deny_contactgroup_update

Denies the ability to update Group information, making it "read-
only".

deny_eventchain_read

Denies the ability to view Event Chain information.

deny_eventchain_update

Denies the ability to make changes to Event Chains.

deny_settings_connection_read

Denies the ability to view information under the Settings
(‘Actions Pane' in the on-line documentation) tab at the
Connection level.

deny_settings_connection_update

Denies the ability to make changes under the Settings tab at the
Connection level.

deny_settings_object_read

Denies the ability to view information under the Settings tab at the
Object level.

deny_settings_object_update

Denies the ability to make changes under the Settings tab at the
Object level.

deny_settings_source_read

Denies the ability to view Source information from the Settings
tab.

deny_settings_source_update

Denies the ability to make changes to Source information from
the Settings tab.

deny_site_update

Denies changes made to Site Configuration.

deny_watch_connection

Denies the ability to watch or stop watching a Connection.

deny_watch_object

Denies the ability to watch or stop watching an individual Object.

AN EXAMPLE

For example, you may have a junior DBA that needs to be able to use SQL Sentry's Calendar
View to check for any failures or long running jobs overnight, but you don't want them to be able
to make changes to any of SQL Sentry 's settings.

First, add their login as a User on the SQL Sentry Repository database. Next, place that User in
the allow_all role. This will ensure the User has access to all the information they need while
being explicitly denied any information specified in the additional roles in which you place them.
Finally, for this example, you may want to add this User to all " deny_" roles except the ones
ending in "_read". This will deny changes to any settings along with the ability to watch or stop

watching a connection or object.

It is also important to remember that logins using SQL Server Authentication must be specified
in the SQL Sentry Client connection information as well. Go to the File > Connect to Installation
menu, uncheck the box marked "Integrated Windows Authentication", and enter the User's login
and password. You will then have to restart the SQL Sentry Client. These new settings will
remain in effect on this SQL Sentry Client until explicitly changed again.
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[ NOTE: The roles starting with "db_" are SQL Server default roles placed on every database. Use of these roles in
the SQL Sentry database may cause unpredictable behavior.

Navigator

The SQL Sentry Navigator Section contains the following topics:

e Shared Groups
o Default Site
e Computers
» Connections
e Contact Management
e Monitoring Service
e Monitoring Service Settings
¢ Site Configuration
e Connections List

e Clustering

e Actions Log
e Service Configuration Utility

¢ Monitoring Service Logon Account

Shared Groups

SHARED GROUPS

The Shared Groups node is the root node of the SQL Sentry Client and can be found in the top
position of the Navigator Pane. All computers that are registered across the entire SQL Sentry
enterprise can be found within Shared Groups.

The Shared Groups node can be used to configure Global Actions and Settings within the SQL
Sentry Alerting and Response System. The Shared Groups node can also be used to view the
Event Manager Global View Calendar or a Performance Advisor Shared Computers overview.

Shared Group Context Menu
Right click on the Shared Groups node to access its context menu. The following commands
are available:

Command Description More Information
Open - Event Manager Opens the Event Manager Global View of your SQL Global Views
Sentry enterprise. Event Manager
Open - Performance Advisor Opens the Performance Advisor Shared Computers  Global Views
Overview. Performance _Advisor
Overview
Add Site Adds a new Site node beneath the Shared Groups Site Configuration
Node. Default Site
Add Connection Adds a new Connection to the Default Site. Connections
Default Site

GLOBAL LEVEL OF THE ALERTING AND RESPONSE SYSTEM
The Shared Groups node is used to configure  Global Actions and Settings within the  SQL
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Sentry Alerting and Response System . When the Shared Groups node is selected in  the
Navigator pane, the associated global level Actions and Settings pane will be available. If you
do not see the Actions and Settings pane when the Shared Groups node is selected, use the
View Menu ('Menus' in the on-line documentation) to bring up the desired pane. Actions and
Settings configured at the Shared Groups level are global in nature. This means that when an
Action or Setting is setat the Shared Group level it will automatically propagate down
throughout your SQL Sentry environment.

Example:

You configure a Send Email Action (‘Actions’ in the on-line documentation) for
the SQL Agent Job: Failure condition (‘Conditions’ in the on-line
documentation) at the Shared Groups global level.

An email will now be sent anytime an  Agent Job fails across your entire monitored
environment.

Once Global Actions and Settings are configured, more granular configurations can be made
where needed at the lower levels. For more details on how Global Actions and  Settings are
inherited throughout your SQL Sentry environment, and information about setting up alerting for
your SQL Sentry installation, see the Alerting and Response System topic.

GLOBAL VIEWS

You can access Global Views of your SQL Sentry enterprise through the Shared Groups node.
This can be done by either double clicking the Shared Groups node or by using its right-click
context menu. Assuming you have both SQL Sentry Performance Advisor and SQL Sentry
Event Manager installed, you will be able to select which Global View you would like to see.

The Primary purpose of the Global Views is give you insight into what is happening across your
enterprise without having to open individual Event Manager calendars or Performance Advisor
dashboards at the connection level. Future and running events are disabled in  the Event
Manger Global view, but you can adjust the runtime filter and  other filter criteria on the Event
View (‘Navigator Pane' in the on-line documentation) filter tab to further refine the display for
personal preferences. For more information about the Performance Advisor Shared Computers
Overview see the Performance Advisor Overview topic.

SHARED GROUP CHILD NODES
Jump to:
-> Default Site

- Computers
- Connections

Default Site

DEFAULT SITE

Sites represent a logical grouping of Computers, Connections, and Monitoring Services within
your SQL Sentry environment. If you are upgrading from a previous version of SQL Sentry you
will notice that the Sites displayed beneath the Shared Groups node directly reflect those sites
you previously configured within the Site  Configuration node. If you are a new user you will
notice that the Connections you added using the Quickstart wizard are all contained in the
Default Site.
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When a Site node is selected in  the Navigator pane the associated Site level Actions and
Settings pane will be available. If you do not see the Actions and Settings pane when the Site
node is selected, use the View Menu (‘Menus' in the on-line documentation) to bring up the
desired pane. Actions and Settings configured atthe Site level apply to all Computers,
Connections, and Objects in that Site. This means that when an Action or Setting is configured
at the Site level it will automatically propagate down throughout that Site.

Site Context Menu
Right click on any Site node to access its context menu. The following commands are available:

Command Description More

Information
Add Computer Adds a new Computer to the selected Site. Computers
Add Computer Group Adds a new Computer Group to the selected Site. Computers
Add Connection Adds a new Connection to the selected Site. Connections
Delete Site Deletes a Site from the Shared  Group node. Any Computers or groups n/a

contained within the Site must first be deleted before a site can be deleted.
This command is not available from the Default Site node.

1, Warning: The Delete Computer command is permanent, see the
Computers (on-line documentation) topic for more information.

Rename Site Renames the currently selected Site. n/a

Open Performance Advisor | Opens a Performance Advisor Overview for every Computer in the Site. Performance
Advisor
Overview

MONITORING SERVICES

Beneath every Site node there is a Monitoring Services node. This Monitoring Services
node contains the Monitoring Service(s), identified by their associated computer name(s), that
are responsible for collecting information pertaining to that site.

The SQL Sentry Monitoring Service is a Windows Service which is responsible for collecting event history, event
status, and performance related information and  storing that information  in the SQL  Sentry Repository.
Monitoring Services are also responsible for sending notifications based on events.

The Monitoring Service(s) within a Site are responsible for gathering information about those
watched Computers and Connections contained within  that same site. Available Monitoring
Services can be assigned to Sites either through the  Site Configuration node or by dragging
and dropping a Monitoring  Service within the Navigator pane. This enables you to control
exactly which Monitoring Services watch which  computers, and can be critical for  scenarios
where you have multiple servers located at different geographic locations. Having a Monitoring
Service for each geograpic location minimizes network traffic across the WAN.

For more information see the Monitoring Services and Site Configuration topics.

COMPUTERS

Beneath every Site node, are its associated Computer nodes, identified by the Computer's
name. Each Computer node represents a physical computer, commonly a Windows Server,
within your SQL Sentry  Environment. Contained beneath every = Computer node are those
associated connections that reside on that computer.
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Within the framework of the Alerting and Response System Hierarchy (‘Alerting and
Response System' in the on-line documentation) , Computers represent a level between

Sites and Connections. This means that when an Action or Setting is configured at a
Computer level it will automatically propagate down to its associated Connections, and objects.

If you do not see the Actions and Settings pane when a Computer node is selected, use the
View Menu (‘Menus' in the on-line documentation) to bring up the desired pane. Actions and
Settings configured at the Computer level apply to all Connections, and Objects beneath that
Computer. This means that when an Action or Setting is configured at the Computer level it will
automatically propagate down to its associated Connections, and objects.

For more information see the Computers topic.

CONNECTIONS

Contained within every Computer node are its associated Connection nodes. Connections
are identified by their Computer/Instance name. Contained beneath every Connection node
are its associated objects.

Within the framework of the Alerting and Response System Hierarchy (‘Alerting and
Response System' in the on-line documentation), Connections represent a level above
objects. This means that when an Action or Setting is configured ata Connection level it will
automatically propagate down to its associated objects.

If you do not see the Actions and Settings pane when a Connection node is selected, use the
View Menu ('Menus' in the on-line documentation) to bring up the desired pane. Actions and
Settings configured at the Connection level apply to all objects belonging to that Connection.
This means that when  an Action or Setting is configured at the = Connection level it will
automatically propagate down to its associated objects.

For more information see the Connections topic.

Computers

COMPUTERS

Contained within every Site node are its associated Computer nodes. Computer nodes
are identified with  the Computer's full name, usually ComputerName.DomainName. Each
Computer node represents a physical computer, commonly a Windows Server within your SQL
Sentry Environment. Beneath every Computer node in the Navigator pane are its associated
Connections.

Double click any Computer node to access its related Performance Advisor Dashboard or
Event Manager Calendar. Assuming you have both SQL Sentry Performance Advisor and SQL
Sentry Event Manager installed, the Product Selector dialog should open, allowing you to

choose which product you would like to open.

Computers Context Menu

Right click on any Computers node to access its context menu. The following commands are

available:
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Command Description More
Information

Open - Event Manager Opens the Event Manager Calendar View for the associated Computer. Event Manager

Open = Performance Advisor | Opens the Performance Advisor dashboard for the associated Computer. Performance
Advisor
Dashboard

Show Windows Processes Launches a Process Activity Window similar to Windows Task Manager for | Windows

the associated Computer. Process

Activity
(‘Dashboard’ in
the on-line

documentation)

Add Connection Adds a new Connection to the Default Site. Connections

Delete Computer i . . . .
¥, Warning: This command will Delete the actual registration for the

Computer from SQL Sentry. This includes the deletion of all
historical information for any associated connections belonging to
the Computer from the SQL Sentry Database. This command is
final and cannot be undone. Only use this command if you want to
permanently delete information SQL Sentry has stored about the
Computer and its associated Connections from the SQL Sentry

Database.
Jump to Time Allows you to select a date, time of day, and time frame for an Event
Manager Calendar
Scan for Configuration This scan looks for hardware and schema changes that have taken n/a
Changes place on the Computer or its associated Connections.

COMPUTER ACTIONS AND SETTINGS

Within the framework of the Alerting and Response System Hierarchy (‘Alerting and
Response System' in the on-line documentation) , Computers represent a level between

Sites and Connections. This means that when an Action or Setting is configured at a
Computer level it will automatically propagate down to its associated Connections and objects.

If you do not see the Actions and Settings pane when a Computer node is selected, use the

View Menu ('Menus' in the on-line documentation) to bring up the desired pane. Actions and
Settings configured at the Computer level apply to all Connections and objects beneath that
Computer. This means that when an Action or Setting is configured at the Computer level it will
automatically propagate down to its associated Connections and objects.

ADDING A COMPUTER TO YOUR ENVIRONMENT

To add a new Computer to your installation you can use the Add Computer command found in
the right click context menu  of any Site Node. Alternatively you may choose to just add a
Connection, as anytime you add a Connection, a Computer node will be automatically created
if it does not exist. You may add a connection either through the File Menu ( File Menu - New
Connection). You can also add a connection with the Add Connection command, found in the
right click context menu of the Shared Groups node or any Site Node.

DELETING A COMPUTER FROM YOUR ENVIRONMENT

To delete a Computer from your installation use the Delete Computer command found in the
right-click context menu of any Computer node. Please see the following warning concerning
the Delete Computer Command.

L\I Warning: The Delete Computer command will Delete the actual registration for the Computer from SQL Sentry. This
includes the deletion of all historical information for any associated connections belonging to the Computer from the SQL
Sentry Database. This command is final and cannot be undone. Only use this command if you want to permanently
delete information SQL Sentry has stored about the Computer and its associated Connections from the SQL Sentry
Database.
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COMPUTER GROUPS

Computers can be organized into Computer Groups beneath any Site node. A Computer
Group allows you to create logical groups of  devices for alerting, organizational, and display
purposes. The Add Computer Group command can be found in the right-click context menu
of any Site node.

COMPUTER GROUP ACTIONS AND SETTINGS

Within the framework of the Alerting and Response System Hierarchy (‘Alerting and
Response System' inthe on-line documentation) , Computer Groups represent an
intermediate level between the Site and Computer. This means that when an Action or Setting
is configured at a Computer Group level it will automatically propagate down to its associated

Computers, Connections, and objects.

Connections

CONNECTIONS

Contained within every Computer node are its associated Connection nodes. Connections are
identified by their Computer/Instance name. Contained beneath every Connection node are its
associated objects.

CONNECTIONS ACTIONS AND SETTINGS

Within the framework  of the Alerting and Response  System Hierarchy (‘Alerting and
Response System' in the on-line documentation), Connections represent the level above
objects. This means that when an Action or Setting is configured ata Connection level it will
automatically propagate down to its associated objects.

When a Connection node is selected in the Navigator pane the associated Connection level
Actions and Settings pane will be available. If you do not see the Actions and Settings pane when
a Connection node is selected, use the View Menu ('"Menus' in the on-line documentation) to
bring up the desired pane. Actions and Settings configured at the Connection level apply to all
Objects belonging to that connection. This means that when an Action or Setting is configured at
the Connection level it will automatically propagate down to its associated objects.

Contact Management

CONTACT MANAGEMENT

The Contacts Navigator node is used to create and maintain Users and Groups within your
SQL Sentry environment. Users and Groups are created for couple of different reasons. Firstly,
they can be created for notification purposes within the SQL  Sentry Alerting and Response
System. When you configure a Send Email ('Actions’ in the on-line documentation) or Send
Page ('Actions' in the on-line documentation) action, any user or group which has been
created will be available for you to choose as a target.

The second reason for defining Users and Groups is the ability to assign rights to them. These
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rights are used to restrict the access  of users and groups within the SQL  Sentry Client. For
more information, please see the SQL Sentry Client Security topic.

VIEWING NOTIFICATIONS BY USER OR GROUP

From the Contacts node it is also possible to view all notifications assigned to a particular user
or group. To do so select any user or group node and open the Actions pane ( View Menu -
General/Failsafe/Audit Actions ). A list of all notification actions associated with that
user/group will appear; from here you can disable or change any of these configured Actions.

USERS

Expand the Users node in the Navigator pane to list any configured users.

ADD OR EDIT A USER

To add a new user simply double-click on the Users node. To edit information about an existing
user, double click on the user's name in the Navigator to open the Edit User tab.

DELETE OR DISABLE A USER

You may also delete or disable a user through the right-click context menu. When you disable a
user, they will no longer receive notifications for any actions which they are the selected target
of. If the disabled user is part of a group, that user will also no longer receive notifications when
that group is notified. Disabled users are grayed-out in the Navigator and also have ( disabled)
next to their name. To enable a user that has been disabled, use the right-click context menu of
the user and select the Enable User command.

When you create a new user or edit an existing user the following fields will be available.

USER FIELDS

Field Description

First Name The first name of the user. Required.

Last Name The last name of the user.

Email Address The email address of the user. Required

Pager Address The pager address of the user.

Email Window The email window for the selected user. Windows are used to control when alerts and
notifications are sent. For more information please see the Schedules and Windows topic.

Pager Window The pager window for the selected user. Windows are used to control when alerts and
notifications are sent. For more information please see the Schedules and Windows topic.

Login The Windows or SQL Authentication for the user.

Description Descriptive text or notes for the user.

Groups The Available area lists any group within your SQL Sentry enterprise.
The Selected area lists those groups which the user belongs to.

Expand the Groups node in the Navigator pane to list any configured groups.

ADD OR EDIT A GROUP

To add a new group simply double-click on the Groups node. To edit information about an
existing group, double click on the group name in the Navigator to open the Edit Group tab.

ASSIGN USER(S) TO A GROUP
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To assign users to the group, choose from the available users on the bottom-left side of the
view, and click the Add button. Click on the Save button in the top toolbar to save a group.

DELETE OR DISABLE A GROUP

You may also delete or disable a group through any group's right-click context menu. When you
disable a group, that group will no longer receive notifications for any actions which they are the
selected target of. Disabled groups are grayed-outin the Navigator and are also listed as
disabled. To enable a group that has been disabled use the right-click context menu of the
group and select the Enable Group command.

GROUP FIELDS
When you create a new group or edit an existing group the following fields will be available.

Field Description

Group Name The name to assign to a group.

Alert Window The Alert Window to assign to the group. For more information please see the Schedules and
Windows topic.

Description Descriptive text or notes for the user.

Users The Available area lists users within your SQL Sentry enterprise.

The Selected area list any users that belong to the group.

Monitoring Service

SQL SENTRY MONITORING SERVICE OVERVIEW

The SQL Sentry Monitoring Service , a Windows service, collects  event history, status, and
performance information, sends notifications, and performs various other tasks related to event
management for each “watched” connection. The various event metadata and history information
collected by the SQL Sentry Monitoring Service is stored in a SQL Server database. The number
of connections that can be watched in your environmentis  controlled by the number of licenses
you have purchased.

SQL SENTRY MONITORING SERVICE NODE

—|E.‘ Meonitoring Service

_| Connections List
--E5 System Status

----- 4 Actions Log

The SQL Sentry Monitoring Service node is  available from the Navigator and has the following
child nodes.

Monitoring Service Settings

SQL SENTRY MONITORING SERVICE SETTINGS

The SQL Sentry Monitoring Service Settings are global in nature in that they apply to the entire
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SQL Sentry installation. They control the behavior and function of  all installed SQL Sentry
Monitoring Services connected to the active SQL Sentry database. The SQL Sentry Monitoring
Service is a Windows service installed on one or more  servers in your enterprise. All settings
are stored in the SQL Sentry database.

The Settings sub-node is located under the SQL Sentry Monitoring Service node in the
Navigator pane. It opens to the SMTP Configuration tab.

SMTP CONFIGURATION

SMTP Server Enter the IP Address or the Domain Name of the SMTP Server. When using localhost, this will
be the local SMTP server on the machine where the SQL Sentry Monitoring Service is
installed.

Email From Address Enter the From Address that you will be using for Email notifications in the field provided.

Username and Password Optional: Enter the Username  and Password used to  authenticate with the SMTP
Server.

Test Button Use the Test button to set up a Test Message. Click the Test button, and the Test Message
box will appear. In the field provided, enter a valid email address you will be sending the test
message to. Click Send to transmit the test message.

¥ Note:

e For servers requiring SSL to be enabled upon connection, a checkbox exists to enable SSL.
e A custom port checkbox is also available to change the default port.

e For the most accurate SMTP test, you should use a SQL Sentry Client installed on the SQL Sentry Monitoring
Service to send a test message. If you use a different computer, i.e., your local workstation, the results may be
different. For example, your SMTP server may allow relay from your workstation's subnet, but not from the
SQL Sentry Server's subnet. In this case the test from your workstation would succeed; however, the SQL
Sentry Monitoring Service would be unable to deliver notifications.

EVENT MONITOR

Thistabis  used to configure  settings forthe  process responsible for  polling watched
connections for active event status information.

Polling Interval Polling Interval controls how often the SQL Sentry Monitoring Service will
poll each watched connection for event status information. The polling
operations used are lightweight, however, the value can be increased to
reduce network activity associated with the SQL Sentry Monitoring Service.
The default Polling Interval is 15 Seconds.

Error Resume Interval Error Resume Interval is how long the SQL Sentry Monitoring Service
should wait to recover from an error or exception in the event monitor when
attempting to obtain event status information from a connection. The
default Error Resume Interval is 1 Minute.

Trigger "Run Missed" Condition Use the check-box to specify  whether or not to execute  the Run
Missed Condition when the connection is offline.

Minimum Block Duration Required to Trigger "SQL | Used to specify the minimum time a SQL Agent job must be part of a
Server Agent Job: Block Condition” blocking chain before triggering the Block condition.

EVENT HISTORY MONITOR
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history

information from watched connections.

Polling Interval

Polling Interval controls how often the SQL Sentry Monitoring Service will poll each watched
connection for event history information.

Error Resume Interval

Error Resume Interval is how long the SQL Sentry Monitoring Service should wait to recover
from an error or exception in the event monitor when attempting to obtain event status
information from a connection.

Purge History Older Than

This specifies how long performance data should be kept in the SQL Sentry repository.

Max Thread Pool Size

This is an advanced setting that may improve performance in large (100+ watched

connections) environments.

Event Chains are Only
Affected by History Within

This setting tells chaining how far back in the history to look when determining whether
history entries should affect chain status. This setting is used as a fail safe measure if for
some reason you were unable to synchronize with a server for a specified period of time,
whenever the server comes  back online and SQL  Sentry is able to  re-synchronize
history information, any history that is older than the time specified by this setting will not
be used to impact chain  execution status. The minimum value for this setting is 10
minutes.

NOTE: It is recommended that you contact SQL Sentry support before changing the
default value.

MESSAGE PROCESSOR

These settings control the process that

polls the message queue and processes messages.

Examples of processes include logging to disk or the event log, or sending an email notification.

Polling Interval

Polling Interval controls how often the SQL Sentry Server's internal message queue is checked
and messages are processed. Increasing this setting will effectively lengthen the time between
when a condition is met and any associated actions are triggered. Adjusting the setting up or
down will affect overhead on the SQL Sentry Monitoring Service only, and will not affect network
or monitoring overhead for watched connections.

Error Resume Interval

The Error Resume Interval is how long the SQL Sentry Monitoring Service should wait to recover
from an error or exception in the message processor.

Do Not Fire Actions for
Messages Older Than

If messages were unable to be collected for some time this setting will keep actions from
being fired for these older messages.

Purge Action Log History
Older Than

This setting determines how many days worth of log information will be stored.

Global Message Throttling
(Don't send more than X
emails within X hours.

enabled and, if so, how
before the
"Message

These settings determine whether global message throttling is
many email messages can  be sent within the  provided amount of time
message throttling  activates. When  message throttling  activates the
Processor: Message Action Throttled" condition is fired.

The "Message Processor: Message Action Throttled" condi tion is a Failsafe condition;
therefore by default any user added during the  Setup Wizard will be notified when this
condition is met. If you disable  alerting for the "Message Processor: Message Action
Throttled" condition, Message Throttling will still remain in effect.

NOTE: The "Message Processor: Message Action Throttled" condition is  subject to
global message throttling itself.

PERFORMANCE MONITOR

These settings control the process responsible for monitoring Windows

performance counters

that are linked to event objects.

Polling Interval

Polling Interval controls how often the SQL Sentry Monitoring Service will sample any
performance counters linked to an event. The polling is not continuous, but is started and
stopped automatically based upon an event object's schedules.

Error Resume Interval

The Error Resume Interval is how long the SQL Sentry Monitoring Service should wait to
recover from an error or exception in the performance monitor.
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Purge History Older Than | This specifies how long performance data should be kept in the SQL Sentry repository.

NOTE: This applies to performance monitoring data only, not all job history.

MAINTENANCE WINDOW

Maintenance window settings allow you to specify a time frame where Failsafe Notifications
('Recommended Global Conditions' in the on-line documentation) will be disabled while
daily maintenance activity takes place. This will prevent excessive notifications that may occur if
a watched connection is temporarily inaccessible during these activities. Log Actions will still be
enabled during this  window, but any  Execute or Send  Actions will not fire inside the
Maintenance Window. The Maintenance Window specified in this view, under the SQL Sentry
Monitoring Service node, applies to activity on  the SQL Sentry repository itself. To specify a
Maintenance Window for watched connections / devices, select the Settings tab from  the
Settings Pane for that connection / device.

SNMP CONFIGURATION

SNMP SETTINGS

Hostname | This value determines where the SNMP trap will be sent. The default setting (BROADCAST) will send the
trap to all managers. Individual managers can be sent the traps using the individual hostname or IP
address.

NOTE: Managers included in the BROADCAST group and who are also listed individually will receive two
messages for each occurrence.

Port The port used for transmission of the traps (Default 162).
SNMP The version of SNMP to be used (1, 2C or 3)
Version

Enabled This checkbox determines whether or not the trap is enabled.

SNMP V1/2C CONFIGURATION

Community
Enter the community.

SNMP V3 CONFIGURATION

Engine ID Enter the Engine ID.
NOTE: You can also use the Generate button to get this value.
Username Enter the username
Privacy Algorithm Select the appropriate privacy algorithm
Privacy Password Enter the privacy password
Hash Algorithm Select the appropriate hash algorithm (MD5,SHA, or None).
Hash Password Enter the password.

Site Configuration

SITE CONFIGURATION

Site Configuration enables logical partitioning of SQL Sentry Monitoring Services and watched
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Devices into distinct groups. This feature enables you to control exactly which SQL Sentry
Monitoring Services watch which devices, and can be critical for scenarios where  you have
multiple servers located at different geographic locations and you want to minimize associated
network traffic across the WAN.  This is based on the premise that there is generally more
network activity between a SQL Sentry  Monitoring Service and many watched devices than
there is between a SQL Sentry Monitoring Service and the SQL Sentry database. See SQL
Sentry Enterprise Architecture for a graphical representation.

Take the example of a company with offices in Atlanta and Louisville, with five servers at each
location. Using separate “sites” for Atlanta and Louisville, a SQL Sentry Monitoring Service can
be installed in Louisville which monitors only the five servers there, and which reports back to
the SQL Sentry database in Atlanta. This configuration will result in less network  traffic across
the WAN link than if the SQL Sentry Monitoring Service in Atlanta  watched the Louisville
servers.
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Here are the steps to accomplish this example:

1. On the Site Configuration node, add a new site called "Atlanta".

2. Select the Atlanta site, then click "Add" for the SQL Sentry Monitoring Service(s) and the
5 Atlanta servers, then click "Save". (This will effectively prevent any of these servers
from being picked up by the SQL Sentry Monitoring Service in Louisville when you install
it.)

3. Create a new site called Louisville.

4. Install the new SQL Sentry Monitoring Service on a server in Louisville, and when
prompted during setup, connect it to the SQL Sentry database in Atlanta.

5. Wait a minute or so, then click off and back on the Site Configuration node to refresh it.

6. Select the new Louisville site. The new SQL Sentry Monitoring Service should show up
as Available. Select it and click "Add", then click "Save".

7. In the treeview, set the devices in Louisville that you want the new SQL Sentry Monitoring
Service to monitor to "Watched".

8. On the Site Configuration node, select the Louisville site, then highlight the 5 servers in
Louisville and click "Add", then click "Save". At this point the SQL Sentry Monitoring
Service in Louisville will start watching the Louisville servers.
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NOTE: The Default Site acts asa "catchall" forany SQL Sentry Monitoring Services and
Devices that are removed from or haven't yet been added to any other sites. This is the reason
you can't remove SQL Sentry Monitoring Services or Devices from the Default Site, since there
is nowhere for them to go.

CONFIGURE A NEW SITE

Select the "New" button. This opens the Add/Edit Site window. Enter the Name and Description
for the new site in the fields provided. When finished Click the "OK" button. The Sites list will
include the new site so connections can be added to it.

EDIT A SITE OR ITS CONFIGURATION

To edit an existing site, click on the desired site in the "Sites" list. If you wish to edit the site
properties, click the "Edit" button. This will open the Add/Edit Site window and expose the site
name and description.  When a site is selected, SQL Sentry Monitoring  Services and
connections can be added or removed from the site.

SAVE SITE CONFIGURATION

When finished editing a site, click the Save button on the toolbar to commit any unsaved
changes.

DELETE SITE CONFIGURATION

Select a site from the site list and click the Delete button. The Delete Site confirmation box
appears.

To delete the site, Click OK. This will bring up the Save Changes Box. Click Yes to confirm the
deletion.

See also:
Watching Servers Across Domains

Connections List

CONNECTIONS

The Connections view allows you to see the Watched Status of any  Connection within your
environment.

You can drag the column header to the top to group by that column. The Connections View
allows you to group connections by the SQL  Sentry Monitoring Service assigned to a particular

site.
Site Management Site Maintained through the Site Configuration screen.
Monitoring Service Specific SQL Sentry Monitoring Service by machine name.
Connection Name Name of specific connection.
Connection Type Connections may be SQL Server, Task Scheduler, or Oracle Database.
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| Watched | Check the box to "Watch" or "Unwatch" a connection. |

CONTEXT MENUS

Connections can be watched or unwatched from this grid by using the context menu. The context
menu shown on this grid is the same as what is displayed if you right-click on the connection in the
navigator. This allows for watching and un-watching of connections, including connections that are
no longer online. This can be useful if you need to obtain historical information for a server that is
no longer online.

Other options are available in  the context menu for the column headers for grouping, sorting,
filtering etc. Once applied, the filter will be shown at the bottom of the pane as  shown above and
can be edited there.

Clustering

CLUSTERING

In order to cluster multiple SQL Sentry Servers, install more than one SQL Sentry Monitoring
Service and connect each tothe same SQL Sentry database during setup.  There is no
configuration required to implement a basic SQL Sentry cluster. Once an additional SQL Sentry
Monitoring Service is installed and connected to the same SQL Sentry database during setup,
they will automatically  distribute the monitoring  load evenly between  themselves providing
automatic fault tolerance and load  balancing. If one SQL Sentry  Monitoring Service fails, the
remaining SQL Sentry Monitoring Services will pick up the load automatically.

For example, if there are three SQL Sentry Monitoring Services associated with nine servers, the
SQL Sentry Monitoring Services will divide the servers evenly among themselves, each managing
three. If one SQL  Sentry Monitoring Service were  to fail, the other  two would pick up  the
unmanaged servers and divide the remaining three between themselves.

See SQL Sentry Enterprise Architecture for a graphical representation.

Actions Log

ACTIONS LOG

SQL Sentry includes an interface for viewing, sorting, and filtering log and notes information.The Actions
log is where information relating  to General, Failsafe, and Audit  Actions can be viewed. Additionally
whenever a Condition is configured with the Log to Database Action (‘Actions’'in the on-line
documentation), information related to that Condition can also be viewed in the Actions Log.

Filter Criteria
EventTime [V] After  4p15p2012 [~ 3:37:54PM s [l Before  4p29p2012  [Ev  %Z37:54FM =

Object Name Parent Mame Contains
Log Type |.|5.|| v| Condition v| Action | v|
| Refresh | | Apply Filter | | Reset Filter | Page 1 of |1 |I1 First | I{Preu | INext) | |Last P||

LOG FILTER
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Filter Criteria used to manage results displayed in the view. Use the Log Filter to search for a specific log
entry by narrowing the selection criteria to be displayed in the Log List.

Property Description
After Enables the filter to only show logs with an event time after the specified time in  the date/time selection
controls.
Before Enables the filter to only show logs with an event time before the  specified time in the date/time selection
controls.
Object Name Filters the log list by applyinga like comparison to the specified value to  the value stored in the Object
Name field.
Parent Name Filters the log list by applying a like comparison to the specified value to the value stored in the Parent
Name field.
Contains Narrows the log list to the entries with the specified value in the message text.
Log Type Specify the type of Actions to display in the Log List.
Conditions Filters for a specific condition category.
Action Filters for a specific action category.
Refresh Used to refresh the list of logs and date/time filter.
Apply Filter Used to apply Filter Criteria settings and refresh the log list.
Reset Filter Used to remove the filter applied to the log list.
Page Used to show the current display page of results and how many pages are in the log list.
First Move to the first page of log results
Previous Move to the previous page of log results.
Next Move to the next page of log results.
Last Move to the last page of log results.
LOG LIST

The Log List shows all log records retrieved. Records cannot be edited, however, notes can be added. To
sort a list, click on the header.

Column Description

Log Time Displays the time the action was fired for the event.
Event Time Displays the start time for the event.

Object Time Displays the object type for the event.

Object Name Contains the name of the object for the event.
Parent Object Name Contains the name of the parent object for the event.
Condition Captures the condition that caused the event.
Action Captures the action that caused the event.

NOTES LOG LIST

Even though notes are considered a logged object, the properties are somewhat different than the logs for
other events. Thus, the log list columns vary in order to reflect these differences.

Column Description

Log Time Date/time note was created.

User Name Name of user that created the note.

Object Name The object name that the note references.

Parent Object Name The name of the parent object that the note references.
Note Text Contains the note message text.

Note Title Contains the title or subject of the note.

Calendar Captures the condition that caused the event.
Notifications Captures the action that caused the event.
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MESSAGE WINDOW

The Message window is  located at the bottom  portion of the view, and contains a read-only area,
displaying the log messages. To add or edit notes to an event instance, right-click on the desired row in
the list, and choose the option to Add/Edit Notes to open the note editor.

Service Configuration Utility

SERVICE CONFIGURATION UTILITY

When the SQL Sentry Monitoring Service is first installed a keychain password must be provided.
This password is used to encrypt and decrypt stored credentials that the Monitoring Service uses
to connect using non-integrated authentication methods such as SQL Server authentication. Any
time the security credentials for the Monitoring Service are changed this keychain password must
be provided. For this reason, simply changing the security account using the services applet in the
Windows control panel will cause the service to fail. The service will appear to be running, but will
not be able to perform any work due to an encryption error.

The "ServiceConfiguration.exe" utility is located in  the SQL Sentry program group on  the start
menu. It can be used to change the service account properly.

Note that the only supported ways of changing the service account are by using this utility or by
reinstalling the Monitoring Service. If only the password needs to be changed, the services applet
in the Windows control panel can be used.

See also:
Monitoring Service Logon Account
Watching Servers Across Domains

Monitoring Service Logon Account

54

MONITORING SERVICE LOGON ACCOUNT

SQL Server authentication is supported by the SQL Sentry  Monitoring Service for connecting to
monitored SQL Servers. In order for the SQL Sentry Monitoring Service to store and utilize SQL
Server and Oracle database logins and passwords for individual instances, a public/private key is
used to allow encryption of login information. Each time a SQL Sentry Monitoring Service is
installed or upgraded, the public/private encryption password specified during the initial installation
of the repository must be entered so that the SQL Sentry Monitoring Service may safely store and
utilize these logins. This applies if the Monitoring  Service is upgraded or installed on a different
server to enable clustering.

If the User account used by the Monitoring Service needs to be changed, the SQL Sentry Service
Configuration Utility will need to be run in order for the Public/Private key encryption to validate the
change. If the incorrect password is provided the decryption process will be unable to validate and
the password change will fail. SQL Sentry will be unable to watch connections and your
existing installation will be invalidated. Remember this password and keep it in a safe
place.

Common Tasks
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Reporting

REPORTING OVERVIEW

SQL Sentry offers an expansive list of reporting options. SQL  Sentry reports are generated
using SQL Server Reporting  Services (SSRS) technology. The SQL Sentry Client includes
Reporting Services Report Viewer which  allows the SQL Sentry Reports  to be viewed from
within the SQL Sentry  Client. SQL Sentry Reports  can also be deployed to a Reporting
Services 2005 and above server for distribution.

The SQL Sentry reports are accessed from the Reports menu of the SQL Sentry Client. Once a
report is selected, the user can specify a number of parameters including a date and time range
for the report. The Report Deployment Settings are also accessed from the Reports menu.

EVENT MANAGER

Depending on the Report  that is run different  options can be selected  within the Report
Parameters window, including  Connection Status. This option is available for all Event
Manager reports except the Watched Object Summary, which only reports on Watched Objects.

Report Description

Current Failures Provides a list of all failures that have occurred on watched connections in
the given time frame.

Management Summary Gives overview information on all watched connections allowing you to
easily determine which are the most active.
Performance Counters List Displays all performance counters currently associated with specific event
objects or custom event views.
Watched Object Summary Gives information about different types of objects found on each watched
connection.
PERFORMANCE ADVISOR

The Performance Advisor reports  allow the userto  configure a variety of  parameters for
customization. Once the report is selected from the toolbar, the Report Parameters window
opens with the applicable parameters for each report. Parameters available on the various
reports are:

o Start Date with time

e End Date with time

e Server

e Logical Disk

e Database

e Connection(s)

e Category

e Counter

¢ Instance

e Additional range for comparison

[# NOTE: On the applicable reports, the Load Saved Parameters drop-down box allows the user to save the
parameters for future use.
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Description

Global Server Performance

Provides a summary of the performance metrics collected in a
graphical form of each of the servers.

Performance Counter Date Range
Comparison

Various parameters (Server, Connection, Category, Counter, and
Instance) can be configured to provide detailed graphical information
regarding the performance counter history over two different time
ranges.

Performance Counter History

Various parameters (Server, Connection, Category, Counter, and
Instance) can be configured to provide detailed graphical information
regarding the performance counter history over a given time range.

SQL Server Performance

Provides detailed graphical SQL Server performance data for the
instance over the selected time range.

SQL Server Transactions - Top Databases | Provides detailed graphical data for the transactions and log flushes

of the top databases.

SQL Server Wait Stats Analysis

This report provides graphical data regarding SQL Server Waits for
the instance over the selected time range.

SSAS Performance

Provides detailed graphical information regarding the SSAS
performance for the selected connection over a given time range.

Windows + SQL Server Performance

Report providing detailed performance metrics of each instance on
the selected server with regard to Windows and SQL Server
performance in a graphical form.

Windows Performance

This report gives detailed graphical data surrounding Windows
performance of the selected server.

BLOCKING

Report
Blocking - By Application

Description

Provides a summary of blocking data by application over the given time
range.

Blocking - By User

Provides a summary of blocking data by user over the given time range.

Blocking - By SQL Server

Provides a summary of blocking data by SQL Server over the given time
range.

TOP sQL

Report
Top SQL - By User

Description

Provides a summary of Top SQL data by user over the given time range.

Top SQL - By Database

Provides a summary of Top SQL data by database over the given time
range.

Top SQL - By Application

Provides a summary of Top SQL data by application over the given time
range.

Top SQL - By Server

Provides a summary of Top SQL data by SQL Server over the given time
range.

Top SQL - All Servers

Provides a summary of Top SQL data for all of SQL Servers over the given
time range.

DISK / FILE SPACE

Report
SQL Server File Utilization - Top Files

Description

Provides a summary of blocking data by application
over the given time range.

SQL Server File Utilization - By Logical Disk Provides a summary of blocking data by user over the
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Report Description

given time range.

SQL Server File Utilization - By Database Provides a summary of blocking data by SQL Server
over the given time range.

Windows Disk Utilization Provides detailed graphical data regarding the
physical and logical disk utilization for the server over
the selected time range.

Misaligned Partitions - By Server Provides a summary of the misaligned partitions for
the selected server.

Misaligned Partitions - All Servers Provides a summary of the misaligned partitions for all
of the servers.

High VLFs - By Server Provides a summary of the high VLFs for the selected
server.

High VLFs - All Servers Provides a summary of the high VLFs for all of the
servers.

GENERAL

Once the report is selected from the toolbar, the user can specify a date and time range for the
report. The General reports allow the  user to choose  between Watched Connections,
Unwatched Connections, and All Connections, using the Report Parameters window.

Active Settings Provides details on every setting made from the Settings tab in the Action and Settings pane
List at all levels combined into one resource.

Configured Provides a list on every action that has been configured for a given condition, specifying at
Actions List what level the action has been configured.

Configured Allows you to view all conditions that are specifically configured to send notifications by email
Notifications List = or pager.

REPORT DEPLOYMENT

You can deploy any SQL Sentry reportto one or more Reporting  Services 2005 and
above servers. Deploying reports to  your own SSRS instance allows you to create custom
deployment schedules. Before the reports can be deployed, you must specify the name of the
server where you wish to  deploy the reports. Thisis done by selecting Report Deployment
Settings from the Reports Menu.

NOTE:
e Windows Authentication must be enabled to immediately run reports via the web interface.

e SSRS 2008 uses the same endpoint as SSRS 2005, so the ReportService2005.asmx
shown below will work for both.

‘. Deployment Preferences ] o ]

Enter the location of the SAL Server 2005 Report Server where pou wish to have your reports deploved. The repart server
Il ghould ook similar to the following default Uil http: /flocalhost/ReportS erver/HeportS ervice2005_azsmx

Report Server: Ihttp:.-".-"M_l,IS ervel'Reports erverS AL2005/F eportS ervice 2005, asmsx

k. Cancel
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When you choose to deploy your reports, you will be given the ability to decide where on your
reporting server that you would like to store these reports.  Simply click the desired folder and
press OK. You can create new folders by right-clicking on an existing folder and choosing New
Folder.

[ B Deploy Reports E=REERTSCT)

melect the destination folder for these reports.

=) Root i
----- £] Active Settings List 1
----- =] Corfigured Actions List

----- =] Corfigured Motffications List

----- =] Cument Failures

----- =] Global Server Performance

----- £] Management Summary

----- E Performance Counter Date Range Comparison
----- =] Performance Counter History

----- =] Performance Counters List

----- =] SQL Server File Utilization - By Database

----- =] 5GL Server File Utiization - By Logical Disk

----- =] SQL Server File Utilization - Top Files

----- =] SQL Server Peformance

----- =] SQL Server Transactions - Top Databases

----- =] SQL Server Wait Stats Analysis

-4 SQLDS

----- % SGLFile Lkilization TopFiles SubReport

----- £] S5AS Performance

----- E SubReport_Performance AreaChart

| E SubReport_Perfformance AreaChart_small

| I E SubReport_Performance AreaChart _xsmall |
----- E SubReport_Performance AreaCverdayChart

----- E SubReport_Perfformance AreaCverayChart_small
----- E SubReport_Perfformance AreaOverdayChart_xsmall
----- E SubReport_PerformancelineChart

----- E SubReport_Performance LineChart_small

0L o O S 5 N S | . S {11

m

REPORT SUBSCRIPTIONS

In orderto create subscriptions, the user will need to change the authorization type to
Credentials stored securely in the report server inthe SQLDS properties and click the
checkbox for Use as Windows credentials when connecting to the data source.

ADDITIONAL REPORTING FEATURES

List Views All list views inside the SQL Sentry Client can be easily exported to HTML and
other formats.
Runtime Graphs All runtime graphs in the SQL Sentry Client are printable.

Performance Graphs All performance graphs in the SQL Sentry Client are printable.
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Event Chains All Event Chain diagrams in the SQL Sentry Client are printable.

Calendar Views All Calendar views in the SQL Sentry Client are printable.

IMPORT REPORTS

This option can be found in  the Reports menu on the main  toolbar. As of version 6.0, SQL
Sentry supports importing future reports (created by the SQL Sentry development team) to the
console separately without requiring an upgrade. Stay tuned for the latest reports!

Adding Notes

NOTES

Notes are used to help facilitate communication between DBA team members. They can be
used for change tracking, resolution history, and a variety of other functions. You can set notes
to be included in any future notifications generated for an object, as well as to be displayed for
all calendar instances of an object. Both of these features can be valuable for sharing
escalation procedures, recovery steps, emergency contact information, etc., with other team
members.

The Notes interface can  be reached througha variety of context menus (on-line
documentation) throughout the SQL Sentry Client, just about anywhere that you can act on an
event object or event instance. The notes interface can also be accessed by pressing (CTRL +
ALT + N) when an applicable object is selected.

When adding a note, if any failures exist for the selected event object, you will be prompted to
clear them (‘Clearing Failed Instances’ in the on-line documentation).
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User n/a Displays the current Windows user name.

Title n/a The subject of the note which will appear in
the selection list.

Note n/a The body of  the note which  cannot be
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blank.

Include in Notifications n/a Enable this setting to include this note with
any notifications related to the object.

Show for All Calendar Instances n/a Enable this  settingto  showthe note
information in the  popup of every  event
instance of the object.

New Ctrl+N Creates a new note.
Save Ctrl+S Saves the current note.
Delete Ctrl+D To delete a note, select it from the list and
click delete.
Close Ctri+C Closes the window.
See also:
Notes Log

Clearina Failed Instances
Watching Connections and Objects

WATCHING CONNECTIONS AND OBJECTS

Throughout this document you  will see the term  "Watch" used frequently, in  the context of
watching connections or event objects. Before SQL Sentry will start monitoring a connection or
object, its status must be set to “Watched”.

This is accomplished by right-clicking any root node, group node, connection node, source node,
or object node in the Navigator. The actual "Watch" context menu items and sub-items displayed
will change depending on selected node level and node type.

Please consider these rules regarding watched connections and objects:

1. When a connection is watched, SQL Sentry will monitor the connection and fire any
applicable conditions for the connection based on it's type (SQL Server, Oracle,
SharePoint, or Task Scheduler), such as Online/Offline or Monitor errors.

2. When an object is watched, SQL Sentry will monitor the object and fire conditions for
the object based on its source type (Job, DTS Package, Report, etc.).

A connection can be watched without watching any of its objects.

If any object on a connection is set to watched, the connection will also be
automatically set to watched.

5. An object and its connection must be watched to utilize SQL Sentry's queuing,
chaining, and performance monitoring features.

Connect to Installation

CONNECT TO INSTALLATION

The Connect to Installation... File menuitem controls the active database for the locally
installed SQL Sentry Monitoring Service and Client.
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i N
i Connect [i"j—]
Please Spedfy the Server Name
S5WS14 -

Flease Specify the Database Mame
s0LSentry|

¥ Use Integrated Windows Authentication

| 5QL Server authentication {(Optional) .

Connect Cancel

L A

Please Specify the Server
Enter the name of the Server to connect to in the field provided.

Please Specify the Database Name
Specify the database name of the SQL Sentry Repository that you wish to connect to.

Use Integrated Windows Authentication

By Default this option will be selected. If you wish to  use SQL Server authentication, uncheck
the box and enter the SQL Server credentials. After connecting to the server a new instance of
the SQL Sentry Client will be launched that connects to the specified alternate installation.

To Remove an old Server from the Connection List

When you start the SQL Sentry Client, if you have more than one server in the Connection List
you will be prompted to choose an installation to connect to. You may have more than one
server in the Connection List if you have moved the SQL Sentry Repository to a new location.

To remove an old server from the Connection List so that you will no longer be prompted about
it when opening the SQL Sentry Client:

1. Select the Server Name of the server you would like to remove in the “Please Specify the
Server Name” drop-down list, and press Shift + Delete.

2. The new server should now be the only one listed in the drop-down list. Use the Connect
command and connect to the new installation.

The next time you open the Client it will automatically connect to the new installation.
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Alerting and Response System

ALERTING AND RESPONSE SYSTEM

SQL Sentry employs a comprehensive Alerting and Response System. The Alerting and
Response System uses the concept of Conditions and Actions. Conditions describe the
various states of monitored objects. SQL Sentry allows you to define criteria for when
Conditions are met using various Settings. As a response to Conditions taking place Actions
can be configured. You can refine and how often Actions will be carried out using Response
Rulesets.

Actions and Settings are all hierarchical, working through  the principle of inheritance. This
means that Actions and Settings applied at the global level ( Shared Groups node ), are
automatically inherited by all objects below that node. Any Inherited Actions or  Settings can
then be overridden at each lower level as needed.

This allows  youto  designyour alerts and responses at  a high level (Global
Shared Groups) and then fine tune them as necessary at the lower levels (Sites, Computers,
Connections, Objects). For a visual representation of these different levels see the Alerting
and Response System Hierarchy diagram.

The following table contains a brief description of the different concepts within the SQL  Sentry
Alerting and Response system. For detailed information  concerning each concept, select the
links to open the individual sub topics.

Concepts:

Concept Description

- Conditions Conditions describe the various states of monitored event objects or associated
performance counters. You define Actions to take when Conditions are met.

-> Actions Actions determine what happens when a Condition is met, including sending notifications,
executing a process, etc.

- Settings Settings define criteria for when a Condition is considered to be  met, including
runtime thresholds for events that are captured. Certain Settings, known as Source
Settings define what events are collected by SQL Sentry.

-> Response Rulesets Response Rulesets control how often Actions are taken in response to Conditions
being met. They do this by assigning additional criteria on top of the Condition itself,
that must be met before an Action will take place. The default Response Ruleset is
Notify EveryTime.

ALERTING AND RESPONSE SYSTEM HIERARCHY

Actions and Settings have a hierarchical configuration. This means that settings applied at the
Global level ( Shared Groups ) are automatically inherited by all  objects below that node.
Inherited Actions and Settings can then be overridden at each level as needed. These new
Actions and Settings will then be inherited by each object below that level. The below diagram
shows the flow of inherited Actions and Settings. It also shows those levels at which the
Actions and Settings panes are available for configuration.
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Conditions

CONDITIONS

Conditions describe the various states of an event object or associated performance counters.
You can configure Actions to take place when a Condition is met. All Actions work on the
principle of inheritance. This means that if you configure an Action inresponse to
a Condition being met at the Global level (Shared Groups), it will be automatically passed
down to all applicable objects below it. This allows you to define Global Actions for the most
common issues across  your environment once, and have those passed downto every
monitored server automatically. You can further refine Actions at each level as needed.

For a general overview of the Alerting and Response  System see the Alerting and Response
System topic. For a visual representation of how inheritance works within SQL Sentry see the
Alerting and Response System Hierarchy diagram ('Alerting and Response System' in
the on-line documentation).

Conditions fall into three categories: General, Failsafe, and Audit.

Condition Description
- General General Conditions are applicable to monitored event  objects or associated  performance
Conditions counters. These are the most common Conditions which you will configure Actions for in your

environment. Not all General Conditions apply to all event object types.

Example General Conditions include, SQL  Agent job failure, Event Chain completed, and
Runtime Threshold conditions.

For a complete list of General Conditions see the General Conditions topic.
You can configure Actions in response to General Conditions being met at the Global level

(Shared Groups), at the Site  level, at the Computer level, at the Connection level, and  at the
individual object level.

- Failsafe Failsafe Conditions fall into two categories: Connection Status and Error.
Conditions
Connection Status Failsafe Conditions are met when a Connection goes Offline or Online. Error
Failsafe Conditions are met when there is an error detected with a SQL Sentry Monitoring Service
or related monitoring process.
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Condition Description

Example Failsafe Conditions falling under the Connection Status category include, SQL Server
Agent Offline, SharePoint Server Offline, and  Analysis Server Offline. Example Failsafe
Conditions of the Error category include Monitoring Service errors  and Reporting Services
monitor errors.

For a complete list of all Failsafe Conditions see the Failsafe Conditions topic.

You can configure Actions in response to Connection Status Conditions being met, at the Global
level (Shared Groups), at the Site level, at the Computer level, or at the individual Connection level.
You can configure Actions in response to Error Conditions being met at the Global level (Shared

Groups) or at the Site level.

- Audit Audit Conditions are applicable to various activities carried out both inside and outside of the SQL
Conditions Sentry Client. Audit Conditions provide a way for you to  be notified when various Settings are
changed, or monitored objects are modified from within the SQL Sentry Client.

Example Audit Conditions include Settings changed, Actions changed, or Response Rulesets
changed. For a complete list of all Audit Conditions see the Audit Conditions topic.

You can configure Actions in response to Audit Conditions being met at the Global level (Shared
Groups), at the Site level, at the Computer level, or at the individual Connection level.

Use the links below to jump to a description of the various Conditions. For each Condition you
will find a description and any related Setting(s) which may affect the Condition.

Jump To:

General Conditions

Blocking SQL (‘General Conditions' in the on-line documentation)
Deadlocks (‘General Conditions' in the on-line documentation)

DTS Package (‘General Conditions' in the on-line documentation)

Event Chain (‘General Conditions’ in the on-line documentation)

Event Chain Node (‘General Conditions' in the on-line documentation)
Index ('General Conditions' in the on-line documentation)

Maintenance Plan (‘General Conditions' in the on-line documentation)
Oracle DBMS Job (‘General Conditions' in the on-line documentation)
Oracle EM Job ('General Conditions' in the on-line documentation)

Oracle Scheduler Job ("General Conditions' in the on-line documentation)
Performance Counter (‘General Conditions' in the on-line documentation)
Reporting Services Report (‘General Conditions' in the on-line documentation)
SharePoint Timer Job ('General Conditions' in the on-line documentation)
SQL Server Agent Alert (‘"General Conditions' in the on-line documentation)
SQL Server Agent Job (‘General Conditions' in the on-line documentation)
SQL Server Agent Log (‘General Conditions' in the on-line documentation)
Top Commands (‘General Conditions' in the on-line documentation)

Top SQL (‘General Conditions' in the on-line documentation)

Windows Task (‘General Conditions' in the on-line documentation)

Failsafe Conditions

Analysis Services ('Failsafe Conditions' in the on-line documentation)
Oracle Database (‘'Failsafe Conditions' in the on-line documentation)
Monitoring Service

SharePoint Server (‘Failsafe Conditions’ in the on-line documentation)

SQL Server Connection (‘Failsafe Conditions' in the on-line documentation)
Windows Task Scheduler (‘Failsafe Conditions' in the on-line documentation)
Audit Conditions

Custom Event View ('Audit Conditions' in the on-line documentation)
Event Chain (‘Audit Conditions' in the on-line documentation)

Global (‘Audit Conditions' in the on-line documentation)
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Performance Counter (‘Audit Conditions’ in the on-line documentation)

General Conditions

GENERAL CONDITIONS

General Conditions are applicable to monitored event objects or associated performance
counters. These are the most common Conditions which you will configure Actions for within
your environment. Please keep in mind that not all General Conditions apply to all event object
types. A Condition must be supported by an  object's underlying event provider in order for
Conditions and Actions to be available in SQL Sentry.

CONFIGURE ACTIONS FOR GENERAL CONDITIONS

Configure Actions for General Conditions
You can configure Actions in response to General Conditions being met at these levels:
Shared Groups (Global), Site, Computer Group, Computer, and Connection.

To do so, select the node appropriate to the level you would like to configure the action for in
the Navigator Pane and then the General Actions tab in the Actions Pane. If you do not see the
Actions Pane use the View menu - General Actions.

Next you will want to click the Add button found in the Actions Pane. This will open the Select
Action window. Expand the applicable Object and Condition. Use the check box(s) to select
which Actions should be taken in response to this Condition being met. Click the OK button.

For more information about Actions that can be taken when a Condition is met see the Actions
topic.

COMMON GENERAL CONDITIONS

Common General Conditions
The Following table contains a description of several common General Conditions.

Conditions Is Met When

Started Occurs when an event instance begins.

Completed Occurs when an event instance finishes running, regardless of success or failure
status.

Success Occurs when an event instance completes and returns a success status.

Failure Occurs when an event instance completes and returns a failure status.

Output Content Match This condition is met when specific content, which you define, exists in the output
message text for an event instance. See the Output Content Match topic for more
information.

Runtime Threshold Min Occurs whenever an event runs shorter than x% of its average runtime, or shorter

than an explicit duration.

Runtime Threshold Max Occurs whenever an event runs longer than x%  of its average runtime, or
longer than an explicit duration.

Performance Counter Threshold Min Occurs when a minimum performance threshold has been set for a performance
counter, and the counter's value falls below it.

Performance Counter Threshold Max Occurs when a maximum performance threshold has been set for a performance
counter, and the counter's value exceeds it.
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GENERAL CONDITIONS COMPREHENSIVE LIST

Use the links below to jump to a description of the various Conditions. For each Condition you
will also find a column which lists related Settings which affect the Condition . Settings define
criteria for when a Condition is considered to be met, including runtime thresholds for events
that are captured. Certain Settings, known as Source Settings define what events are
collected by SQL Sentry. For more information about Settings see the Settings topic.

Jump to:

General Conditions
Blocking SQL
Deadlocks

DTS Package

Event Chain

Event Chain Node
Index

Maintenance Plan
Oracle DBMS Job
Oracle EM Job

Oracle Scheduler Job
Performance Counter
Reporting Services Report
SharePoint Timer Job
SQL Server Agent Alert
SQL Server Agent Job
SQL Server Agent Log
Top Commands

Top SQL

Windows Task

BLOCKING SQL

Condition Description Related Setting
Blocking SQL A Block was detected, subject to the Minimum Block Duration set Blocking SQL
for the Blocking SQL Source. View the block on the Event Source:

Manager calendar or the Performance Advisor Blocking SQL tab. Minimum Block
Duration (‘SQL
Server Settings'
in the on-line
documentation)

Blocking SQL: Output Content Match | A match condition was found in the output content of a Block. Blocking SQL
Source:
Minimum Block
Duration ('SQL
Server Settings'
inthe on-line
documentation)

Condition
Settings
Blocking SQL: Runtime Threshold Block exceeded the maximum runtime threshold. Blocking SQL
Max Source:

Minimum Block
Duration ('SQL
Server Settings'
inthe on-line
documentation)
Blocking SQL:
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Condition Description Related Setting

Maximum
Runtime
Threshold
(‘'SQL  Server
Settings' in the
on-line
documentation)

DEADLOCKS
Condition Description Related Setting
Deadlock A Deadlock was detected. View the deadlock on the Event Manager Deadlocks
calendar or the Performance Advisor Deadlocks tab. Source: Collect
Deadlock Events
(‘SQL Server
Settings’ in the
on-line
documentation)
Deadlock: Output Content Match | A match condition was found in the output content of a Block. You Deadlocks
must define which strings to search for in the event output to trigger Source: Collect
this condition. See Condition Settings for more information. Deadlock

Events 'SQL

Server Settings'
inthe  on-line

documentation)

Condition
Settings

DTS PACKAGE

Condition Description Related Setting

Completed DTS Package completed. N/A
Failure DTS Package failed. N/A

Output Content Match A match condition was found in the output content of a DTS Package. Condition
Settings

Runtime Threshold Max | DTS Package exceeded the maximum runtime threshold. DTS Package:
Maximum
Runtime
Threshold
("SQL Server
Settings' in the
on-line
documentation)

Runtime Threshold Min DTS Package did not meet the minimum runtime threshold. DTS Package:
Minimum
Runtime
Threshold
(‘SQL Server
Settings’ in the
on-line
documentation)

Step Failure DTS Package step failed. N/A
Success DTS Package succeeded. N/A

EVENT CHAIN

Condition Description Related Setting

Completed Event Chain execution completed. N/A

Failure Event Chain execution failed. N/A

Runtime Threshold Max Event Chain exceeded the maximum runtime threshold. Event Chain:
Maximum
Runtime
Threshold
("Settings' in
the on-line
documentation)

Runtime Threshold Min Event Chain did not meet the minimum runtime threshold. Event Chain:
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Condition

Description

Related Setting

Minimum
Runtime
Threshold
("Settings' in
the on-line
documentation)

Started

Event Chain execution started.

N/A

Success

Event Chain execution succeeded.

N/A

EVENT CHAIN NODE

Condition

Description

Related Setting

Completed

Event Chain Node execution completed.

N/A

Failure

Event Chain Node execution failed.

N/A

Runtime Threshold Max

The runtime threshold maximum for an Event Chain Node was
exceeded.

Event Chain
Node:
Maximum
Runtime
Threshold
("Settings' in
the on-line
documentation)

Runtime Threshold Min

Event Chain Node did not meet the minimum runtime threshold.

Event Chain
Node: Minimum
Runtime
Threshold
("Settings' in
the on-line
documentation)

Started

Event Chain Node execution started.

N/A

Success

Event Chain Node execution succeeded.

N/A

MAINTENANCE PLAN

Condition Description Related
Setting
Output Content Match A match condition was found in the output content of a Maintenance Plan. Condition
Settings
Step Failure Maintenance Plan step failed. N/A

ORACLE DBMS JOB

Condition

Description

Related Setting

Completed

Oracle DBMS Job completed.

N/A

Failure

Oracle DBMS Job failed.

N/A

Runtime Threshold Max

Oracle DBMS Job exceeded the maximum runtime threshold.

Oracle DBMS
Job: Maximum
Runtime
Threshold
("Oracle
Database
Settings’ in the
on-line
documentation)

Runtime Threshold Min

Oracle DBMS Job did not meet the minimum runtime threshold.

Oracle DBMS
Job: Minimum
Runtime
Threshold
("Oracle
Database
Settings' in the
on-line
documentation)

Success

Oracle DBMS Job succeeded.

N/A

ORACLE EM JOB
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Description

Related Setting

Completed

Oracle EM Job completed.

N/A

Failure

Oracle EM Job failed.

N/A

Output Content Match

A match condition was found in the output content of a DTS Package.

Condition
Settings

Runtime Threshold Max

Oracle EM Job exceeded the maximum runtime threshold.

Oracle DBMS
Job: Maximum
Runtime
Threshold
("Oracle
Database
Settings' in the
on-line
documentation)

Runtime Threshold Min

Oracle EM Job did not meet the minimum runtime threshold.

Oracle DBMS
Job: Minimum
Runtime
Threshold
(‘Oracle
Database
Settings’ in the
on-line
documentation)

Success Oracle EM Job succeeded. N/A
ORACLE SCHEDULER JOB

Condition Description Related Setting

Completed Oracle Scheduler Job completed. N/A

Failure Oracle Scheduler Job failed. N/A

Output Content Match A match condition was found in the output content for an Oracle Condition

Scheduler Job. Settings

Runtime Threshold Max Oracle Scheduler Job exceeded the maximum runtime threshold. Oracle DBMS
Job: Maximum
Runtime
Threshold
("Oracle
Database

Settings' in the
on-line
documentation)

Runtime Threshold Min

Oracle Scheduler Job did not meet the minimum runtime threshold.

Oracle DBMS
Job: Minimum
Runtime
Threshold
("Oracle
Database
Settings' in the
on-line
documentation)

Success

Oracle Scheduler Job succeeded.

N/A

PERFORMANCE COUNTER

Condition

Description

Related
Setting

Threshold Max

Performance Counter value exceeded the maximum threshold.

Performance
Counter:
Counter
Thresholds
Maximum

Threshold Min

Performance Counter did not meet the minimum threshold

Performance
Counter:
Counter
Thresholds
Minimum

REPORTING SERVICES REPORT
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Condition Description Related Setting

Completed Reporting Services Report completed. N/A

Failure Reporting Services Report failed. N/A

Runtime Threshold Max Reporting Services Report exceeded the maximum runtime threshold. Reporting
Services
Report:
Maximum
Runtime
Threshold
("SQL Server
Settings' in the
on-line
documentation)

Runtime Threshold Min Reporting Services Report did not meet the minimum runtime Reporting
threshold. Services
Report:
Minimum
Runtime
Threshold
('SQL Server
Settings’ in the
on-line
documentation)

Started Reporting Services Report started. N/A

Success Reporting Services Report succeeded. N/A

SHAREPOINT TIMER JOB

Condition Description Related Setting

Completed SharePoint Timer Job completed. SharePoint
Timer Jobs
Source:
Minimum Event
Duration
("SharePoint
Settings' in the
on-line
documentation)

Failure SharePoint Timer Job failed. SharePoint
Timer Jobs
Source:
Minimum Event
Duration
("SharePoint
Settings' in the
on-line
documentation)

Output Content Match A match condition was found in the output content for a SharePoint Condition Settings
Timer Job.

Runtime Threshold Max SharePoint Timer Job exceeded the maximum runtime threshold. SharePoint
Timer Jobs
Source:
Minimum Event
Duration
("SharePoint
Settings' in the
on-line
documentation)
SharePoint
Timer Job:
Maximum
Runtime
Threshold
("SharePoint
Settings' in the
on-line
documentation)

Runtime Threshold Min SharePoint Timer Job did not meet the minimum runtime threshold. SharePoint
Timer Jobs
Source:
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Condition Description Related Setting

Minimum Event
Duration
("SharePoint
Settings' in the
on-line
documentation)
SharePoint
Timer Job:
Minimum
Runtime
Threshold
("SharePoint
Settings' in the
on-line
documentation)

Started SharePoint Timer Job started. SharePoint
Timer Jobs
Source:
Minimum Event
Duration
("SharePoint
Settings’ in the
on-line
documentation)

Success SharePoint Timer Job succeeded. SharePoint
Timer Jobs
Source:
Minimum Event
Duration
("SharePoint
Settings' in the
on-line
documentation)

SQL SERVER AGENT ALERT
Condition Description Related
Setting
Alert Fired SQL Server Agent Alert was fired. N/A
Output Content Match A match condition was found in the output content of a SQL Server Agent Alert. | Condition
Settings
SQL SERVER AGENT JOB

Condition Description Related Setting

Block SQL Server Agent Job is blocked or is blocking. The Minimum
Block Duration
Required to
Trigger "SQL
Server  Agent
Job: Block"
Condition can
be changed in
the Monitoring
Service
Setting.
(Monitoring
Service ->
Settings -
>Event
Monitor)

Completed SQL Server Agent Job completed. N/A

Conflict There was a job conflict, meaning two or more jobs were seen N/A

running concurrently.
Failure SQL Server Agent Job failed. N/A
Output Content Match A match condition was found in the output content of a SQL Server Condition
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Condition Description Related Setting
Agent Job. Settings

Queued SQL Server Agent Job was queued via SQL Sentry's queuing SQL Server
system. Agent Job:
Queue Type
("SQL Server
Settings' in the
on-line
documentation)

Retry SQL Server Agent Job step was retried. N/A

Run Missed The scheduled run for a job was missed for some reason. This may SQL Server

be because SQL Server Agent was offline. Agent Jobs
Source: Missed
Run Threshold
("SQL Server
Settings' in the
on-line
documentation)

Runtime Threshold Max SQL Server Agent Job exceeded the maximum runtime threshold. SQL Server
Agent Job:
Maximum
Runtime
Threshold
("SQL Server
Settings’ in the
on-line
documentation)

Runtime Threshold Min SQL Server Agent Job did not meet the minimum runtime threshold. | SQL Server
Agent Job:
Minimum
Runtime
Threshold
("SQL Server
Settings' in the
on-line
documentation)

Started SQL Server Agent Job started. N/A
Step Failure SQL Server Agent Job step failed. N/A
Success SQL Server Agent Job succeeded. N/A

SQL SERVER AGENT LOG

Condition Description Related
Setting
Error An Error event occurred in the SQL Server Agent Log. N/A
Output Content Match A match condition was found in the output content of a SQL Server Agent Condition
Log. Settings
Warning A Warning event occurred in the SQL Server Agent Log. N/A

TOP COMMANDS

Condition Description Related Setting

Top Commands: Completed An Analysis Services command (MDX or XMLA) completed. NOTE: Top Commands
It is highly recommended that a ruleset be used with this condition to | Source: Collect
avoid excessive logging. MDX/DMX/XMLA

Events ('SSAS
Settings' in the
on-line
documentation)
Top Commands
Source:
Minimum
Duration ('SSAS
Settings' in the
on-line
documentation)

Top Commands: Error An Analysis Services command (MDX or XMLA) completed with an Top Commands
error. Source: Collect
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Condition Description Related Setting
MDX/DMX/XMLA
Events ('SSAS
Settings' in the
on-line
documentation)
Top Commands
Source:
Minimum
Duration ('SSAS
Settings' in the
on-line
documentation)

Top Commands: Output Content A match condition was found in a completed Analysis Services Top Commands
Match command (MDX or XMLA). Source: Collect
MDX/DMX/XMLA

Events (‘SSAS
Settings' in the
on-line

documentation)

Top Commands
Source:

Minimum
Duration ('SSAS
on-line
documentation)
Condition
Settings

Top Commands: Runtime The runtime threshold maximum was exceeded for an Analysis Top

Threshold Max Services command (MDX or XMLA). Commands:
Maximum
Runtime
Threshold
("SSAS Settings'
in the on-line
documentation)
Top Commands
Source: Collect
MDX/DMX/XMLA
Events ('SSAS
Settings' in the
on-line
documentation)
Top Commands
Source:
Minimum
Duration ('SSAS
Settings' in the
on-line
documentation)

TOP SQL

Condition Description Related Setting

Top SQL: Completed Top SQL event completed. NOTE: It is highly recommended that a Top SQL Source
ruleset be used with this condition to avoid excessive logging. ('SQL Server
Settings’ in the
on-line
documentation)

Top SQL: Error Top SQL event completed with an error. Top SQL Source
("SQL Server
Settings' in the
on-line
documentation)
Top SQL: Output Content Match A match condition was found in the content of a completed Top SQL | Top SQL
event. Source ('SQL
Server Settings'
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Condition Description Related Setting
inthe on-line
documentation)
Condition

Settings

Top SQL: Runtime Threshold Max | Top SQL event exceeded the maximum runtime threshold. Top SQL
Source ('SQL
Server Settings'
inthe on-line
documentation)
Top SQL:
Maximum
Runtime
Threshold
('SQL  Server
Settings' in the
on-line
documentation)

WINDOWS TASK

Condition Description Related
Setting

Completed Windows Task completed. N/A

Failure Windows Task failed, as determined by the success exit code setting for the N/A

task.

Output Content Match A match condition was found in the output content for a Windows Task. Condition
Settings

Runtime Threshold Max Windows Task exceeded the maximum runtime threshold. Windows
Task:
Maximum
Runtime
Threshold

Runtime Threshold Min Windows Task did not meet the minimum runtime threshold. Windows
Task:
Maximum
Runtime
Threshold

Started Windows Task started. N/A

Success Windows Task succeeded, as determined by the success exit code setting for N/A

the task.

Failsafe Conditions

FAILSAFE CONDITIONS

Failsafe Conditions fall into two categories: Connection Status and Error. Connection Status
Failsafe Conditions are met when a Connection goes Offline or Online. The Offline Condition for
a Connection will be met if a server crashes or becomes otherwise unavailable. The Online
condition will be met once that Connection becomes available again. Failsafe Error Conditions
are met when there is an error detected with a SQL Sentry Monitoring Service or related
monitoring process.

The Log to Database Action (‘Actions’ in the on-line documentation) and the Send Email Action (‘Actions’
in the on-line documentation) are both configured by default for all Failsafe Conditions. This is so you can be
alerted whenever a connection goes offline, or whenever the SQL Sentry Monitoring  Service experiences an
error and is unable to perform its work.

CONFIGURE ACTIONS FOR FAILSAFE CONDITIONS

Configure Actions for Failsafe Conditions
You can configure Actions in response to Connection Status Failsafe Conditions being met at
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these levels: Shared Groups (Global), Site, Computer Group, Computer, and Connection. You
can configure Actions in response to Failsafe Error Conditions being met at the Global level
(Shared Groups) or at the Site level.

To do so, select the node appropriate to the level you would like to configure the action for in
the Navigator Pane and then the Failsafe Actions tab in the Actions Pane. If you do not see the
Actions Pane use the View menu -> Failsafe Actions.

Next you will want to click the Add button found in the Actions Pane. This will open the Select
Action window. Expand the applicable Object and Condition. Use the check box(s) to select
which Actions should be taken in response to this Condition being met. Click the OK button.

For more information about Actions that can be taken when a Condition is met see the Actions
topic.

Below you will find a complete listing of all Failsafe conditions.

Failsafe Conditions
Analysis Services

Oracle Database
Monitoring Service
SharePoint Server

SQL Server Connection
Windows Task Scheduler

ANALYSIS SERVICES
Condition Description
Offline Analysis Services is offline or otherwise inaccessible.
Online Analysis Service is online and accessible.

ORACLE DATABASE

Condition Description
Offline Oracle Database is offline or otherwise inaccessible.
Online Oracle Database is offline or otherwise inaccessible.

MONITORING SERVICE

Condition Description

Event History Monitor: Error An error was encountered by the Event History Monitor, the process responsible
for historical data collection from various sources.

Job Monitor: Error An error was encountered by the Job Monitor, the process responsible for
collecting data for running SQL Server Agent Jobs.

Message Processor: Message | The Message Processor reached its max messages per interval threshold, and
Action Throttled at least one message was throttled. Subsequent messages will be sent to the
Actions Log. See SQL Sentry Monitoring Service->Settings.

Performance Monitor: Error An error was encountered by the Performance Monitor, the process responsible
for collecting performance data.

Reporting Services Monitor: Error | An error was  encountered by the  Reporting Services Monitor, the process
responsible for collecting data for SSRS reports.

Monitoring Service: Action Failed | The SQL Sentry Monitoring Service attempted to execute an action, but the action failed.
For example, the Send Email action can fail if the SMTP server is unavailable.

Monitoring Service: Database | The SQL Sentry repository database is offline or otherwise inaccessible.
Offline

Monitoring Service: Database | The SQL Sentry repository database is online and accessible.
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Monitoring Service: Performance
Collection Failed

The Performance Monitor encountered an error while collecting data for a specific
performance counter.

Monitoring Service: Repository | An error occurred while writing data to the SQL Sentry repository database.
Error
Monitoring Service: [ The SQL  Sentry Monitoring  Service encountered  a critical  error while
Synchronization Error synchronizing settings from the SQL Sentry database with its  configuration
management thread.
Windows Task Scheduler | An error was encountered by the Task Scheduler Monitor, the process
Monitor: Error responsible for collecting data for Windows Tasks.
SHAREPOINT SERVER
Condition Description
Offline SharePoint Server is offline or otherwise inaccessible.
Online SharePoint Server is online and accessible.
SQL SERVER CONNECTION
Condition Description

SQL Server Agent: Offline

SQL Server Agent is offline or otherwise inaccessible.

SQL Server Agent: Online

SQL Server Agent is online and accessible.

SQL Server Cluster Failover

The SQL Server cluster failed over.

SQL Server Connection: Offline

SQL Server is offline or otherwise inaccessible.

SQL Server Connection: Online

SQL Server is online and accessible.

WINDOWS TASK SCHEDUL

ER

Condition

Description

Offline

SharePoint Server is offline or otherwise inaccessible.

Online

SharePoint Server is online and accessible.

Audit Conditions

AUDIT CONDITIONS

Audit Conditions are applicable to various activities carried out both inside and outside of the

SQL Sentry Client.

Audit Conditions provide a way

for you to be  notified when various

Settings are changed, or monitored objects are modified from within the SQL Sentry Client.

The Log to Database Action

("Actions' in the on-line documentation) is configured by default for all Audit

Conditions. This gives you an audit trail concerning changes to your SQL Sentry environment. If you would like to
be notified about an Audit Conditions happening in your environment you could configure the Send Email Action
(‘Actions’ in the on-line documentation).

CONFIGURE ACTIONS FOR AUDIT CONDITIONS
Configure Actions for Audit Conditions

You can configure additional

Actions inresponse to Audit Conditions being met at these

levels: Shared Groups (Global), Site, Computer Group, Computer, and Connection.

To do so, select the node appropriate to the level you

would like to configure the action for in

the Navigator Pane and then the Audit Actions tab in the Actions Pane. If you do not see the
Actions Pane use the View menu - Audit Actions.
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Next you will want to click the Add button found in the Actions Pane. This will open the Select
Action window. Expand the applicable Object and Condition. Use the check box(s) to select
which Actions should be taken in response to this Condition being met. Click the OK button.

For more information about Actions that can be taken when a Condition is met see the Actions

topic.

For a complete listing of all Audit conditions, see below.

Audit Conditions
Custom Event View
Event Chain

Global

Performance Counter

CUSTOM EVENT VIEW

Condition

Description

Custom Event View Created

A Custom Event View was created.

Custom Event View Deleted

A Custom Event View was deleted.

EVENT CHAIN

Condition

Description

Event Chain Modified

An Event Chain was modified.

GLOBAL

Condition

Description

Actions Changed

A configured Action was changed for an object.

Contacts Changed

A Contact was changed.

Event Object Created

An Event Object (job, task, etc.) was created.

Event Object Deleted

An Event Object (job, task, etc.) was deleted.

Event Object Properties Modified

An Event Object's (job, task, etc.) properties were modified.

Event Object Rescheduled

An Event Object (job, task, etc.) was rescheduled. For some object types
this condition is only detected when rescheduling in the SQL Sentry Client
via drag-and-drop.

Notes Changed

A note was changed.

Response Ruleset Created

A Response Ruleset was created.

Response Ruleset Deleted

A Response Ruleset was deleted.

Response Ruleset Modified

A Response Ruleset was modified.

Settings Changed

Object or application settings were changed.

Watched Flag Changed

The watched flag was changed for an object.

PERFORMANCE COUNTER

Condition

Description

Performance Counter Added

A Performance Counter was added to an event object or event view.

Performance Counter Deleted

A Performance Counter was deleted from an event object or event view.

Performance Monitored Flag Changed

The Performance Monitored flag was changed for an event object or event
view.

Actions
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ACTIONS

The Alerting and Response systemin  SQL Sentry uses the concept of Conditions and
Actions. Actions can be defined in response to certain  Conditions being met within  your
environment. You can choose from a variety of Actions, depending on which Condition is
being responded to.

All Actions work on the principle of inheritance. This means that if you configure an  Action in
response to a Condition being met at the Global level ( Shared Groups), it will be automatically
passed down to all applicable objects below it. This allows you to define Global Actions for the
most common issues across your environment once, and have those passed down to every
monitored server automatically. You can further refine Actions at each level as needed. For a
visual representation of how inheritance works  within SQL Sentry see the Alerting and
Response System Hierarchy diagram (‘'Alerting and Response System' in the on-line

documentation).

Each Action that you configure in  your environment will have an  associated behavior. The
behavior controls how the Action will be carried out relative to any inherited Actions. There are
three Action behaviors available: Override Inherited Actions, Combine with Inherited
Actions, and Disabled. For a complete explanation and example usage scenario for each
behavior see the Action Behavior section below.

You can fine tune Actions for a specific group of objects or even  an individual object, giving
you effective control over how SQL  Sentry works throughout your environment. SQL ~ Sentry
comes with a number of Global Actions predefined to get you up and running quickly. These
Actions can be changed, as needed to fit the specific needs of your environment.

Jump to:
Actions

Kill Task

Log to Event Log
Log to Disk
Send Email
Execute SQL
Send SNMP Trap
Log To Database
Execute Process
Send Page

Run QuickTrace
Execute Job

HOW TO CONFIGURE ACTIONS

If you are upgrading from a previous version of SQL Sentry you will notice that the Actions and
Settings pane has been overhauled.

The Conditions displayed in the Actions pane will change depending on which node or object
you have selected in the Navigator pane. If you do not see the Actions pane once you have
selected a node in the Navigator pane, use the View Menu (View ->General Actions / Failsafe
Actions / Audit Actions ).
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If you select the Shared Groups node you will see globally applied Conditions in  the Actions
pane. When you select any applicable object level below the Shared Groups node, you will see
two specific sets of applied Conditions in the Actions pane.

The top section of the Actions pane contains the Inherited Section, which shows you any
applied Conditions that are being passed down to the current object level. The Inherited Section
also contains an Object column, which shows you the object level the Condition is being
inherited from. When an Inherited Condition is overridden or disabled, it will still show up in the
Inherited Section, but its text will be grayed-out, and its status will say Overridden.

Directly beneath the Inherited Section, is the Explicit Section. The Explicit Section contain
applied Conditions that have been set at the current object level. The Explicit Section also
displays a Behavior column. Each Action that you set up in your environment  will have an
associated behavior. This behavior controls how the Action  will be carried out relative to any

inherited Actions.

To add a new Action, select the desired node in the Navigator pane. Next you will want to click
the Add button found in the Actions Pane. This will open the Action Selector window. Expand
the applicable object and Condition. Use the check box(s) to select which Actions should be
taken in response to this Condition being met. Click the OK button.

You may also choose to quickly Disable, Override, or Combine any inherited Actions. To do so,
simply select a Condition in the Inherited Section of the Actions pane and choose the desired
command (Disable button, Override button, or Combine button).

ACTION BEHAVIORS

Each action that you setup in your environment will have an associated behavior. This behavior
controls how the action will be carried out relative to any inherited actions.

The user can change the Behavior of any Action to one of the following:
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Behavior Description

Override Inherited Actions Actions defined with this behavior  will override all actions that are
being inherited from a higher level. This behavior can be thought of
as a special set of instructions which are followed instead of the
passed down(inherited) instructions.

When a condition occurs which triggers  an action defined with the
Override Inherited Actions behavior, inherited actions will not  be
executed, but the action which is defined at that specific level will be
executed.

The Override Inherited Actions behavior is the default behavior
assigned for any newly defined action.

->For an example scenario  see the Override Inherited Actions
Example (‘Action Behaviors' in the on-line documentation).

Combine with Inherited Actions Actions defined with this behavior will be combined with all inherited
actions. This behavior can  be thought of as  a set of instructions
which are  followed jn addition to the passed down(inherited)
instructions.

When a condition occurs which triggers an Action defined with the
Combine with Inherited Actions behavior, all inherited actions will
be executed, and all actions that are defined at that specific level will
also be executed.

->Foran example scenario seethe Combine with Inherited
Actions Example (‘Action Behaviors' in the on-line
documentation).

Disabled When an action is defined with the Disabled behavior it will disable
any action of the same  action type, which is being inherited for a
certain Condition. This behavior can be thought of as a special set of
instructions which simply disallow the passed down(inherited) set of

instructions.

When a condition occurs which triggers  an Action defined with the
Disabled behavior, inherited Actions will not be executed.

->For an example scenario see the Disabled Example (‘Action
Behaviors' in the on-line documentation).

MULTIPLE ACTIONS PER CONDITION

One of the new improvements made to the Alerting and Response System it the ability to add
multiple versions of the same action type per condition . You can use this ability, in combination
with Response Rulesets to implement escalation procedures when certain  Conditions take
place.

¥ NOTE: Configured actions of the same action type, defined at the same object level,  will have their behavior
types bound together. This is because inherited actions can  not simultaneously be in more  than one state.
(disabled, combined, and overridden)

ACTIONS

KILL TASK ACTION

The Kill Task Action will "Kill", or cancel the current job. This action is typically associated with
Runtime Maximum, Performance Threshold Maximum, Block, or Conflict conditions, in order to
prevent resource contention situations. It is not applicable to the Started condition, or any
conditions implying event instance completion. See the Conditions and Actions Matrix for a
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complete listing.

LOG TO EVENT LOG ACTION

The log to Event Log Action sends data relevant to the condition to the Application Event Log
on the SQL Sentry Monitoring Service computer.

LOG TO DISK ACTION

The Log to Disk Action sends data relevant to the condition to  the specified text file on the
SQL Sentry Monitoring Service computer's file system.

SEND EMAIL ACTION

The Send Email Action sends an email alert to the Users  or Groups specified in the Action
Settings. For more information about Users and Groups see the Contacts Management topic.

Certain Alert emails in version 7.0 now include a [View in SQL Sentry Client] section. You will
notice that the Event View section contains a hyperlink which begins with the SQL Sentry URL
protocol. Selecting this link will open the Event View in  the SQL Sentry Client for the specific
condition which triggered the alert.

To stop receiving the Outlook Security Notice when you select an Alert email link you will need to enable trust for
the SQL Sentry protocol. Please see the Trusting the SQL Sentry hyperlink in Outlook KB article.

Settings
The Actions Settings tab allows the following configurations.
Option Description
Select Targets Specify which Users or Groups will receive the email alert.
Importance Specify the importance level of the email alert.
From Address Specify the from email address of the alert. To use the default email address
leave this blank. For more information see the SMTP configuration section of
the SQL Sentry Monitoring Service Settings topic.

EXECUTE SQL ACTION
The Execute SQL Action executes the T-SQL statement(s) on the specified SQL Server.

Settings
Use the Server list to select a server, and enter the desired T-SQL in the command text box.

SEND SNMP TRAP ACTION

The Send SNMP Trap Action sends an Simple Network Management Protocol (SNMP)  trap
notification. For more about configuring SNMP  see the SQL Sentry Monitoring Service
Settings ('"Monitoring Service Settings' in the on-line documentation) topic.

LOG TO DATABASE ACTION
The Log To Database Action will log data relevant to the condition to the Actions log.


http://forum.sqlsentry.net/topic2136-trusting-the-sql-sentry-hyperlink-in-outlook.aspx
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EXECUTE PROCESS ACTION

The Execute Process Action will execute the defined command text on the specified SQL
Server.

Settings
Within the Execute Process Action Settings tab you will see the Execute Process section. Use

the Server list to select a server. Use the Command Text box enter the desired literal command.

¥ NOTE: You may also pass certain system parameters, as well as user defined parameters through output text.

SEND PAGE ACTION

The Send Page Action sends an alert to the Pager address for the specified Users or Groups.
For more information about Users and Groups see the Contacts Management topic.

Settings
The Actions Settings tab for the Send Page Action allows the following configurations.
Option Description
Select Targets Specify which Users or Groups will receive the pager alert.
Importance Specify the importance level of the pager alert.
From Address Specify the From address of the alert. To use the default email address leave
this blank. For more information  see the SMTP configuration section  of the
SQL Sentry Monitoring Service Settings topic.

RUN QUICKTRACE™ ACTION

The Run QuickTrace Action executes a Quick Trace™ againsta specified target server. A
Quick Trace is a comprehensive snapshot of activity created by combining process-level data
and trace events collected during a brief sample period. A Quick Trace is not filtered, so it
collects all events on the specified SQL Server.

The Quick Trace Action is now available for a wide range of conditions.

To avoid impacting the performance of the target SQL Server, Quick Trace is both time and size
limited. Only one simultaneous Quick Trace can be run against any target server. Quick Traces
are also throttled to control the time between successive runs. The current allowed frequency is
one minute. This means that once a Quick Trace is completed, another Quick Trace cannot
begin on the same specified server until one minute has elapsed.

Settings
The Actions Settings tab for the Quick Trace Action allows the following configurations.
Option Description
Run QuickTrace Against Specify the Target server on which the Quick Trace will run.
Run QuickTrace for Specify the length of time  which the Quick Trace will  run against the target
server.
Collect Statement Events Specifies whether or  not to collect Statement Level Events. Enabling the

Collect Statement Events option will  dramatically increase the amount trace
data collected.

Limit Trace Data to Specify the maximum number of rows which the Quick Trace will collect.



http://www.sqlsentry.net/help/ug/System_Parameters.html
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EXECUTE JOB ACTION

The Execute Job Action executes a SQL Agentjob onthe current server, or any other
watched server in your enterprise. This action effectively enables you to create simple "one-to-
one" job chains by associating it with Completed, Success or Failure conditions. Also see Event
Chains for more advanced chaining features.

Settings
Within the Action Settings tab you will see the Jobs To Execute section. Use the server list to

select a server. Use the job list to specify the SQL Agent Job to run. Once a target job has been
specified for this action, it will show up in the Event Manager Calendar View with a grid pattern
background as a indication of its conditional execution.

Behaviors

ACTION BEHAVIORS

OVERRIDE INHERITED ACTIONS EXAMPLE

Actions defined with the Override Inherited Actions behavior will override all actions that are
being inherited from a  higher level. This behavior can be thought of as a special set of
instructions which are followed instead of the passed down(inherited) instructions.

For this example assume the following:

There is a Send Email Action (‘Actions’ in the on-line documentation) configured at the Global level which has a
selected target of DBA1 forthe SQL Server Agent Job: Failure condition (‘Conditions'in the on-line
documentation).

With this Action configured as above, anytime a SQL Sever Agent Job  fails across the entire monitored Enterprise
the following will occur:

1. The SQL Server Agent Job: Failure condition is met.
2. In response to the Condition being met, the Send Email Action will execute, sending a notification email to
DBA1.

Now suppose there is a Development Server ( DEVServer) in the environment, which is not managed by DBA1. For
this particular server when an Agent Job fails, instead of the user DBA1 being alerted, you would like notification
emails sent to the developer or user DEV1.

To accomplish this you would want to add a Send Email Action (‘Actions’ in the on-line documentation) with a
selected target of DEVA1, forthe SQL Server Agent Job: Failure condition (‘Conditions' in the on-line
documentation) at the Connection level with a behavior of Override Inherited Actions.

With this Action configured as above, anytime a SQL Sever Agent Job fails on the Development Server the following
will occur:

1. The SQL Server Agent Job: Failure condition is met.
2. In response to the condition being met, the Send Email Action will execute, sending a notification email to
DEVA1.

Only the Development Server would be impacted by this change. The rest of the monitored Enterprise would still be
subject to the Globally configured Send Email Action which has a selected target of DBA1.

COMBINE WITH INHERITED ACTIONS EXAMPLE

Actions defined with the Combine with Inherited Actions behavior will be combined with all
inherited actions. This behavior can be thought of as a set of instructions which are followed in
addition to the passed down(inherited) instructions.



http://www.sqlsentry.net/help/ug/Event_Chains.html
http://www.sqlsentry.net/help/ug/Event_Chains.html
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For this example assume the following:
There is a Send Email Action (*Actions’ in the on-line documentation) configured at the Global level which has a
selected target of DBA1 for the SQL Server: Offline condition (‘Conditions' in the on-line documentation).

With this Action configured as above, anytime a SQL Sever is detected t o be offline across the entire monitored
Enterprise, the following will occur:

1. The SQL Server: Offline Condition is met.
2. In response to the Condition being met, the Send Email Action will execute, sending a notification email to
DBA1.

Now suppose there is a SQL Server (ASPServer) in the environment that has an internet facing workload. When the
SQL Server: Offline C ondition is met you would still like to  notify DBA1, but you would also like to  notify the Web
Developer, WEBDEV1.

To accomplish this you would want to add a Send Email Action ('Actions’ in the on-line documentation) , with a
selected target of WEBDEV1, for the SQL Server: Offline condition (‘Conditions’ in the on-line documentation)
at the Connection level with a behavior of Combine with Inherited Actions.

With this Action configured as above, anytime that the ASPServer is detected to be offline, the following will occur:

1. The SQL Server: Offline Condition is met.
2. In response to the condition being met, the Send Email Action will execute, sending a notification email to
DBA1 and WEBDEV1.

Only the ASPServer would be impacted by this change. The rest of the monitored Enterprise would still be subject to
the Globally configured Send Email Action for the SQL Server: Offline Condition, which has a selected target of
DBA1.

DISABLED BEHAVIOR EXAMPLE

When an Action is configured for a Condition with the Disabled Action behavior, it will disable
any action of the same action type, which is being inherited. This behavior can be thought of as
a special setof instructions which simply disallow the passed down(inherited) set of
instructions.

For this example assume the following:

On TestServer1 there is a Send Email Action (‘Actions’ in the on-line documentation) configured which has a
selected target of DBA1 for the SQL Server Agent Job: Runtime Threshold Max condition ('‘Conditions’ in the
on-line documentation). This actions is configured at the Connection level.

With this Action configured as above, anytime any SQL Agent Job meets the Runtime Threshold Max condition on
TestServer1 the following will occur:

1. The SQL Server Agent Job: Runtime Threshold Max Condition is met.
2. In response to the Condition being met, the Send Email Action will execute, sending a notification email to
DBA1.

Now suppose there is a Job, LongRunningJob, that is known to be long runningon TestServer1. DBA1 has no
need to be alerted about it and would like to disable runtime notifications about this job.

To accomplish this you would want to add a Send Email Action (‘Actions’ in the on-line documentation) for the
SQL Server Agent Job: Runtime Threshold Max condition (‘Conditions’ in the on-line documentation) at the
object level(the LongRunningJob) with a behavior of Disabled.

With this Action configured as above when the LongRunningJob runs long, the following will occur:

1. The SQL Server Agent Job: Runtime Threshold Max Condition is met.
2. In response to the Condition being met, the inherited Send Email Action will not be executed.

Only the individual SQL Agent Job LongRunningJob will be impacted by this change. The rest of the SQL Agent
Jobs on TestServer1 will still be subject to the Connection level Send Email Action configured for the SQL Server
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Agent Job: Runtime Threshold Max Condition.

Settings

SETTINGS

What makes Settings especially relevant in the context of the Alerting and Response System is
that certain Settings define the criteria of when a Condition is considered to be met. This
includes Runtime Threshold Settings.

Other Settings, known as Source Settings define what events are collected by SQL Sentry.
The Source Settings define minimum duration thresholds for the  collection of events taking
place in the monitored environment. These Source Settings have a direct correlation to
Conditions being met, as an event must first be  captured before any Condition related to it
can be evaluated. These Setting include various Collection Settings.

WHERE TO CONFIGURE SETTINGS

You can configure Settings at the Global level ( Shared Groups), Site level, Computer Group
level, Computer level, Connection level, or at the individual object level as applicable. Settings
are hierarchical, and work  through the principle of inheritance. This means that Settings
applied at the Global level (Shared Groups)are automatically inherited by all the
Sites, Computer Groups, Computers, Connections, and Objects in your environment. Generally
it is a good idea to configure your Settings Globally, and then adjust Settings as needed at the
lower levels.

HOW TO CONFIGURE SETTINGS

To configure a Setting first select the desired node in the Navigator pane. For instance, select
the Shared Groups node if you want to configure Settings Globally, or select an individual
Connection node if you would like to configure Settings specific to just that Connection. If you
do not see the Settings pane once you have selected your desired node in the Navigator pane,
use the View Menu ( View ->Settings). Next you will want to use the drop-down lists  found in
the Settings pane, to select the Settings which you would  like to configure. See below  for
examples.

For instance, if you wanted to configure the Top SQL Minimum Duration Collection Setting Globally:

1. Select the Shared Groups node in the Navigator Pane
2. In the Settings pane, use the top drop-down list and select SQL Server Settings.

3. Use the second drop-down list to select Top SQL Source. You should now see the Top SQL Source Settings
that are being applied Globally.

4, Change the Minimum Duration to the desired value, it will be saved automatically.

If you wanted to configure the SQL Server Agent Job Maximum Runtime Threshold Percent for an individual
Connection:

1. Select the desired Connection node in the Navigator pane.
2. In the Settings pane, use the top drop-down list and select SQL Server Settings.

3. Use the second drop-down list to select SQL Server Agent Job. You should now see the SQL Server Agent
Job Settings that are configured for the Connection.

4. Change the Inherit From Parent Setting to False.
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| 5. Change the Maximum Runtime Threshold Percent to the desired value, it will be saved automatically. |

COMPREHENSIVE LISTING OF SETTINGS

Use the links below to jump to the individual topics for more information about various Settings.
You will find a description of each Setting and a Related Condition column. This Related
Condition column contains a link to the Condition(s) that are affected by the specific Settings.

SQL Server Settings
SSAS Settings

Oracle Database Settings
SharePoint Settings

Task Scheduler Settings

GENERAL INFORMATION ABOUT SELECT SETTINGS

Runtime Thresholds Settings
Runtime Thresholds can be set for a number of sources such as SharePoint Timer Jobs or SQL
Server Agent Jobs.

Percent Based

A value for Minimum Runtime Threshold Percentand Maximum Runtime Threshold
Percent can be specified.

The global Minimum Threshold  Percent default is 10%. The Maximum Threshold Percent
default is 250%. This means that anytime a job runs for less than 10% or longer than  250% of
it's average runtime the Associated Condition would be met and any Actions configured for that
Condition would also take place. If too many messages are being received, these settings can
be adjusted as needed.

Time Based

Explicit time-based thresholds can also be specified. Anytime an explicit time-based threshold
is specified it  will override the percentage based thresholds for that object. Time-based
thresholds are usually less valuable at the Global level, particularly the Minimum  Runtime
Threshold, which doesn't have much value at all globally. Explicit runtime thresholds tend to be
more applicable at the actual connection or object level for overriding the global percentage
thresholds on a case-by-case basis.

[# NOTE: One notification will  be sent once the Maximum Runtime Threshold has beenmetanda separate
notification will be sent once it has completed.

For example, consider a job that has a great deal of volatility in runtime such as a transaction
log backup, which can run for anywhere between 30 seconds and 30 minutes, and it's average
runtime is 5 minutes. To avoid unnecessary percentage-based threshold notifications for the
job, one option would be to setits Maximum Runtime Threshold to"35 Minutes" and
Minimum Runtime Threshold to "20 Seconds". This can be done by selecting either the job's
node in the Navigator or an instance of the job on the calendar, then follow the same steps as
above to access and change the job's runtime threshold settings.

[§ NOTE: Runtime Threshold messages for Reporting Services Reports  completing in less than two minutes, and
DTS packages will not be processed until they are complete.

Performance Counter Threshold Settings
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The Performance Counter Settings screen is used to set the minimum and maximum values for
the counter thresholds of that particular counter. These will be used to trigger the Performance
Counter: Threshold Min and Max conditions if any actions are enabled for them. This option is
only available when selecting a specific performance counter from the Navigator Pane. There
can be only one minimum and one maximum value for a given counter, regardless of how many
objects are linked to the counter. For more information about Performance Counters see the
Performance Counter topic.

COMPUTER SETTINGS

Setting Description Related
Condition
Maintenance Window Used to set a schedule for the Maintenance Window. Only Log Failsafe
Actions will  be triggered  for Failsafe ~ conditions inside  the | Conditions

Maintenance Window. Maintenance = Window setting allow a time
frame to be specified while daily maintenance activities take place on
that connection.

For more information see the Schedules and Windows (on-line
documentation) topic.

EVENT CHAIN SETTINGS

Setting Description Related
Condition

Maximum Runtime Threshold Define the Maximum allowed runtime for the Event Chain. Event Chain:
Runtime
Threshold Max
(‘"General
Conditions' in
the on-line
documentation)

Minimum Runtime Threshold Define the Minimum allowed runtime for the Event Chain. Event Chain:
Runtime
Threshold Min
(‘General
Conditions' in
the on-line
documentation)

EVENT CHAIN NODE SETTINGS

Setting Description Related
Condition

Maximum Runtime Threshold Define the Maximum allowed runtime for the Event Chain node. | Event Chain
Node: Runtime
Threshold Max

(‘"General
Conditions' in
the on-line

documentation)

Minimum Runtime Threshold Define the Minimum allowed runtime for the Event Chain node. Event Chain
Node: Runtime
Threshold Min

(‘"General
Conditions' in
the on-line

documentation)
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SQL Server Settings

SQL SERVER SETTINGS
Blocking SQL
Setting

Related
Condition

Blocking SQL:
Runtime
Threshold Max
(‘"General
Conditions' in
the on-line
documentation)

Description

Maximum Runtime Threshold Set the Maximum allowed Runtime for the object.

Blocking SQL Source

Setting Description Related
Condition

Maximum Rows To | Set the maximum rows of historical event data to collect from | N/A('Conditions’

Synchronize this source. inthe on-line

documentation)
All Blocking SQL

Minimum Block Duration Set the time that must elapse before a Block Condition will be

triggered. Conditions
(‘General
Conditions' in the
on-line
documentation)
Deadlocks Source
Setting Description Related Condition

N/A('Conditions’ in the on-line

documentation)

Set the maximum rows of historical
eventdata tocollect from this
source.

Maximum Rows To Synchronize

All Deadlock SQL Conditions (‘General
Conditions' in the on-line
documentation)

Specifies whether deadlock statement
collection is enabled.

Collect Deadlock Events

DTS Package
Setting

Related Condition

DTS Package: Runtime Threshold Max
('General Conditions' in the on-line
documentation)

DTS Package: Runtime Threshold Max

Description

Define the maximum allowed
runtime for the object.

Maximum Runtime Threshold

Define the maximum allowed
runtime percent for the
object.

Maximum Runtime Threshold Percent

Minimum Runtime Threshold

Define the minimum allowed
runtime for the object.

DTS Package: Runtime Threshold Min
('General Conditions' in the on-line
documentation)

Minimum Runtime Threshold Percent

Define the minimum allowed
runtime percent for the
object.

DTS Package: Runtime Threshold Min

DTS Package Source
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Related Condition

All DTS Package
Conditions

(‘General
Conditions' _in
the on-line
documentation)-
An object  must
be watched in
order for
Conditions to be
evaluated for it.

Setting Description

Auto-watch New Objects Defines whether or not new objects will be set to watched

when they are discovered.

Maximum Rows To Synchronize The maximum rows of historical event data to collect from this N/A(*Conditions’
source. in the on-line
documentation)
Maintenance Plan Source
Setting Description Related
Settings
Auto-watch New Objects Specify whether or not new objects will be set to watched when All

they are discovered. Maintenance
Plan
Conditions
(‘General
Conditions' in
the on-line
documentation)
- An object must
be watched in
order for
Conditions to be
evaluated for it.

to collect for  this [ N/A

The maximum rows  of historical data

source.

Maximum Rows To Synchronize

Reporting Services Report

Setting

Description

Related Condition

Maximum Runtime Threshold

Define the maximum
allowed runtime for the
object.

Reporting Services Report: Runtime
Threshold Max (‘Conditions' in the on-line
documentation)

Maximum Runtime Threshold Percent

Define the maximum
allowed runtime percent for
the object.

Reporting Services Report: Runtime
Threshold Max (‘Conditions' in the on-line
documentation)

Minimum Runtime Threshold

Define the minimum allowed
runtime for the object.

Reporting Services Report: Runtime
Threshold Min ('Conditions’ in the on-line
documentation)

Minimum Runtime Threshold Percent

Define the minimum allowed
runtime percent for the
object.

Reporting Services Report: Runtime
Threshold Min (‘Conditions’ in the on-line
documentation)

Reporting Services Report Source
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Setting Description Related Settings

Auto-watch New Objects Specify whether or not new objects will be set to watched when they | All Reporting
are discovered. Services Report
Conditions
(‘General
Conditions' in
the on-line
documentation)
-An object must
be watched in
order for
Conditions to be
evaluated for it.

Maximum Rows To Synchronize | The maximum rows of historical data to collect for this source. | N/A

SQL Server Agent Alerts Source

Setting Description Related
Condition

Auto-watch New Objects Specify whether or not new objects will be set to watched when they | All SQL Server
are discovered. Agent Alert
Condition
(‘General
Conditions' in
the on-line
documentation)
- An object must
be watched in
order for
Conditions to be
evaluated for it.

Maximum Rows To Synchronize | The maximum rows of historical data to collect for this source. | N/A

SQL Server Agent Job

Setting Description Related
Condition

Maximum Runtime Threshold The maximum allowed runtime for the object. SQL Server
Agent Job:
Runtime
Threshold Max
(‘General
Conditions' in
the on-line
documentation)

Maximum Runtime  Threshold | The maximum allowed runtime percentage for the object. SQL Server
Percent Agent Job:
Runtime
Threshold Max
(‘General
Conditions' in
the on-line
documentation)

Minimum Runtime Threshold The minimum allowed runtime for the object. SQL Server
Agent Job:
Runtime
Threshold Min
(‘General
Conditions' in
the on-line
documentation)

Minimum Runtime Threshold | The minimum allowed runtime percent for the object. SQL Server
Percent Agent Job:
Runtime
Threshold Min
(‘General
Conditions' in
the on-line
documentation)
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Setting Description Related
Condition
Queue Others for up to The maximum length of time this job will queue other jobs.See Job | N/A
Queuing for more information.
Auto-Start Threshold Any job whose next scheduled run time is beyond the specified N/A
threshold will be started automatically upon leaving the queue. If a
job's next scheduled run time is before the threshold it will not auto-
start.
Queue Type The behavior when this job is queued. See Job Queuing for more | SQL Server
information. Agent Job:
Queued
("General
Conditions' in
the on-line
documentation)
Queue For Up To The maximum length of time this job can queued.See Job Queuing | N/A
for more information.
Auto-Start Type Controls the auto-start behavior for the job when it leaves the N/A
queue. "Use default setting" will cause the queuing job's "Auto-
Start Threshold" setting to be used.
SQL Sever Agent Jobs Source
Setting Description Related
Condition
Auto-watch New Objects Specify whether or not new objects will be  set to watched | All SQL  Server
when they are discovered. Agent Job

Conditions - An

object must be
watched in order
for Conditions to
be evaluated for
it. (‘Conditions’
inthe on-line
documentation)

Missed Run Threshold

The length of time that must pass before an object run is
considered to be missed.

SQL Server
Agent Job: Run
Missed (‘General
Conditions' in
the on-line
documentation)

Maximum Rows To Synchronize

The maximum rows of  historical data to collect  for this

source.

N/A

SQL Server Agent Log Source

when they are discovered.

Setting Description Related
Condition
Auto-watch New Objects Specify whether or not new objects will be  set to watched | All SQL Server

Agent Log
Source

Conditions
(‘General
Conditions' _in
the on-line
documentation)

- An object must
be watched in
order for
Conditions to be
evaluated for it.

("Conditions’ in

the on-line
documentation)

Maximum Rows To Synchronize

The maximum rows of historical data to collect for this

source.

N/A
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Setting Description Related

Condition
SQL Server Connection

Setting Description Related
Condition

Auto-enable SQL Server Agent | On SQL Server 2005 and above, SQL Agent Tokens are disabled as | All SQL Server

Tokens a security measure. They must be enabled to allow SQL Sentry to Agent Alert

watch Alerts. Conditions

("General
Conditions' in
the on-line

documentation)

Auto-recycle large SQL Server
Agent Logs

Whether or not to automatically recycle large Agent Log files.
SQL Sentry polls the Agent log for history synchronization. If an
Agent Log file becomes too large, this polling will cause timeout
problems. To prevent this, SQL Sentry will stop  polling and
issue a Console Alert if the agent log file exceeds 1MB. This
problem often manifests when informational level logging is
enabled.

N/A

Maximum Queue Length

The maximum number of objects that can be queued at one time.
This setting always applies to the connection level.

SQL Server
Agent Job:
Queued
(‘General
Conditions' in
the on-line
documentation)

take place on that connection.

For more information see the Schedules and Windows (on-

line documentation) topic.

Synchronize Type This setting refers to how the SQL Sentry Client will respond if it | N/A
discovers the data in the  SQL Sentry repository is not  up to
date. The defaultis to show a message box warning of the
conditon and  askingif the SQL  Sentry Client  should
synchronize the information itself.

Synchronization Threshold The amount of time that must pass since the last  successful | N/A
synchronization by the SQL Sentry Monitoring Service before
the Client attempts to synchronize directly with the target.

Maintenance Window Used to set a schedule for the Maintenance Window. Only Log | Failsafe
Actions will be  triggered for Failsafe  conditions inside the | Conditions
Maintenance Window. Maintenance  Window setting allow a | ("Conditions' in
time frame to be  specified while daily maintenance activities | the on-line

documentation)

Top SQL
Setting Description Related Condition
Maximum Runtime Threshold The maximum allowed runtime | Top SQL: Runtime Threshold  Max
for the object. This default value | (‘General Conditions' inthe on-line
is 1 hour. documentation)
Top SQL Source
Setting Description Related
Condition
Maximum Rows to | The maximum rows of historical data to collect for this source. N/A
Synchronize
Minimum Duration The Minimum Duration setting determines the required duration for a All Top SQL
Top SQL event to be collected. The default setting is 5 seconds. For Conditions
safety reasons, it cannot be reduced below 100ms unless one of the (‘General
CPU, Reads or Writes filters is >0. Conditions' in
the on-line
documentation)
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Setting Description Related
Condition

Minimum CPU The minimum required CPU for a statement to be logged.* All Top SQL
Conditions
(‘General
Conditions' in
the on-line
documentation)

Minimum Reads The minimum required reads for a statement to be logged.* All Top SQL
Conditions
(‘General
Conditions' in
the on-line
documentation)

Minimum Writes The minimum required writes for a statement to be logged.* All Top SQL
Conditions
(‘General
Conditions' in
the on-line
documentation)

Collect Trace Events Specify whether or not to collect Trace Events. If Collect Trace Events is | N/A
disabled, SQL Sentry will not start a trace or collect any Top SQL events
from a monitored target.

Collect Statement Events Specify whether or not  to collect Statement Events.  If Collect | N/A
Statement Events is disabled, statement-level information will not
be available in the Plan Explorer Statements Tree when viewing a
query plan.

¥, WARNING: On systems with very high transaction volumes
that also make extensive use of scalar functions, enabling
Collect Statement Events may cause a negative impact on
the performance of the monitored target, regardless of the
effective Top SQL filter settings  or the number of events
actually collected. See also: Performance impact: SQL trace
and user defined scalar functions

Collect Execution Plans Specify whether or not to collect Execution Plans. If Collect Execution N/A
Plans is disabled, Top SQL event collection will occur as normal,
however query plan information will not be automatically collected for
those events. Plan information can still be collected on demand from
within a Plan Explorer session, however.

Running Events Polling | Specifies how often the service checks for running events. N/A
Interval

[{ Top SQL Source Note:
There is an AND relationship that exists between the Minimum Duration, Minimum CPU, Minimum Reads, and the
Minimum Writes Collection Settings. This means, that in order to be collected as Top SQL, the event will need to
satisfy each individual Collection Setting. For example, if you set the Minimum Duration at 10 seconds and the
Minimum Reads at 25 , an event would need to meet both a Minimum  Duration of 10 seconds AND a Minimum
Reads of 25 to be captured in Top SQL.

Minimum Duration cannot be set below 100ms  unless Minimum CPU, Minimum Reads, or Minimum Writes is
greater than 0. This lower limit is enforced because setting this thresholds below 100ms for an extended period of
time could dramatically increase the volume of data collected and stored by SQL Sentry, and have a negative
impact on the monitored server. SQL Sentry's Quick Trace functionality is better suited to analyze extremely short
duration events.

SSAS Settings

SQL SERVER ANALYSIS SERVICES SETTINGS
Analysis Services Connection
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that connection.

For more information see the Schedules and Windows (on-line

documentation) topic.

Setting Description Related
Condition
Collect Memory by Category Enable or disable Memory by Category Data. This setting is used to provide | N/A
Data more detail than the basic Cleaner memory data, but is higher overhead to
collect. Use caution when enabling to ensure it does not impact
performance. The default value for this setting is False.
Synchronize Type This setting refers to how  the SQL Sentry Client will  respond if it | N/A
discovers the data in the SQL Sentry repository is not up to date. The
default is to show a message box warning of the condition and asking
if the SQL Sentry Client should synchronize the information itself.
Synchronization Threshold The amount of time thatmust passsince thelast successful [ N/A
synchronization by the SQL  Sentry Monitoring Service before  the
Client attempts to synchronize directly with the target.
Maintenance Window Used to set a schedule for the Maintenance Window. Only Log | Failsafe
Actions will  be triggered  for Failsafe  conditions inside  the | Conditions
Maintenance Window. Maintenance  Window setting allow atime | (‘Conditions'in
frame to be specified while daily maintenance activities take place on | the on-line

documentation)

Top Commands

Setting

Description

Related
Condition

Maximum Runtime Threshold

Define the maximum allowed runtime for the object.

Top
Commands:
Runtime
Threshold Max
(‘General
Conditions' in
the on-line
documentation)

Top Command Source

Setting Description Related
Condition

Maximum Rows to Synchronize. The maximum rows of historical event data to collect from  this | N/A

source.

Minimum Duration Set the minimum required duration for a statement to be logged. All Top
Commands
Conditions
(‘General
Conditions' in
the on-line
documentation)

Collect MDX/DMX/XMLA Events Specifies whether command collection is enabled. N/A

Oracle Database Settings

ORACLE DATABASE SETTINGS

Oracle Database Connection
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that connection.

For more information see
documentation) topic.

the Schedules and Windows (on-line

Setting Description Related
Condition
Synchronization Type This setting refers to how the SQL Sentry Client will respond if it | N/A
discovers the data in the SQL Sentry repository is not up to date. The
default is to show a message box warning of the condition and asking
if the SQL Sentry Client should synchronize the information itself.
Synchronization Threshold | The amount of  time that must  pass since the  last successful | N/A
synchronization by the SQL  Sentry Monitoring Service before the
Client attempts to synchronize directly with the target.
Maintenance Window Used to set a schedule for the Maintenance Window. Only Log | Failsafe
Actions will  be triggered  for Failsafe = conditions inside  the | Conditions
Maintenance Window. Maintenance  Window setting allow atime | (‘Conditions' in
frame to be specified while daily maintenance activities take place on | the on-line

documentation)

Oracle DBMS, EM, and Scheduler Job

Setting

Description

Related
Condition

Maximum Runtime Threshold

Define the maximum allowed runtime for the object.

Oracle " " Job:
Runtime
Threshold Max
("General
Conditions' in
the on-line
documentation)

Maximum Runtime Threshold Percent

Define the maximum allowed runtime percent for the object

Oracle " " Job:
Runtime
Threshold Max
(‘General
Conditions' in
the on-line
documentation)

Minimum Runtime Threshold

Define the minimum allowed runtime for the object.

Oracle " " Job:

Runtime
Threshold Min
(‘General
Conditions' in
the on-line

documentation)

Minimum Runtime Threshold Percent

Define the minimum allowed runtime percent for the object.

Oracle " " Job:

Runtime
Threshold Min
(‘General
Conditions' in
the on-line

documentation)

Oracle DBMS, EM, and Scheduler Jobs Source

Setting

Description

Related
Condition

Auto-Watch New Objects

Defines whether or not new objects will be set to watched when they
are discovered.

All Oracle
DBMS, EM, and
Scheduler Job
Conditions
(‘General
Conditions' in
the on-line
documentation)
- An object must
be watched in
order for
Conditions to be
evaluated for it.

Maximum Rows To Synchronize

The maximum rows of historical event data to collect from this source.

N/A
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SharePoint Settings

SHAREPOINT SETTINGS

SharePoint Server Connection

Setting Description Related
Condition
Synchronization Type This setting refers to how the SQL Sentry Client will respond ifit [ N/A

discovers the data in the SQL Sentry repository is not up to date.
The default is to show a message box warning of the condition and
asking if the SQL Sentry Client should synchronize the information
itself.

Synchronization Threshold | The amount of time that must pass since the last successful | N/A
synchronization by the SQL Sentry  Monitoring Service before the
Client attempts to synchronize directly with the target.

Maintenance Window Used to seta  schedule for the Maintenance  Window. Only Log | Failsafe
Actions will  be triggered  for Failsafe  conditions inside  the | Conditions
Maintenance Window. Maintenance Window  setting allow a time | ("Conditions' in
frame to be specified while daily maintenance activities take place | the on-line
on that connection. documentation)

For more information see the Schedules and Windows (on-line
documentation) topic.

SharePoint Timer Job

Setting Description Related
Condition

Maximum Runtime | Define the maximum allowed runtime for the object. SharePoint

Threshold Timer Job:

Threshold Max
("Conditions' in
the on-line
documentation)

Maximum Runtime | Define the maximum allowed runtime percent for the object SharePoint
Threshold Percent Timer Job:
Threshold Max
("Conditions' in
the on-line
documentation)

Minimum Runtime | Define the minimum allowed runtime for the object. SharePoint

Threshold Timer Job:
Threshold Min

("Conditions' in
the on-line
documentation)

Minimum Runtime | Define the minimum allowed runtime percent for the object. SharePoint
Threshold Percent Timer Job:
Threshold Min
("Conditions' in
the on-line
documentation)

SharePoint Timer Jobs Source
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Setting Description Related
Condition
Auto-Watch New Objects Defines whether or not new objects will be set to watched when they are All SharePoint
discovered. Timer Job

Conditions - An
object must be

Synchronize

watched in
order for
Conditions to
be evaluated
for it.

Maximum Rows To | The maximum rows of historical event data to collect from this source. N/A

Minimum Event Duration

Set the minimum event duration for non-failed rows. Only events that have
a duration greater than or equal to this duration will be synchronized

All SharePoint
Timer Job
Conditions
("Conditions’ in
the on-line
documentation)

Task Scheduler Settings

TASK SCHEDULER SETTINGS

Windows Task

Setting Description Related
Condition

Maximum Runtime Threshold The maximum allowed runtime for the object. Windows Task:
Runtime
Threshold Max
("General
Conditions' in
the on-line
documentation)

Maximum Runtime Threshold Percent | The maximum allowed runtime percentage for the object. Windows Task:
Runtime
Threshold Max
(‘General
Conditions' in
the on-line
documentation)

Minimum Runtime Threshold The minimum allowed runtime for the object. Windows Task:
Runtime
Threshold Min
(‘"General
Conditions' in
the on-line
documentation)

Minimum Runtime Threshold Percent The minimum allowed runtime percentage for the object. Windows Task:
Runtime
Threshold Min
("General
Conditions' in
the on-line

documentation)

Windows Task Schedu

ler Connection

discovers the data in the SQL Se ntry repository is not up to date.
The default is to show a message box warning of the condition and
asking if the SQL Sentry Client should synchronize the information
itself.

Setting Description Related
Condition
Synchronization Type This setting refers to how the SQL Sentry Client will respond if it | N/A




SQL Sentry User Guide | 85

Setting Description Related
Condition
Synchronization Threshold | The amount of  time that must  pass since the last successful | N/A
synchronization by the SQL Sentry  Monitoring Service before the
Client attempts to synchronize directly with the target.

Maintenance Window Used to seta schedule for the Maintenance ~ Window. Only Log | Failsafe
Actions will  be triggered  for Failsafe  conditions inside  the | Conditions
Maintenance Window. Maintenance Window  setting allow a time | (‘Conditions' in
frame to be specified while daily main tenance activities take place | the on-line
on that connection. documentation)

For more information see the Schedules and Windows (on-line
documentation) topic.

Windows Task Source

Setting Description Related
Condition

Auto-watch New Objects Specify whether or not new objects will be set to watched when | All Windows

they are discovered. Task Conditions
(General
Conditions' in
the on-line
documentation) -
An object must be
watched in order
for Conditions to
be evaluated for
it.

Maximum Rows to Synchronize | The maximum rows of historical data to collect for this source. N/A

Response Rulesets

RESPONSE RULESETS

Response Rulesets control how often Actions are taken in response to Conditions. The default
ruleset is Notify Every Time, meaning that the Action will be taken every time the Condition is
met. Response Rulesets allow for an extra level of configurability for certain notifications. They
do this by allowing you to define additional criteria that must be met in order for the Action to be
taken.

For example, you may receive false-positive Database Offline/Online messages throughout the
day on servers/networks that  are highly utilized. An  example Response Ruleset for this
scenario might specify that this Condition must be true for 5 minutes before an email is to be
sent. Additionally you can specify under what criteria subsequent actions for this same
Condition occur.

Actions and their configured Response Rulesets have a  hierarchical configuration. When you
configure an Action with a Response Ruleset the Action and the Action's Response Ruleset
will be inherited by each object below that level. For a visual representation of how inheritance
works within SQL  Sentry see the Alerting and Response System Hierarchy diagram
(‘Alerting and Response System’' in the on-line documentation).

Response Rulesets can be a powerful tool to help you fine tune alerts. Response Rulesets are available
globally, meaning the same Response Ruleset can be applied to multiple Conditions. Keep in mind that any
changes to a Response Ruleset will affect every Condition where the Response Ruleset has been applied.

RULESET TYPES
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There are two Ruleset types, Count Based and Time Based.

Ruleset Type Description

Count Based With Count Based Rulesets you can control:

e How many times a Condition must occur within a specified time frame before Actions
are taken.

e How many times a Condition must reoccur before subsequent Actions are taken.
e How long to continue taking action when a Condition is occurring.

See the Response Ruleset Count Based example (‘Response Ruleset Examples' in
the on-line documentation) for more information.

Time Based With Time Based Rulesets you can control:

e How long a Condition must exist before actions are taken.
e How much time must elapse before subsequent actions are taken.
e How long to continue taking action when a Condition is occurring.

See the Response Ruleset Time Based example (‘Response Ruleset Examples' in the
on-line documentation) for more information.

RESPONSE RULESET EXAMPLES

For example use scenarios see the Response Ruleset Examples topic.

RULESET MANAGEMENT

Response Rulesets can be managed using the Tools menu -> Manage Response Ruleset
command. In this window you can create, edit, and delete rulesets. You can also assign
rulesets to all of the Actions configured within your environment. Once a Response Ruleset has
been defined, it can be associated with a Condition.

Response Rulesets can also be managed for individual Actions from the Response Ruleset
tab found within the Action Pane.

CREATE A NEW RESPONSE RULESET

To create a new Response Ruleset from within the Manage Response Ruleset dialogue select
the New Ruleset button. Choose a name for the Response Ruleset. Next use the Ruleset
Type box to select either a Count based or Time Based ruleset. Depending on which Ruleset
type you are creating the configuration options will be as follows.

Ruleset Configuration Options



Count Based

i Response Ruleset Editor

Mame

Fuleset Type
Court Based -

Process Actions After

1 |2 Occumences [¥] within 1 :
i 2 0 - | Seconds -

r Save

Time Based

i Response Ruleset Editor

Mame

Ruleset Type
| Time Based - J

Process Actions After

1 +| Hours -

Process Subsequent Actions Every

1 :|Hours - | forupto |1

:|Daﬂ_.'s -
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Configuration Options

Process Actions After:
e Occurrences — number of times the
event must occur prior to processing
actions.

e Within (checked) — the window of time
in which the events needs to occur.

e Within (not checked) - ignore time
limit, enable subsequent actions.

Process Subsequent Actions Every:
e Occurrences — number of times the
event must occur prior to processing
subsequent actions.

e Forupto— how longto follow the
subsequent actions  setting before
starting ruleset over.

Configuration Options

Process Actions After:
e The amount of time a condition
must exist prior to processing
actions.

Process Subsequent Actions Every:

e The amount of time a condition
must continue to exist between
processing actions.

e For up to — how long to follow the
subsequent actions setting before
starting ruleset over.

r [ Save

[# Note: Modifications to a Response Ruleset will trigger an Audit Condition.

ASSIGN A RESPONSE RULESET TO AN ACTION

You can assign a Response Ruleset to an Action from within the Manage Response Ruleset

dialogue as follows.

1. Open the Manage Response Ruleset dialogue. (Tools menu - Manage Response

Ruleset )

2. Select any Action found within the Configured Actions section.
3. Select the drop-down arrow in the Ruleset column to see Response Rulesets applicable

for the Action.

4. Click on the Response Ruleset that you would like to apply.

You can also assign a Response Ruleset to an Action from the Response Ruleset tab found

within the Action Pane.

1. In the Navigator Pane select the node appropriate to the level that you would like to
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configure the Action for.
2. Select the Action that you would like to apply a ruleset for in the Actions Pane. (View
menu - General/Failsafe/Audit Actions)

3. Select the Rulesets tab found directly beneath the Action.
4. Click on the Response Ruleset that you would like to apply.

BEST PRACTICES FOR USING RESPONSE RULESETS

e Name global rulesets by their behavior.

e Name custom rulesets by the object and event/condition they apply to.
e Use count based rulesets for event driven rules.

e Use time based rulesets for condition driven rules.

Response Ruleset Examples

RESPONSE RULESET EXAMPLES

Response Rulesets control how often Actions are taken in response to Conditions. The default
ruleset is Notify Every Time, meaning that the Action will be taken every time the Condition is
met. Response Rulesets allow for an extra level of configurability for certain notifications. They
do this by allowing you to define additional criteria that must be met in order for the Action to be
taken. For a general overview see the Response Ruleset topic.

COUNT BASED EXAMPLE:
As a reminder with Count Based Rulesets you can control:

e How many times a Condition must occur within a specified time frame before Actions are
taken.

e How many times a Condition must reoccur before subsequent Actions are taken.

¢ How long to continue taking Action when a Condition is occurring.

This Count Based Ruleset Example deals with a SQL Server Agent job that often fails.

For this example assume the following:

You have a Send Email Action (‘Actions’ in the on-line documentation) configured at the Connection level for the
SQL Server Agent Job: Failure Condition ("General Conditions’ in the on-line documentation) . There is a SQL
Server Agent Job FrequentJob, that runs every minute. The occasional failure is expected and can be disregarded
but if this job begins failing repeatedly it usually indicates there is a problem.

To prevent getting an alert on every failure, you could set a Response Ruleset to limit the processing of the  Send
Email Action for the SQL Server Agent Job: Failure Condition so that an email was only  sent after the job failed
multiple times within a  specified time frame. For  the example we will  do this by configuring a Count Based
Response Ruleset that will require the job to fail 3 times within 5 minutes.

To accomplish this you need to apply a Count Based Response Ruleset at the job level ( FrequentJob). You will
want to apply this Response Ruleset at the individual job level as  opposed to the Connection  level to avoid
suppressing email notifications for the rest of your Agent Jobs belonging to that Connection.

First you will want to configure a Send Email Action for the SQL Server Agent Job: Failure Condition for the Agent
Job FrequentJob.
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1. Select the FrequentJob node in the Navigator Pane.

2. Next open the General Actions tab in the Actions Pane. If you do not see the Actions Pane use the View
menu -> General Actions.

3. Click the Add button found in the Explicit section of the General Actions tab. This will open the Select Action
window.

4. Expand the SQL Server Agent Job: Failure Condition. Use the check box to select the Send Email Action.
Click the OK button to add the configured action. Be sure to specify a Selected Target in the Action
Settings tab.

Next you will want to apply a Response Ruleset to the configured Action.

1. Select the configured email action in the Explicit section of the Actions Pane.

2. Select the Response Rulesets tab found directly beneath the Explicit section of the Actions Pane. You should
see that the default Response Ruleset, Notify Every Time is applied. Click the New button to open the
Response Ruleset Editor.

3. Give the Response Ruleset a name, remembering that it is a best practice to name a custom ruleset by the
object and Condition that it applies to.

i Response Ruleset Editar @

M ame

-

Frequentlob Failure: 3 times within 5 minutes]
Fulezet Type

Count Bazed

Process Actions After

3 || Occurences [V within 5 | Minutes -
e 0 | Seconds -

Save ]| Cancel I

4. Fill in the information as specified above and click the Save button to apply the newly created Response
Ruleset to the configured Action.

Now that the Send Email Action configured forthe = SQL Server Agent Job: Failure Condition has the above
Response Ruleset applied, an email will only be sent alerting you that the FrequentJob failed, if it does so 3 times
within 5 minutes.

Only the SQL Agent Job FrequentJob will be impacted by this change. Other Agent Jobs  would still be subject to
the Send Email Action configured at the Connection level which has the default Response Ruleset of Notify Every
Time.

Consider the following:

e With this ruleset in place on the Send Email Action (‘Actions’ in the on-line documentation), you could still
have the failure execute the Log To Database Action (‘Actions' in the on-line documentation) using the
default ruleset. This way every failure would be recorded.

e You could also apply an additional Send Email Action (‘Actions’ in the on-line documentation) for the SQL
Server Agent Job: Failure Condition with a different ruleset. This could be useful for escalation purposes or if
a different team member prefers to be notified every time the job fails.

TIME BASED EXAMPLE:
With Time Based Rulesets you can control:

e How long a Condition must exist before Actions are taken.
* How much time must elapse before subsequent Actions are taken.
¢ How long to continue taking Action when a Condition is occurring.
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This Time Based Ruleset Example deals with Connection Offline/Online Alerts.

For this example assume the following:

You have a Send Email Action (‘Actions’ in the on-line documentation) configured at the Global level for the
SQL Server: Offline Condition (‘Failsafe Conditions' in the on-line documentation).

You have a Site, TransientSite in your environment that contains several Connections. You are being alerted by
email that these Connections are going Offline and Online, but when you check these connections these seem to be
false notifications. This can happen if there are transient network issues and the Monitoring Service is unable to
connect to the Monitored Servers. If these problems are truly transient, you may not necessarily want to be notified
every time this happens.

To prevent getting an alert  for every occurrence of these transient network issues you could seta Response
Ruleset to limit the processing of the Send Email Action for the SQL Server Connection: Offline Condition . This
Response Ruleset would add additional criteria to the processing of the Send Email Action so that an email is only
sent after the connection was detected to be in an offline state for a specific period of time.

For this example we will do this by:
1. Configuring a Time Based Response Ruleset that will require the SQL Server: Offline Condition to be true
for 5 minutes.

2. Disabling the SQL Server Connection: Online Condition ('Failsafe Conditions' in the on-line
documentation).

To accomplish this you would need to apply a Time Based Ruleset at the Site level for the TransientSite. You will
want to apply this Response Ruleset at the Site level as opposed to the Global level to avoid suppressing email
notifications about the rest of your Connections going offline and online.

First you will want  to configure a Send Email Action for the SQL Server Connection: Offline Condition at the
TransientSite level.

1. Select the TransientSite node in the Navigator Pane.

2. Next Open the Failsafe Actions tab in the Actions Pane. If you do not see the Actions Pane use the View
menu -> Failsafe Actions.

3. Click the Add button found in the Explicit section of the Failsafe Actions tab. This will open the Select Action
window.

4. Expand the SQL Server Connection: Offline Condition. Use the check box to select the Send Email Action.
Click the OK button to add the configured action. Be sure to specify a Selected Target in the Actions
Settings tab.

Next you will want to apply a Response Ruleset to the configured Action.

1. Select the configured email action in the Explicit section of the Actions Pane.

2. Select the Response Ruleset tab found directly beneath the Explicit section of the Actions Pane. You should
see that the default Response Ruleset, Notify Every Time is applied. Click the New button to open the
Response Ruleset Editor.

3. Give the Response Ruleset a name, remembering that it is a best practice to name custom ruleset by the
object and condition that it applies to.

i Response Ruleset Editar @

M ame

-

TransientSite Offline: Matify after 5 minutes
Rulezet Type

Time Based

Process Actions After
5 =

Minutes -
Process Subzequent Actions Every

10 | Minutes ~| forupto |1 | Days -

[ Save ]| Cancel |
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4. Fill in the information as specified above and click the Save button to apply the newly created Response
Ruleset to the configured Action.

Now that the Send Email Action configured forthe SQL Server Connection: Offline Condition has the above

Response Ruleset applied, an email will only be  sent alerting you that one of the  Connections belonging to the
TransientSite is offline, if it is detected to be in that state for longer than 5 minutes. You will receive an additional
email every 10 minutes for up to 1 day as long as the Connection remains offline.

Next we will disable the Send Email Action for the SQL Server Connection: Online Condition at the TransientSite
level. This will stop any  SQL Server online email notifications. ~ We do this because with  the above Response
Ruleset applied, once you stop receiving emails for the SQL Server Connection: Offline Condition you will know that
the Server is online again.

To disable the Send Email Action for the SQL Server Connection: Online Condition at the TransientSite Level.

1. Select the TransientSite node in the Navigator Pane.

2. Next open the Failsafe Actions tab in the Actions Pane. If you do not see the Actions Pane use the View
Menu -> Failsafe Actions.

3. Expand the SQL Server Connection: Online Condition. Use the check box to select the Send Email Action.
Click the OK button to add the action.

4. Select the configured email action in the Explicit Section of the Actions Pane. In the Behavior column select
the drop down box and choose the Disabled behavior. For more about action behaviors see the Actions
topic.

Consider the following:

e You may also want to follow the same procedures for the SQL Server Agent: Offline/Online Conditions, by
applying the same Response Ruleset for the Offline Condition and disabling the Online Condition.

e By default all Failsafe Conditions are configured with a Log To Database Action ('Actions’ in the on-line
documentation), so you will always have a record of each time the SQL Server Connection: Offline Condition
is met if you need to review it.

e You could also apply an additional Send Email Action (‘Actions’ in the on-line documentation) for the
various Offline/Online Conditions with a different Response Ruleset. This could be used for escalation
purposes in the event of an long term server outage.

L}

Output Content Match

OUTPUT CONTENT MATCH

The Output Content Match conditions allow you to assign an  action based on a match of the
output text of an event object. This feature allows you to watch for specialized conditions that may
not otherwise be detected. This may prove useful when trying to catch specific output from the
step text of a DTS package*, or handling exit codes from Windows Tasks.

SETTING UP ACTIONS FOR THE OUTPUT CONTENT MATCH
CONDITION

Output Content Match Actions, like all other General Actions, can be set up from the global level to
the individual event object level. After selecting the appropriate node on the  Navigator pane,
expand the Output Content Match condition for which you wantto set actions. Select the
appropriate check box for the action you would like taken, and the Edit button will appear in the
pane below.

Clicking the Edit button will bring up the Content Match Criteria form. From here you can specify
all conditions the output text from the object has to  meet before responding with the  desired
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action. The matched text can either be in  the form of a string literal, or you can enter a regular
expression. To use regular expressions, prefix the match string with "regex:", i.e. "regex:[a-z]*" to
match any character a-z. Click OK and the Action is enabled.

[f NOTE: The Step Name listbox is only available when setting match criteria for an individual SQL Agent Job.

CONDITION INHERITANCE

All Output Content Match criteria can be set at the global level and will be inherited like any other
setting. It is important  to note, however, that any match criteria defined at a lower level  will
effectively override the inherited criteria. Even if there is not a match at that level, SQL Sentry will
not look further up the inheritance chain to see if there are any other match criteria set at a higher
level. Inherited actions, however, will remain enabled.

For example, a Send Email action is configured at the global level for the SQL Agent Job:Output
Content Match condition when the text string "overflow" appears in any job's output text. You then

click on your Data Import job on Server A and enable a Log to Database action for the SQL Agent
Job:Output Content Match condition and change the match criteria for this job  to "insufficient".
From now on, the only text string  that will be checked when the Data Import  job runs is

"insufficient". Even if that string is not found it will not look for the "overflow" string set at the global
level. However, if the "insufficient" string is matched for that job's output, both the Send Email and

Log to Database actions will be taken.

When you override the Output Content Match settings at a lower level, you will be prompted if you
want use the higher level Output Content Match criteria as  the baseline for this setting.  This
feature was added because often when overriding the Output Content  Match criteria, only minor
changes are required, so this feature can save you a lot of work when many content match strings
are involved.

[# NOTE: Output Content Matching is not supported for output of failed DTS steps or retried SQL Agent Job steps.
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7 SQL Sentry Event Manager

Calendar View

CALENDAR VIEW

The Calendar View is the default display in the Workspace Area. It combines both historical and future
event data to present an  accurate visual representation of the schedule. Visual indicators highlight
overlapping active event instances, event status, and duration. Additional detail information is available

with a single click via popup windows. You can use drag-and-drop to reschedule future jobs or tasks in
order to "level” a schedule, thus minimizing contention between  multiple events fighting for the same
resources.

To navigate to the Calendar View, double-click on any root, group, connection, source, object "Event
View", or Custom Event View node in the Navigator Pane. The actual event instances displayed on the
view will vary depending on the node selected. For example if you select the Jobs node under a SQL
Server, only jobs will be displayed; all other events (DTS packages, maintenance plans, etc.) will be
filtered from the view, and only the Jobs tab will be available in the corresponding Event View
('Navigator Pane’ in the on-line documentation) filter.

RECURRING EVENTS PANE

This pane is used to  display events that run frequently or long enough that they  would clutter the
calendar in the current interval view. Exactly which events are displayed in the recurring events pane
depends on the active interval and the schedule frequency of the respective events. For example,
future instances of a job that runs every 5 minutes will be pinned to the recurring events view when in a
24 hour interval, but will be displayed on the calendar in 1 hour view. To determine how long events
must run before showing in this window, go to the Calendar tab in the User Preferences menu.

NOTE: Events listed in the recurring pane will not register as conflicts with other events on the
Calendar.

CALENDAR CONTEXT MENUS

A Context Menu (‘Context Menus' in the on-line documentation) is available for all event instances
by right-clicking the instance in the calendar. Exactly which context items are available depend on the
source type of the selected instance.
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NAVIGATION CONTROL

The navigation toggle button at the top left of the calendar allows you to move quickly forwards and
backwards through the calendar.

Click the Up A or Down ¥ Arrows to move to the previous or next time interval . The Right » or Left
< Arrows move forward or backward one day, keeping the same interval and start time. The Plus +
and Minus - buttons are used to zoom in or out in the Time Ruler, one interval at a time, keeping the

interval start time the same.

DATE BAR
This bar shows the day of the week and date for each day displayed in the current view.

When in a multi-day view, if you single-click any date on the date bar it will make that date active,
highlighting the date. You can zoom into a single date by double-clicking the date on the date bar. You
can drill into any interval for one or more days by double-clicking on the Time Ruler at the left of the
calendar (see below).

TIME RULER

On the left side of the calendar, a vertical Time Ruler shows the current time-range for the selected
interval. By default, Hours are displayed. You can use the = Time Ruler to zoom in or out to a desired
time interval display.

When you hover over the Time Ruler, the ruler highlights a time-range. Double-click to zoom into the
time-range. This is similar to clicking the Zoom In button, except that the Zoom In button does not
change the start time.

CURRENT TIME

The current time is displayed (when in view) with a  horizontal red bar. The bar will move as the time
changes.

CURRENT TIME COLUMN

To see the exact time, mouse-over the narrow column between the time ruler and the calendar or
between adjacent days.

ZOOM IN/OUT

You can also use the calendar to zoom in  or out to any time intervals. Right-click anywhere there is
empty space on the calendar or on the Time Ruler to bring up the context menu. Select a time interval
to zoom in and out.

INTERVAL BUTTONS

Hover over the very top or bottom of the time ruler and popup arrows are displayed which you can use
to quickly move to the previous or the next interval, just as with the Up A or Down V¥ navigation control
arrows.

EVENT INSTANCES ON THE CALENDAR

All event instances on the calendar appear with a rectangular block. Future instances don't include a
Run Status indicator bar.
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Start Time

| 12:00 PM 20 Minute Job

Ciuration Bar

Run Status Job Name Step Details

Step Details are accessible by clicking the  bottom-right corner of the event instance. By default an
event instance background is white.

Default Run Status colors are:
e Green - Successful

e Yellow - Warning
¢ Red - Failed

¢ Orange - Running
¢ Black - Stopped

GLYPHS

Glyphs are used to provide quick visual cues about event instances on the calendar, including their
event source type, queuing settings and status, block status, etc. Each instance contains at least one
glyph representative of its type, which matches exactly the icon shown in the navigator pane for the
source object. Below is a calendar showing several different types of event instances. See the
Navigator Pane Map for a complete listing of all event instance glyphs.

Other informational glyphs are listed below:

4 Job actively blocked or blocking

| Job actively being queued

a Job cannot be queued
£ 3 Job set to queue

3 Job actively queuing

E g Event instance or event object contains a note
m Event instance was run as part of an event chain
b A Top SQL indicator
e Analysis Services Top Commands indicator
o Deadlock indicator

C SharePoint Timer Job indicator

POPUP WINDOWS

To view details for any event instance, left-click it anywhere to the right of the duration bar to select it

and bring up a popup window. The popup reveals details about the instance, including the last  step
output, start and end time, duration, runtime statistics, schedules, queuing settings, notes, etc. The
actual data contained in the popup will vary based upon the instances event source type. You can clear
the window by moving your mouse away from the instance.
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HIGHLIGHTING RELATED EVENTS

The calendar provides several options for grouping events on the calendar. Right-clicking an event and
selecting "Highlight" will display the applicable highlighting options for the event. Once the highlight
option(s) are chosen, similar events to the one selected will be highlighted on the calendar.

EVENT CONFLICTS

A conflict is defined as two active event instances running on the same server at the same time. When
a instance"s runtime (as indicated by the duration bar) overlaps with one or more other instances in the
same view, itis  considered conflicting and its  background color will be  orange as shown below,
otherwise the background will be white.

You can easily resolve most conflicts by dragging-and-dropping future instances on the calendar. The
amount of time  instances must overlap  before showing as in conflict can be adjusted in  User
Preferences.

NOTE: Events listed in the recurring window will not register as conflicts with other events on the
Calendar.

2:19 PM 20 Minute Job
2:20 PM iminute El 2:20 PM_TestFail |
A 2:22 PM 5 Seconds T |
| | |
Running Conflicting ~ Successful Failed No Conflicts
(Orange) (Orange) (Green) (Red) (White)

TOO MUCH DATA INDICATORS

On very busy schedules, if too many event instances exist within a given range to display all of them in
a meaningful fashion, a small hashed box will be shown on the right side of the pane. Hovering over
the box will show a tooltip with the number of additional events in that time period. Double-clicking the
box will zoom in so each actual event can be seen. If conflicts exist within the specified range, the box
will be displayed  in orange (default). A filter can also  be appliedto  reduce the number  of
event instances on the calendar.

SELECTING AN EVENT INSTANCE

Click to select any event instance on the calendar and it will be displayed with a blue border on the top
and bottom. Note that all other instances of the same object on the calendar will change background
color at the same time for easy reference.

RESCHEDULING VIA DRAG-AND-DROP

After you selecta future job or task instance, you can easily moveittoa different time slot by
dragging-and-dropping the instance. After you move an instance, you will receive a confirmation dialog
box. Either click OK to confirm the move or Cancel to return the instance to its original position.

NOTE: This feature is disabled in the evaluation version of SQL Sentry.



SQL Sentry User Guide | 97

VIEWING STEP DETAILS

To view full step details for an event instance, click the small gray triangle in the lower-right corner of
the instance and the step callout window will appear. You can move the window by clicking the gray
bar at the top, and you can resize it by clicking the small dashed triangle in the lower-right corner. Note
that event instances that don't contain steps, such as status events or Windows tasks, will not have a
step callout button.

List View

LIST VIEW

To view event history in a list format, select List from the View toolbar. The list view shows all
event data that would otherwise be displayed on the calendar, but in a list format. Click the [+] icon
to expand and view the full step details for the event, if any exist. Failed instances  will be
highlighted in red.

NOTE: The history List View for one day can be opened by pressing (CTRL + ALT + H) when an
applicable object is selected.

SPLIT VIEW

You can show both the Calendar View and the List View simultaneously by choosing Split from
the View toolbar. When you select an event instance on the calendar, it will be auto-selected in the
list window, and vice versa.

GROUPING AND SORTING

You can drag-and-drop any column heading into or out of the area directly above the list view to
change the active grouping. You can also click any column heading to sort by that column.

Schedule Performance Monitoring

PERFORMANCE MONITORING OVERVIEW

SQL Sentry's performance monitoring features can clearly illustrate how individual events and
combinations of events are impacting server resources. SQL Sentry lets you "link" any Windows
performance counter directly to an individual active event object, or to groups of event objects on
different servers that utilize the same network resources via Custom Event Views . SQL Sentry
manages starting and stopping the performance monitoring based upon the schedules for its

linked objects.

4 NOTE:
* Performance counters applied to Custom Event Views are applied to all objects specified
by the Connections and Individual Event Objects dialogs. Enabled sources and category
filters on the Event Sources tab are then applied to the combined objects from Connections


http://www.sqlsentry.net/help/ug/Custom_Event_Views_Overview.html
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and Event Objects to determine which are monitored.

e In order to use event performance monitoring features in the Client (accessing and adding
counters), you must be a Domain Administrator or local Administrator on each monitored
Windows computer.

e The Monitoring Service will need to have administrative access to all monitored computers
in order to collect performance counter data.

This section discusses the different elements of Performance Monitoring.
Monitoring Event Object Performance
Monitoring Performance with Custom Views
Generating Performance Alerts
General Performance Monitoring

Monitoring Event Object Performance

MONITORING EVENT OBJECT PERFORMANCE
ADDING PERFORMANCE COUNTERS

To access this feature, expand the node for any job, task, report or custom event view and select the

Performance Counters node to display a list of available Windows performance counters to link to the
event object.

Bt SR YT ——

Server The default value is the server where the event object resides. Changing this option allows you to
monitor performance on any server, for example monitoring disk performance on a file server that is
used to deliver import files to a DTS job.

Connect Used to connect to a different server. This allows you to monitor counters on a remote server as well
as local counters.

Categories Windows groups performance counters into categories. Select the category from the list in the same
way you would if you were using Windows System Monitor.

Explanation For convenience, a detailed explanation of the performance counter is displayed here. A complete list
and explanation of Windows Performance counters can be found with the documentation supplied with
Windows System Monitor.

Add When the performance counter has been selected, press the Add button to link the counter. Once the
performance counter has been added, it will be displayed as a node under Performance Monitors, one
node for each counter.

ENABLE/DISABLE PERFORMANCE MONITORING
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To enable/disable performance monitoring for all counters linked to an object, right-click on the desired
object and select the Monitor Performance or Stop Monitoring Performance context menu item. A
job icon, for example, will change from ] to [@& when performance monitoring is enabled.

NOTE: In order for performance data to be collected and displayed on the graphs, performance
monitoring must be manually enabled using this process. Simply adding a counter to an event does not
automatically enable performance monitoring for an object.

PERFORMANCE GRAPHS

To view collected performance counter data select the desired counter node:

The graph shows the performance counter data alongside the event instance being monitored as well
as any other instances for watched objects that ran during the same time frame. The top  half of the
graph represents the performance counter over time. Below this, a graphical representation of all
watched event objects that ran during the same time is displayed along with a  legend to identify each
object. This format lets you easily correlate how an event instance or combination of instances is
impacting the counter.

The event  object being monitored is always shown in green; in this caseit's  the
“TEST2MantenancePlan.Subplan_1" job. In order to provide a baseline for the counter, data collection
begins a short time prior to the event instance's scheduled start time and  continues for a short period
after it completes.

If the event instance is having a significant impact on the counter resource, you should see the counter
jump after the instance starts. If multiple instances are causing contention for the counter resource, the
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counter will jump further. Note: If a certain job starts, and the counter values jump significantly, and this
increase is sustained until the job completes, this may be an indication that the jobs are fighting for
resources. When this happens, both jobs may run for longer than they would otherwise, which can lead
to undesired effects  such as lengthened maintenance windows, or  even worse errors  may be
encountered in the jobs or other applications using the monitored server.

CUSTOMIZING THE PERFORMANCE GRAPH

Max ¥ Val |6805.28 [¥] Auto-scale To Max Value [¥] Show Value Labels o | = |
Min ¥ val |0 Min Event Duration |0 +|seconds T [¥] Jump To Mext Instance Of |S5WS5: TEST2MaintenancePlz

Min Y Val: / Max Y Val:
Changing these values will resize the graph Y axis to the selected values.

Show Value Labels
Checking this box will show actual counter values above each bar in the performance graph.

Auto-scale to Max Value

Checking this box will automatically select the appropriate Max Y Value of the data being shown in the
current view. When this option is not enabled, SQL Sentry will use a standard deviation calculation to
determine the max Y Value, and the tops of some of the bars may be cut off.

Jump To Next Instance Of

Checking this box affects how the graph is scrolled when  using the Previous/Next buttons on  the
toolbar. With this box checked, the graph is automatically repositioned to the previous or next event
instance, enabling you to conveniently skip over time slots where no performance data is available.

Show Live Data

Checking this box will show the performance data graph in real time as the event runs. With this box
checked and the event running, the graph will automatically scroll to show new performance data
collected.

Min Event Duration
Setting this value can eliminate unnecessary “noise” from short-running recurring events.

Previous / Next Arrows
Pressing these buttons moves  the currently displayed range  forward or backward by  one minor
increment.

Navigation Toolbar
Use the Navigation Toolbar at the top of the screen to go to a specific date and time, or change the
graph interval.

See also:
Performance Counter Settings ('Actions Pane' in the on-line documentation)
Filtering Process

Monitoring Performance with Custom Views

MONITORING PERFORMANCE WITH CUSTOM VIEWS

Performance monitoring can be applied to custom event views similar to individual objects. This
allows you to apply the same counter to several related events at once to  determine how their
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interaction may affect the performance of the same device. When utilizing performance monitoring
on custom event views, it is important to understand the filtering process and what objects are
ultimately monitored by Event Manager.

Performance counters applied to custom event views are  applied to all objects specified by the
Connections and Individual Event Objects dialogs. Enabled sources and category filters on the
Event Sources tab are then applied to the combined objects from Connections and Event Objects
to determine which are monitored. For a graphical representation, see the filter process flowchart.

Generating Performance Alerts

GENERATING PERFORMANCE ALERTS

Performance Alerts can be generated based on minimum and maximum thresholds you define for
each counter. Once you have added a counter to an object or view, select that counter in the
Navigator pane to set the minimum or maximum thresholds in  the Settings pane. There can be
only one minimum and one maximum value for a given counter, regardless of how many objects
are linked to the counter.

Once you have defined thresholds for a given counter, actions such as Send Email, can be set for
the Performance Counter: Threshold Min or Max conditions at any level. This allows you to
define a global response whenever any performance threshold is exceeded, while defining a
specific response when a threshold is exceeded for a particular job or other monitorable object.

Performance alerts can also be throttled by specifying a length of time any counter must exceed
its threshold before an action is taken. Additionally, you can specify how often the action is taken
while the threshold is exceeded. These settings are available from the Settings window under the
SQL Sentry Monitoring Service node in the Navigator pane.

General Performance Monitoring

GENERAL PERFORMANCE MONITORING

"General" performance monitoring is possible with  Event Manager with a few easy steps. This
process will allow you to schedule performance monitoring throughout the day and receive
notifications whenever defined thresholds are exceeded.

e Schedule a single recurring placeholder job on a watched server somewhere in your enterprise
by right-clicking the Jobs node and selecting New > Placeholder Job. Set the job to run for less
than 10 seconds to prevent it from displaying on the performance graphs by default, and then
define a recurring schedule for the job based on how frequently and when you want to sample
the counters -- for example, every 5 minutes between 8am and 5pm daily.

e Create a Custom Event View which includes only that job.

e Link counters to the view using the view's Performance Counters node. The performance
counters can be on any server in your enterprise.

e Set performance counter minimum and/or maximum thresholds and define email alerts or other
response actions as needed. Also see Generating Performance Alerts.
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e Enable monitoring for the view by selecting the Monitor Performance context item. You can
disable counter collection at any time using Stop Monitoring Performance.

Custom Event Views

CUSTOM EVENT VIEWS OVERVIEW

E}F.E.'" Custom Event Vigws
: {:E." Local
Eﬁ.“ Shared
F.E.'" Sample Wigws

Custom Event Views are used to tailor views to view and monitor specific activity across the
enterprise.

For example, if you wanted to monitor all backup jobs across all your servers to determine if there

is contention for a backup  device, you could easily bring  up that specific information to  your
calendar view and drag-and-drop those jobs to level your backup schedule or view performance

information. After you set up a Custom Event View, it will operate like other views selected from
the Navigator pane. Custom Event Views may also be set as the Default View ('Setting a Default
View' in the on-line documentation) when the SQL Sentry Client starts by right-clicking the view
node and selecting the appropriate context menu item.

See Working with Custom Event Views for details on proper setup and configuration.

NOTE: To see new Custom Event Views created by other Client users, right-click on  the main
Custom Event Views node and select Refresh.

Working With Custom Event Views

WORKING WITH CUSTOM EVENT VIEWS

From the Navigator pane expand “Custom Event Views”. This  will provide the Sub-Nodes:
“Local” and “Shared”. Local Views are only available to the User that created them. Shared
Views are available to any User on any SQL Sentry Client. The setup of the View is the same
for either option.

To add a new Custom Event View, double-click on the Local or Shared Node or select "New"
from the context menu. This will bringup the “Add a Custom Event View” window n  the
workspace. The “Creator” field is already populated with your username and is uneditable.
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NOTE: If a view has performance monitoring enabled, using Save View As does not transfer
performance counter settings to the new view.

Creating a new Shared Custom Event View will trigger an Audit: Custom Event View:
Created condition. Deleting and/or modifying existing Shared Custom Event views  will also
trigger similar Audit: Custom Event View: Deleted or Audit: Custom Event View: Modified
conditions in SQL Sentry Event Manager.

ORGANIZING CUSTOM EVENT VIEWS

Both Local and Shared Custom Event Views can be organized using custom folder names.
Create a folder by selecting "New Folder" from the context menu on the Shared or Local nodes.
Once folders are created, views can be moved between folders by dragging and dropping the
view into the desired folder.

See also:
Filtering Process
Conditions and Actions

Filtering Process

FILTERING PROCESS

When setting up a Custom Event View, it is important  to understand the two levels  of object
filtering that take place. The first level of filtering, source level filtering, determines which objects
are included in the view. Any performance counters that are applied to this view will be applied to
every object thatis included after this level of filtering. The second level of filtering, general
filtering, only determines under which circumstances the above objects will be visible on the
calendar. They will still have performance counters applied to them whether they are visible or not.

SOURCE LEVEL FILTERING

Any filter text specified from the Add Connections ('Working With Custom Event Views' in the
on-line documentation) window when setting up or making changes to  a view is at the source
level. This will restrict the number of objects associated with the view and therefore the number of
objects that will be monitorable.

After the view is  created, additional source level filtering can be applied through the Event
Sources tab such as Jobs, Alerts, Tasks, etc. By checking or un-checking the Show <source>
checkboxes, you determine whether objects of this type will be included in the view.

Also on the Event Sources tab are Event Objects and Categories boxes that allow you to
further filter objects from the view. These boxes are typically populated when working with a view
with only one connection.

GENERAL FILTERING

Any filters applied from the Filter tab of the Event Views pane only determine whether or not
certain event objects will be visible on the calendar. Even if they are made invisible by this filter,
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they will still have any performance counters applied to them that are applied to the view. This is
an important distinction for performance purposes. If you do not want a performance counter

activated for an object in a view, you must ensure that it is filtered at the  source level, and not
simply made invisible by the Filter tab.

Please view the Event View Filter Process Flowchart for an illustration of this process.

Filter Process Flowchart

EVENT VIEW FILTER PROCESS FLOWCHART
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After clicking “OK”, we have a Custom Event View ready to use.
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The jobs with an orange background indicate scheduling conflicts - note we have several cases
where backups coming from different servers are hitting the SAN at the same time. Drag-and-
drop functionality can be used on future job instances on the calendar to eliminate the
scheduling conflicts and reduce associated contention on the SAN or network.

When all jobs have a white background, you know you have a “leveled” schedule. A leveled
schedule ensures that any bottlenecks and associated IO errors on the SAN's disk subsystem
and network are minimized, and that backup jobs run at optimal speed!

See Also:
Save View As... Menu Item ("Working With Custom Event Views' in the on-line
documentation)

7.5  Chaining and Queuing

Event Chains

EVENT CHAINS

An event chain is a series of dependencies between events running on the same server or different
servers. There is no limit to the length  of a chain, or the number of events that can be defined for a
chain. To navigate to event chains, select the "Event Chains" node from the Navigator.
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included an SSRS report as node in an Event Chain.

COPY CHAIN

You may run into a situation where you want to create a second chain that is similar to an existing
chain, or want to use an existing chain as a template for new chain. You can effectively copy a chain,
using the Save Chain As... option on the File Menu,

You will then be asked to enter a new name and optional description for the chain.

NOTE: To see new Event Chains created by other Client users, right-click on the Event Chains  root
node and select Refresh.

ORGANIZING EVENT CHAINS

Event Chains can be organized using custom folder names. Any  Event Chain can be moved into
another folder by dragging and dropping into another folder.

See also:
Event History Monitor Settings
Custom Event Views
Performance Monitoring
Conditions and Actions

Job Queueing

JOB QUEUING

Job Queuing allows a resource intensive job to delay other jobs from executing untilit has
completed. This allows the resource intensive job to  utilize more of the  server resources,
allowing all jobs to finish faster and more efficiently. Unlike Event Chains, Job Queuing applies
only to the jobs on an individual SQL Server instance.

Each SQL Agent job has its own queuing settings. Simply click on the desired job and select
the "Settings" tab from the Actions and Settings Pane. Note that you can also configure default
queuing settings at both the global and connection levels, and those settings will be inherited by
any associated jobs.
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AN EXAMPLE SCENARIO

The primary reason for queuing jobs is to ensure a high priority, resource intensive job has full
access to the server's resources to complete its task without competing with other jobs that can
be delayed until the high priority job is done.

For example, consider a full backup job that runs once a week, every Sunday at 1 AM. If this is

the only job running, having full use of the server's resources, it can complete in  about 45
minutes. However, there are typically other recurring jobs on the same server that can cause

contention for resources, resulting in the backup taking almost two  hours to complete. This in
turn causes delays in many other recurring jobs being able to successfully complete. While it is

not plausible to reschedule a five minute recurring job to recur once an hour for the sake of this

one weekly backup, it may be acceptable to temporarily queue that job for one  hour once a
week until the backup is complete.

Clearing Failed Instances

CLEARING FAILED INSTANCES
IDENTIFYING A FAILED INSTANCE

When a certain event has failed, there are several ways the SQL Sentry Client signals you to that fact.

In the Navigator Pane, the text of the object will be red to indicate a failed instance. In the Calendar View,
the status bar for that event's instance will be red

12:50:00 214230 PM Block A [TTET 12:30 pm Block B o |
12:37 PM Failed Job/Step Test |
12:42 PM 5 seconds

and in the List View, the first cell has a red background.
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JOB 2 (FROM ABOVE)

GRAPH CONTROLS

Use the Navigation toolbar to change the start date/time and interval for the graph. The

Days

control can go out up to 60 days at a time. Whenever the selected interval is less than 1 day (1
minute through 4 hours), the Days control will be changed to 1 day.

Min/Max Y Val

Auto-scale to Max
Value

Interval Type
Show Value Labels

When a runtime graph is first displayed, SQL
Sentry will try to determine the most appropriate
interval and maximum Y-axis value. You can
change either of these settings at any time.

Checking this box will automatically select the
appropriate Max Y Value of the data being
shown in the current view.

Changes the interval used for the Y-axis.

Deselect this checkbox to hide the bar value
labels. This can become necessary for broader
ranges with hundreds or thousands of bars to
reduce the noise on the graph.

Toolbars

TOOLBARS

SAVE AND PRINT TOOLBAR
The following describes the Save and Print Toolbar buttons:

3y

foy= | A |

H Save
B

Lt

=

Print

Print Preview

Universal save button.

Displays a print preview window for the selected object.

Prints the selected object.




SQL Sentry User Guide | 134

e Opening a Top SQL, Block, or Deadlock event on the calendar will take you directly into
Performance Advisor with that event selected and expanded.

PERFORMANCE ADVISOR CONDITIONS, ACTIONS & SETTINGS

¢ Performance Advisor conditions are available on the General Actions tab for SQL Server
connections:

¢ Blocking SQL

e Blocking SQL: Output Content Match

¢ Blocking SQL: Runtime Threshold Max
e Deadlock

¢ Deadlock: Output Content Match

e Top SQL

¢ Top SQL: Output Content Match

¢ Top SQL: Runtime Threshold Max

¢ The Run Quick Trace action is available for certain Event Manager and Performance Advisor
conditions. This action will execute and save a Quick Trace when the condition is triggered,
including:
¢ Event Chain Node: Runtime Threshold Max
¢ Event Chain: Runtime Threshold Max
¢ Performance Counter: Threshold Max
¢ Performance Counter: Threshold Min
e SQL Server Agent Job: Block
e SQL Server Agent Job: Retry
¢ SQL Server Agent Job: Runtime Threshold Max
e SQL Server: Blocking SQL
e SQL Server: Blocking SQL: Runtime Threshold Max

¢ Performance Advisor settings are available from the Settings pane:
¢ Blocking SQL
¢ Blocking SQL Source
¢ Deadlocks Source
e Top SQL
e Top SQL Source

Performance Advisor Global View

PERFORMANCE ADVISOR GLOBAL VIEW

The Performance Advisor Global View provides the user with a summary of performance data
for all watched connections. To open the Global View use the right-click context menu of the
Shared Groups node. Use the Show Avg Over drop-down list box to change the interval for
the summarized data. Use the Show drop-down list box to view either Windows, SQL Servers,
or Analysis Services. Please see the Performance Metrics section of the User Guide for a
detailed description of the various performance metrics.

The default setting for the Performance Advisor Overview Skin is black, but can be set to standard via the User
Preferences window. (Tools->User Preferences->Performance Advisor)
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FILTERS

In the top right corner of each filter column header is a filter button. Once selected, the user can
choose the operator and value to filter the data. Once a filter is set, it  will appear along the
'Edit Filter'

bottom panel of the window. Edits to the filter can be made here by simply clicking
disabled by clearing

and changing the criteria. It

can also be

completely using the 'X' on the left side.

PERFORMANCE ADVISOR OVERVIEW THRESHOLDS

the checkbox or

Computer Level Normal Warning Critical
Network Outbound Queue >=3 >=3 for 20 second
duration

Network Inbound Errors >0

Network Outbound Errors >0

Memory Free (MB) <100

CPU Context Switches <5000 times # of >=5000 times # of cores | >=7500 times # of cores
cores

CPU Processing Time % 90

CPU Queue Length >2 times the # of cores

Computer and SQL Server Level

Disk Reads ms/IO <20 20-29 >=30

Disk Writes ms/IO <20 20-34 >=35

SQL Server Level

SQL Server Activity Blocks >0

SQL Server Activity Deadlocks >0

Average Wait Time (ms) CPU % >25

SQL Server Memory Grants Pending >2

SQL Server Memory PLE <600

Disk 10 Lazy Writes >20

SSAS Level

SSAS Formula Engine Queued Jobs >0

SSAS Storage Engine Queued Jobs >0

SSAS Memory Cache Evictions >0

SSAS Storage Temp File (KB) >0

SSAS Memory (KB) Shrunk >0

closed

Dashboard

PERFORMANCE ADVISOR: DASHBOARD

The Performance Advisor Dashboard provides an overview of  both Windows server and SQL  Server, displaying the most
important metrics used for  determining server health and load. Performance datais organized into two vertical panes, with
Windows operating system metrics in the left pane, and SQL Server or SSAS metrics in the right pane.

Please see the Performance Metrics section of the User  Guide for a detailed description
displayed on the Dashboard.

of the various performance metrics

Metrics for all SQL Server or SSAS instances on the server are integrated into the Windows Network: Total, CPU Usage: Total, and
System Memory charts, so you can  quickly determine exactly how much  of each of these resources is being used by each
instance, for any point in time. When hovering over colored sections of these charts the corresponding instance will be displayed.
Note that each instance has a unique color assigned to it that remains constant across all charts.
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Quick Traces

PERFORMANCE ADVISOR: QUICK TRACES
QUICK TRACE™

A Quick Trace is a comprehensive snapshot of activity created by combining process-level data
and trace events collected during a  brief sample period. Various metrics such as CPU, /O,
recompiles, cache misses, cursor operations, etc., are automatically aggregated, and can be
easily grouped and sorted, to  provide a clear picture the processes, hosts, applications, or
users responsible for activity during the sample.

Whereas the continuous Top SQL trace uses filters to collect only the heaviest events by
default in order to maintain  low overhead, a Quick Trace is not filtered and so  collects all
events. Thisis  why Quick Trace is both time- and row-limited, to  avoid impacting the
performance of the target SQL Server.

A Quick Trace is typically run manually from the dashboard in response to observing high
utilization in one or more metrics. For example, if you see an spike in  Transactions/sec on the
SQL Server Activity, you canruna Quick Trace, then sort by Transactions to  determine the
cause.

COLUMN SET

There are four Column Sets that can be selected and modified to  provide a pre-determined
view of the data with preset columns and sorting. If a Quick Trace is launched by right clicking
the Network, CPU, SQL Server Activity, or Disk IO  charts, the appropriate column set will be
used by default. The active column set can be easily changed by right-clicking the master or
detail column header row and selecting the Column  Chooser menu item. When you initiate a
Quick Trace from the Quick Traces tab the SQL Activity Column Set will be used.

The Quick Traces tab lists all Quick Traces occurring during the  active date range. Quick
Traces can be executed manually or automatically via the Run Quick Trace action in response
to a condition such as Runtime Threshold Max or Performance Counter Threshold Max.

RUNNING A QUICK TRACE

When Run Quick Trace is selected from the Quick Traces tab or from the right-click menu on
the other applicable tabs, the options menu opens. In the first box, the user can enter the
length of time the Quick Trace will run. In the second box the user can either Collect statement
events or not by using the check-box. In the third box, the number of Trace Data rows can be
limited to the desired amount.

Default Settings:

e The Quick Trace will run for 15 seconds.
¢ Collect statement events is unselected.
e Limit Trace Data to 10000 rows.
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FILTERS

On many of the fields found on grids in the Performance Advisor, a filter can be used along with
different sorting methods to organize data. The filters show up on applicable column headers on
the top-right side  of the cell whenthe mouse isoverit. Thefilter can be selected by
clicking the small filter button, which  will bring up the filter menu  options. The Filter Editor is
available from the right-click menu also. This feature allows the user to specify filter conditions by
typing them into the window that opens.

EXPORTING GRIDS

The Data Grids found in Performance Advisor provide a great deal of information to the user in
a form that is very easy to customize. = Once the desired organization of the columns has been
achieved, the user can export the information in a variety of formats. This can be done using the
file menu on the applicable tabs of the SQL Sentry Client.  Select Export Data, give a file name,
then select the desired file type.

Types of Files:
e CSV Files (*.csv)

e Microsoft Excel (*.xIs)
e Adobe Acrobat Files (*.pdf)
e Web Pages (*.htm; *.html)

Performance Metrics

PERFORMANCE METRICS

This topic covers the various performance metrics displayed by the Performance Advisor Dashboard and Performance Advisor Overview, and  how to
interpret different metric values and combinations of values across different metrics.

Windows Metrics

Network

Total network utilization

Utilization by SQL Server/SSAS instance
Utilization by network adapter
Network output queue length

CPU Usage

Total processor time

User time by CPU

Kernal time by CPU

Processor time by SQL Server/SSAS process
Context Switches

Processor queue length

System Memory

Memory by SQL Server/SSAS instance
Other processes memory

File Cache memory

Available Memory

Read Faults

Write Faults

Page file usage

Disk 10

Read latency by physical disk

Write latency by physical disk

SQL Server Metrics
SQL Server Activity
User Connections
Blocked Processes
Batches
Transactions
Compiles
Recompiles
Bookmark lookups
Forwarded records
SQL Server Waits
CPU % of Total Waits
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enough, but it's an important concept.

There's another important characteristic ~ of most execution engines — they throw off status
information, typically in the form of an execution log. This elementis key for many of the
functions of SQL Sentry , including notifications, chaining, queuing, etc. If an execution engine
does not log status information to its own execution log, then SQL Sentry will default to use the
logs of the associated scheduler. The fact that it doesn't have an execution log doesn't mean
that it's not an execution engine, just that for SQL Sentry 's purposes there isn't really much that
can be done with it — we need some type of execution log data with an associated provider to
show the event instance on the calendar, trigger conditions and actions, monitor performance,
etc.

NESTED EXECUTION ENGINES

Some execution engines involve multiple “subsystems” — SQL Agent jobs are one example. A
job can use a T-SQL step to do work inside the SQL Server process space. The same job can
also have an OS Command step which shells out to an executable completely outside of SQL
Server to do other  work. When this occurs, the executable could also  be considered an
execution engine, as long as it logs status information independently from the execution agent.

A good example of this is a “scheduled” DTS package. The SQL Agent job doesn't do any real
work, at least not interms ofits own embedded T-SQL or scripting logic. It simply calls
dtsrun.exe which usually connects back to the SQL Server to load and execute a package.

In this case we have two different execution engines writing to their respective execution logs —
the SQL Agent job and dtsrun (if logging is enabled for the package). We end up  with some
general information about the package execution in the job history in MSDB, including the total
job duration, job status (success or failure), and the first 1024 characters of the package's
output stream.

Isn't the job log enough? Well, sometimes...but what happens if the DTS package contains 30
steps, and it failed on steps 10, 18, and 237  Although the job will show as failed, most of the
time you aren't going to be able to make much sense of the job's output, at least not enough to
diagnose and resolve the issue.

Not to fear, if you have package logging (‘DTS Packages' in the on-line documentation)
enabled you will have an entry for each step in the DTS logs in MSDB, including success or
failure status, records processed, and detailed error text for the failed steps.

Similarly, the package may have been executed by some other “enterprise” scheduling system
via dtsrun, in which case there won't be any record of a SQL Agent job running in MSDB...that's
because a job didn't actually run! In  this case your only hope is the DTS package logs, and
possibly the scheduler's own logs which are typically subject to the same limitations as a SQL
Agent job history logs.

If there are two separate logs, doesn't this mean duplicate historical information? Yes, it does —
but fortunately SQL Sentry knows how to deal with this when it comes to DTS and Maintenance
Plans are executed by SQL Agent jobs. Matching logic is used to join the corresponding events
together, and on the calendar you'll always see the most detailed data by default — in this case
the DTS log data. If you want to see the associated job log records alongside the engine logs,
you simply enable the “Show Related Events” option on the DTS filter tab.

Event Stores

EVENT STORES
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Event Store Connections

EVENT STORE CONNECTIONS

An event store connection (usually referredto simply asa connection)is used by event
sources to access data in event stores via some network transport mechanism.

In the SQL Sentry Client, each SQL Server and Task Scheduler instance node represents a
single connection as shown below. In the future, other connection types will be supported.
*- [ IC3RYET

=} ICSRYES "/ SOL Server Connection
=g 1CsRves

+ Jobs
¥ ﬁ.‘ Maintenance Plans

+ E’p‘ Blerts

+- B DTS Packages
@ SGL Server Agent Log

& Task Scheduler — )
+- I IC5RYS Task Scheduler Connection

For example, the Jobs event source above utilizes the "SQL  Server Agent Job" event provider
over an ADO.NET connection tothe SQL Server to access eventdata stored in the MSDB
database.

For maximum efficiency and performance, SQL Sentry allows a connection to be shared by
multiple event sources simultaneously - all event sources under the SQL Server connection node
above (Jobs, Maintenance Plans, Alerts, DTS Packages, Reporting Services, and SQL Agent Log)
utilize the same physical network connection. This conceptis illustrated in more detail in  the
Event Connector Architecture Diagram.

CONFIGURING CONNECTION-LEVEL SETTINGS

Whenever you single-click on a connection node in the Navigator, the Actions and Settings pane
will automatically refresh to display all conditions, actions and settings for the selected connection.
Any changes made here will apply to  the selected connection only, overriding any globally
configured settings. Likewise, connection-level settings can be overridden at  the object level by
selecting an object node in the Navigator.

Event Providers

EVENT PROVIDERS

An event provider is a module which enables SQL Sentry to communicate with and translate data
from an event store over an event store connection into a common format which can be used by
the various parts of the SQL Sentry system, including calendars, graphs, and notifications. A SQL
Sentry event provider is analogous to an OLEDB provider or ODBC driver. There are three types
of event providers: Schedulers, Execution Engines, and Event Logs.

Scheduler providers enable interfacing with the native  scheduler logs, such as for SQL Server
Agent or Windows Task Scheduler.

Execution engine providers connect with the native stores for execution engines for collecting
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historical information, and active status information if supported by the provider. Not all providers
support active status queries.

Event log providers enable translation of status event data contained in a log-type stores, such as
for the SQL Agent Alert log or the Windows Event Log.

SQL Sentry Event Manager ships with several providers, including:

Event Provider Provider
Type
SharePoint Timer Job Scheduler
SQL Server Agent Scheduler
SQL Server Agent Job Execution
Engine
SQL Server Agent Alert Event Log
DTS Execution
Engine
Maintenance Plan Execution
Engine
Reporting Services Execution
Engine
Oracle DBMS Job Scheduler
Oracle Scheduler Job Scheduler
Window Task Scheduler Scheduler

SQL Sentry Event Manager utilizes a “plug-in” architecture which allows future modules to be
added on, typically without requiring install of a new version of the SQL Sentry software.

Event Sources

EVENT SOURCES OVERVIEW

An event source represents a unique instance of an event provider operating over a single event
store connection . In SQL Sentry's Navigator pane, every sub-node underneatha SQL Server
node represents a unique event source. For example, the Jobs node underneath SQL Server
ICWS16 above is an event source - behind the scenes the "SQL Server Agent Job" event provider
is used over the connection to SQL Server ICWS16 to access metadata, history, and active status
information for any watched jobs on the SQL Server.

Below is a current listing of all event sources currently supported by SQL Sentry, along with its
associated event objects, providers and connections:

Navigator Node Event Provider Connection
Type

SQL Server Agent Jobs Jobs SQL Server Agent Job  SQL Server
SQL Server Agent Alerts Alerts SQL Server Agent Alert  SQL Server
SQL Server Agent Log SQL Server Agent Log SQL Server Agent SQL Server
DTS Packages DTS Packages DTS SQL Server

Maintenance Plans Maintenance Plans Maintenance Plan SQL Server
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Navigator Node Event Provider Connection

Type

Reporting Services Reports Reporting Services Reporting Services SQL Server

SharePoint Timer Jobs SharePoint Timer Jobs SharePoint Timer Service SharePoint
Server

Oracle DBMS Job DBMS Jobs DBMS Job Oracle

Oracle Scheduler Job Scheduler Jobs Scheduler Job Oracle

Windows Tasks Tasks Window Task Scheduler Task

SQL Server Agent Jobs

JOBS

= 1ows1e
=g ICWS16 (TSH: ICWS31)
Jobs
+ %‘ Maintenance Plans

+ E’p‘ Alerts

+- B DTS Packages
+ Reporting Services
SOL Server Agent Log
= @ Task Scheduler

- @ Tasks

SQL Server Agent Jobs are listed for each SQL Server connection under the Jobs node. Expand
the node to view the list of jobs, or single-click the node to view a calendar for all jobs. The SQL
Server Agent Job event provider is used behind the scenes to access job metadata, history, and
active status information.

Using the SQL Sentry Client, you can perform all of the same tasks related to jobs that you would
previously do via SSMS, plus many more features such as visual scheduling, performance
monitoring, reporting, queuing and chaining.

SQL Server Agent Alerts

ALERTS

- [ 1ows1e
=7 ICWS16 (TSH: ICWS31)
+ Jobs
+ %‘ Maintenance Plans
m.‘ Alerts
+ B3 DTS Packages
+ Reporting Services
S0 Server Agent Log
= &A Task Scheduler

= & Tasks

SQL Server Agent Alerts  are listed for each  SQL Server connection under the Alerts node.

Expand the node to view the list of alerts, or single-click the node to view a calendar for all alerts.
The SQL Server Agent Alert event provider is used behind the scenes to access alert metadata
and history information.
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NOTE: In order to enable server alert collection and notification without the use of agents on each
SQL Server, SQL Sentry must install one simple job (SQL Sentry Alert Trap) and stored procedure
(msdb.dbo.spTrapAlert_20), and one small table (msdb.dbo.SQL_Sentry AlertLog _20) on each
watched server.

SQL Sentry must also make a minor configuration change to each server alert in order to enable
alert collection and notification - the “Execute job” setting is updated to use the “SQL Sentry Alert
Trap” job. If an alert is already set to execute another job, the “Execute job” settings for that alert
will not be updated, and SQL Sentry will not be able to generate notifications for the alert.

One of the most common reasons the “Execute job” setting may already be set to a job is for
logging and/or notification purposes, in which case SQL Sentry may be able to safely assume
control of this function. Some of the advantages of using SQL Sentry instead are that its  logging
and notification processes are centralized (versus distributed on each server), they are not MAPI-
dependent, and they can easily be made redundant by using more than one SQL Sentry
Monitoring Service.

A complete list of objects SQL Sentry places on a watched server can be found here.

NOTE: In order to watch alerts on SQL Server 2005 and above connections, token replacement
must be enabled for the SQL Server Agent. This is disabled by default as a security precaution.
More information on this setting can be found in SQL Server Books Online. You can also
configure SQL Sentry to auto-enable SQL Agent tokens (‘Actions Pane' in the on-line
documentation) at the global and connection level.

DTS Packages

DTS PACKAGES

[y ICWS16
= TOWS16 (TSH: ICWS31)
+ Jobs
+ @.‘ Maintenance Plans

+ ii’l.‘ Alerts

B DTS Packages
+ Reporting Jervices
5L Server Agent Log
=I-@A Task Schedulsr

- @ Tasks

SQL Server DTS Packages are listed for each SQL Server 2000 connection under the DTS Packages node.
Expand the node to view the list of packages, or single-click the node to view a calendar for all packages. The
DTS event provider is used behind the scenes to access package metadata and history information. Logging
must be enabled fora DTS package in order for SQL Sentry to be able to display history for the
package on the calendar, as well as generate notifications for it.

ENABLING DTS PACKAGE LOGGING

DTS package logging in SQL Server 2000 is a powerful feature when combined with SQL Sentry's ability to
collect it, render it, and trigger conditions and actions based upon it. Package logging enables SQL Sentry to
collect and display detailed status information for any DTS package execution, regardless of how the package
was executed. Historically it has been difficult to troubleshoot failed scheduled packages because the output
stream for a SQL Agent job only contains the first 1024 characters of the package's output, and thus is
frequently truncated. It is also not formatted so is difficult to read. In addition, without package logging it isn't
possible to know for sure how long each package task is taking, which is valuable for troubleshooting long-
running packages.
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Step Il Step Mame Start Time End Time Dwration  Meszage

331532 | DTS5Step_DT5SDynamicPropertiesTa... | BAGA2005 10:03:30. |BABAZ2005 10:03:30. [ 00:00:00 | Processed: 0

331533 | DTS55tep_DTSActiveScriptT ask_1 B/1E/2005 10:03:30.. | BAGA2005 10:03:30.. | 00:00:00 | Processed: 0

381534 |DTSStep DTSExecuteSOLTask_2 E/16/200510:0%30. | 6/16/2005 1000347, | 00:00:17 | Processed: O

331535 | DTS5tep DTSDataPumpTask 1 BAE/200510:03:47.. | 6AE6/200510:03:49.. | 00:00:02 |Processed: 0 -- Emor

Step Error Source: Microsoft OLE
DB Provider for SOL Server
Step Ermor

Dezcriphion: Trangaction [Process
1D 110] waz deadlocked on lock
resources with another process
and has been chozen az the
deadlock victim, Remn the
transaction.

Step Eror code: 80074005
Step Eror Help File:

Step Emor Help Contest [D:0

NOTE:

e Concurrently running instances of the same DTS package may result in incorrect step information as well
as incorrect messages being sent.

e Occasionally, DTS packages may show as running even after they have completed. For this reason, while
a package is running, the Close Running Event context menu item is available to manually close this event.

This menu item should only be used when you are sure the package has completed, but shows as running
in SQL Sentry .

Reporting Services Reports

REPORTING SERVICES

I ICws16
- ICWS1E (TS IOWS31)
+ Jobs
+ ﬁ.‘ Maintenance Plans

+ E’p‘ Alerts

+ Q.‘ DTS Packages
Reporting Services
S0L Server Agent Log
|- Task Scheduler

+ &‘ Tasks

If a Reporting Services database exists on a SQL Server, the Reporting Services node will be displayed
under the SQL Server connection node, under which all reports are listed by name. Expand the node to
view the list of reports, or single-click the node to view a calendar for all reports. The Reporting Services
event provider is used behind the scenes to access report metadata and history information.

For scheduled reports, Reporting Services jobs are listed under the Jobs node using a combination of the
report name and schedule type. Keep in mind that not all reports have schedules, and some reports have
multiple schedules, so the associated object nodes shown under Jobs and Reporting Services nodes may
not match exactly. "Shared" report schedules will be listed under the Jobs node.

Reports are displayed on the Calendar by a friendly name, and offer many details through their popup
window.
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!I 2:48 AM Company Sales

Mame: Company Sales
IE m.[Event Tvpe: Reporting Services Report
HPath: fCompany Sales
Description: Adventure Works sales by quarter and product cateqgory, This report illustrates the use of a
rmatrix data region that provides drildown From summary data inko detail data by showing and hiding
rows, This report alsa illustrakes the use of background images.

i

Run Type: Manual execution
——ctatus: Succeeded

[ 10: Jinstance Name: ICWS32
User Mame: INTERCERYE swright
Report Farmat: HTML4.0
Time For Data Retrieval; 964
Time To Render: 239

Time To Process: 304

Bwte Count: 10526

Raow Count: 154
Parameters:

i

[ 11 q5tart Time: 10/13/2005 9:45:32 AM
End Time: 10/13/2005 9:45:33 AM
Duration: 00:00:01 (100%: of Awg)

i

Min Rontime: 00:00:01
#vwg Runtime: 00:00:01
Max Runtime: 00:00:01

e - — ...,

J

SQL Server Agent Log

SQL SERVER AGENT LOG

o Iy Iows1e
= ICWS 16 (TSH: TCWS31)

+ Jobs
ﬁ.‘ Maintenance Plans

E’p‘ Alerts

B DTS Packages
IE] Reporting Services

SOL Server Agent Log
= & Task Scheduler

- @ Tasks

O O R

The SQL Server Agent Log node is listed under each SQL Server connection node (SQL Server
2000 instances only). Single-click the node to view a calendar for all SQL Server Agent events.
The SQL Server Agent event provider isused behind the scenes to access this  history
information.

SharePoint Timer Jobs

SHAREPOINT TIMER JOBS
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—.ﬁ OWe1564-1054%5P I SWE C O
{ i.."ﬂ OuE1564-10585P IMSWVE, CORYEPINSTAMCE (ERA)
—lﬂ ZharePoint Timer Jobs
+E'rt"'I Application Server Administration Service Tirmer Job

+E‘| Spplication Server Timer lob

Event Manager for SharePoint can help you monitor SharePoint timer jobs in a SharePoint 2010
installation. SharePoint timer jobs can be a point of contention in your environment, as they use
the concept of "ranges" —you set possible start and end times, and the job can run any time
during that range. The Event Manager Calendar for SharePoint gives you visibility into possible
conflicts across your installation.

[# NOTE: SharePoint 2007 servers are not supported.

SharePoint Timer Jobs are listed for each SharePoint Server connection under the  SharePoint
Timer Jobs node. Expand the node to view the list of jobs, or single click the node to view a
calendar for all jobs. The SharePoint Timer Job event provider is used behind the scenes to
access job metadata, history, and active  status information. You can use the Properties
command found in the right-click context menu of any SharePoint Timer Job node to launch the
SharePoint Central Administration web interface.

[{ NOTE: To access the schedule properties the user will need  to be member of the Farm Administrators Group. For
more information about the levels of administration within SharePoint Server 2010 see this Microsoft Technet article.

You can setup alerting for various Timer Jobs, just as you would with SQL Server Agent Jobs. See
the Conditions and Actions Matrix (on-line documentation) for a complete list of the conditions
for which SQL Sentry can respond, along  with the corresponding actions that can be  taken for
SharePoint Timer Jobs.

For additional information about  Event Manager for SharePoint _ see this blog post by Greg
Gonzalez.

Windows Tasks

WINDOWS TASKS

= [y ICws1s
=l ICWS 16 (TSH: ICWS31)
+ Jobs
+ %‘ Maintenance Plans

+ E.‘ Alerts

+- B DTS Packages
+ Reporking Services
SGL Server Agent Log
= ﬁ Task scheduler
ﬁ-‘ Tasks

Windows Tasks are listed for each Task Scheduler connection under the Tasks node. Expand the
node to view the list of tasks, or single-click the node to view a calendar for all tasks. The
Windows Task Scheduler event provider is used behind the scenes to access task metadata,
history, and active status information.

IMPORTANT: Windows Vista introduced Task Scheduler 2.0. Task Scheduler 2.0 is backwards


http://technet.microsoft.com/en-us/library/cc263291.aspx
http://sqlsentry.net/event-manager/sharepoint.asp
http://greg.blogs.sqlsentry.net/2011/10/sql-sentry-v62-sharepoint-timer-jobs-oh.html
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Oracle Scheduler Jobs

ORACLE SCHEDULER JOBS

-y ICLAPL2, INTERCERVE.COM
- ICLAPL2ASGLOL
= H ICLAP12\0RALOG
- [ DBMS Jabs
: -- Scheduler Jobs
e} & Task Scheduler

NOTE: The Oracle Scheduler was introduced in the Oracle database 10g Release 1.

Oracle Scheduler Jobs are listed for each Oracle connection under the Scheduler Jobs node.
Expand the node to  view the list of jobs, or single-click the node to  view a calendar for all
Scheduler jobs. In order to perform actions on Scheduler jobs the user must either be the owner of
or be granted the alter privilege on the job.

While watching Scheduler Jobs in Event Manager, the following functionality is available through
the SQL Sentry Client:

Objects
e Listall jobs

e Start jobs
e Stop jobs
e Enable/Disable jobs

Display

e Display running jobs

e Display estimated future run events for jobs
e Display historical job runs

e Reschedule jobs via drag-and-drop

Oracle Scheduler jobs can be scheduled using named schedules. Ifa  Scheduler job that uses a
named schedule is rescheduled using SQL Sentry Event Manager, the named schedule will not be
changed. Instead the Scheduler job will be marked to no longer use a stored schedule and the
new schedule will be a part of the job object itself.

Event Objects

EVENT OBJECTS OVERVIEW

At a high level, an event object is simply any job, task, or other event type that can be managed
using SQL Sentry. There are  two general types of events:  active event objects and status
events. The two are actually completely different, with the exception that their event instances
both occur at some measurable point in time, and therefore can be represented chronologically in
calendar and list views. A third sub-type is hybrid event objects which contain some characteristics
of both active and/or status events.
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WHY IS IT IMPORTANT TO DIFFERENTIATE THE TYPES OF EVENT
OBJECTS?

When you view a calendar in SQL Sentry , you will see a combination of various types of active
and status event instances. Active event objects include SQL Agent Jobs, DTS Packages,
Maintenance Plans, and Reporting Services Reports, along with Windows Task Scheduler Tasks.
Status events include SQL Agent Alerts and SQL Agent Log records. Since busy calendars can
include some or all of these event types, it's important to be able to differentiate them to make the
most of the information presented. The SQL Sentry Client facilitates this by indicating the  type of
event object using a small glyph (‘Calendar View' in the on-line documentation) on each event
instance, as well as in event instance popup windows.

It's also important  to understand why, for example, active event objects have runtime and
performance graphs, as well as runtime and performance conditions, while status events do not.

Event Objects Connection Type

SQL Server Agent Job Active SQL Server
SQL Server Agent Alert Status (hybrid) SQL Server
SQL Server Agent Log Record Status SQL Server
Maintenance Plan Active (hybrid) SQL Server
DTS Package Active SQL Server
Reporting Services Report Active SQL Server
Oracle DBMS Job Active Oracle

Oracle Scheduler Job Active Oracle
Windows Task Active Task Scheduler

Active Event Objects

ACTIVE EVENT OBJECTS

An active event object is also commonly referred to as ajob or a task, and contains all of the
information necessary to perform some measurable work. This  can include instructions in some
scripting language (T-SQL, VBScript, etc.), connection information, configuration parameters, etc.
Active events always have a start time and an end time, i.e., they have duration, and they are also
schedulable. SQL Agent Jobs, Oracle Jobs and Windows Tasks are examples active event
objects.

Status Events

STATUS EVENTS

A status event represents the discrete occurrence of some condition of a  process, usually a
persistent process. Status events do not have duration, they are not schedulable, and they do not
perform any measurable work. For example, the SQL Server Agent Log contains various status
events given off by the SQL Server process at specific points in time.
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STATUS EVENT OBJECTS

A status event object is any status event that is predefined and/or configurable, such as a SQL
Server Agent error condition. Most entries in the SQL Agent Logs are instances of a status event
object, such as this one:

[264] An attempt was made to send an email when no email session has
been established

Although this event object is not “configurable”, it represents an error condition thatis  predefined
and static.

AD HOC STATUS EVENTS

Not all status events can be pre-defined, for example an “ad  hoc” message for a transaction log
backup recorded in the SQL Server Log:

Log backed up: Database: Northwind, creation date (time) :
2004/07/27(11:51:24), first LSN: 238:292:1, 1last LSN: 238:292:1, number
of dump devices: 1, device information: (FILE=1, TYPE=DISK: {'D:\Program
Files\Microsoft SQL Server\MSSQL\BACKUP\

In this case a discrete status event is logged as the result of some process, but does not specify a

start or end time, nor is the output constant, i.e., it changes every time. Itis  also not entirely pre-
defined nor is it configurable; therefore we consider this an ad hoc status event.

Hybrid Event Objects

HYBRID EVENT OBJECTS

Hybrid event objects are those that don't necessarily fall cleanly into the active or status event
categories.

For example, a SQL Agent Maintenance Plan is an active event object that is comprised of
several other active event objects — SQL Agent jobs. The plan itself doesn't actually do any work,
the jobs do; they handle the various activities associated with the plan  such as backups,
optimizations, etc. In this case the jobs act as surrogates for the plan itself. The plan does,
however, contain configuration information, as well as an execution engine and log, and its
associated jobs do work and have duration. Therefore we consider the plan a variant of an active
event object. If it did not have its own configuration info or execution log, it would simply be a
collection of jobs.

A SQL Agent Alertis avariant of a status event object . Alerts can be triggered by various
conditions of the SQL Server process, such as a full transaction log, a corrupt database, etc. SQL
Server logs a status event to the Windows Application Log, then SQL Agent picks it up and fires
any defined Alerts that match  the condition. Although Alerts don't actually have their own log,
when they fire SQL Sentry is able to capture the output as a discrete status event instance and log
it to a table in MSDB, effectively an event log. SQL Agent Alerts  are really more of a tool for the
DBA to define the events for which they want to be notified or take some other action -- they aren't
really status event objects in the strictest sense, but for our purposes it helps to think of them that
way.

Event Instances

EVENT INSTANCES
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@query_result_separator ="},
@query_attachment_filename = 'queryresults2.txt'

Results:

Atkachrments: E] ueryresultsz

Titles List Eeport

oix

File Edit Format Miew Help
title_id,title . ]

PCLO35  ,But Is It User Friendly? .
PS1372  ,Computer Phobic aWD Non-Phobic Individuals: Behavior wariations,
BU1111 ,cCooking with Computers: surreptitious Balance sheets )
PS7777 ,Emotional Security: A Mew algorithm ,
TC4203 L, Fifty vears in Buckingham PaTace Kitchens .
Ps205%1 ,Is anger tThe Enemy? )
Ps2loa  ,Life without Fear ,
PCS985 | MNet Etiguette .
TC3218 ,onions, Leeks, and Garlic: Cooking secrets of the mediterranean,
PS3333  ,Prolonged Data Depriwvation: Four Case studies )
PCBE88  ,secrets of silicon valley ,
MZ2222  ,311dcon valley Gastronomic Treats .
BUFB32 ,straight Talk about Computers )
TCF777 ,sushi, Anyone? ,
BULO3Z ,The Busy Executive's Database Guide ,
MZ3021  ,The Gourmet Microwave ,
mMZ3026 ,The psychology of Computer Cooking )
BUZ07S ,¥ou Can Combat Computer Stress! .

4] 2

Enterprise Architecture

ENTERPRISE ARCHITECTURE

See topics on SQL Sentry Monitoring Service, Site Configuration, and Clustering for more information.
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Watched Server Objects

WATCHED SERVER OBJECTS

When a SQL Server instance is watched by SQL Sentry Event Manager , the below objects are
placed on the target server. To remove these objects, see the SQL Sentry Quick Start Guide :
Uninstalling SQL Sentry topic for additional information.

TABLES (MSDB):

SQLSentryAlertLog_20

SQLSentryEmails_20

SQLSentryDBEmails_20 (SQL Server 2005+)
SQLSentryDBEmail_Attachments_20 (SQL Server 2005+)
SQLSentryLogCache_20

SQLSentryLogCacheDTS_20

SQLSentryLogData_20

SQLSentryObjectVersion_20

SQLSentryQueuelLog_20

STORED PROCEDURES (MSDB):

spGetBlockinfo_20
spGetDTSLog_ 20
spGetdoblnfo_20
spQueueHeartbeat 20
spQueuedob_End_20
spQueuedob_Start 20
spQueueMonitor_20
spReadLogFile_20
spSetupAlertsTrap_20
spTrapAlert_20
sp_sentry_mail
sp_sentry_mail_20
sp_sentry_dbmail_20 (SQL Server 2005+)

FUNCTIONS (MSDB):

fnGetSQL_20
fnGetWaittypeDesc_20

SQL AGENT JOBS:

SQL Sentry 2.0 Alert Trap
SQL Sentry 2.0 Queue Monitor

Execute Action Parameters
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ADDITIONAL OPTIONS

Other options are available for the StepName and Message parameters. The StepName and
Message can also be passed using the format <%StepName:[/dentifier]%> or
<%Message:[/dentifier]%>. If the [Identifier] is a number then the value from that particular step
ID is used, starting with step 1.

Additionally, the [/dentifier] can also be one of the following values:

FirstStep — The value for the step name or message of the first completed step.
LastStep — The value for the step name or message of the last completed step.
FirstFailure — The value for the step name or message of the first failed step.
LastFailure — The value for the step name or message of the last failed step.

Example: INSERT INTO TABLE (MyCustomMessage) VALUES ('The last step failure was on
step <%StepName:LastFailure%> and the text for that was
<%Message:LastFailure>")

Repository Maintenance

REPOSITORY MAINTENANCE

Just as with any other SQL Server database, it is important that regular maintenance activities be
performed on the SQL Sentry database to ensure optimal performance. The following are
suggested practices for performing such maintenance.

WEEKLY

INDEX REBUILDS

Weekly Index rebuilds are recommended. SQL Sentry Fragmentation Manager can be used to
help you make intelligent decisions about index management in your environment. For more
information see the Fragmentation Manager topic.

NIGHTLY

DATABASE INTEGRITY CHECKS

Database integrity checks should be performed every night. They also can be scheduled through
a maintenance plan and will then be reflected in the SQL Sentry Client.

INDEX DEFRAGMENTATION

SQL Sentry Fragmentation Manager can be used to help you make intelligent decisions about
index management in your environment. For more information see the Fragmentation Manager
topic.

CONFIGURING THE REPOSITORY MAINTENANCE WINDOW

The Maintenance Window (‘Monitoring Service Settings'in the on-line documentation)
should also be configured with the  above activity scheduled within to avoid excessive Failsafe
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Notifications due to these activities.

Relocating the SQL Sentry Repository Database

RELOCATING THE SQL SENTRY REPOSITORY
DATABASE

Moving the SQL Sentry database to a new SQL Server instance is a straightforward process.
Following are the steps required to accomplish this:

1. Retrieve  the instance name for thenew SQL Server byrunning SELECT
SERVERPROPERTY('SERVERNAME') against it. Your license key is based on this instance
name.

2. Login to the  Customer Portal http://www.sqlsentry.net/portal and click View/Modify
Existing SQL Sentry Licenses , click the existing license name to editit, then enter the new
instance name from Step 1 to generate a new license. The license will be automatically emailed
to you when clicking Update. You can also retrieve the license immediately by clicking the
Details button.

3. Once you have received the new key, shut down all SQL Sentry Clients and Monitoring
services.

4. Perform a full backup of the SQL Sentry database.

5. Detach the database.

6. Move the associated data and log files.

7. Attach to the new server.

8. Openthe SQL Sentry Client on any machine with a Monitoring service. After failing to
locate the repository, the "Specify the SQL Sentry Database" window should appear. Enter the
new location information. The SQL Sentry  Client will alert you thatit has to be restarted to

connect to the new repository. On restarting, you will be asked for the new license key.

9. After successfully entering the license and starting the SQL Sentry Client, you may start the
Monitoring service on that machine.

10. Repeat steps 7 and 8 on any other machines with  Monitoring services. You will not be
asked for the license again, however.

11. You may now start any other SQL Sentry Client and enter the new repository location when
asked.

12. Don't forget to setup repository maintenance on the new server.

To remove an old server from the Connection List so that you will no longer be prompted about it when opening
the SQL Sentry Client:

1. Select the Server Name of the server you would like to remove in the “Please Specify the Server Name”
drop-down list, and press Shift + Delete.


http://www.sqlsentry.net/portal
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2. The new server should now be the only one listed in the drop-down list. Use the Connect command and
connect to the new installation.

The next time you open the Client it will automatically connect to the new installation.

Watching Servers Across Domains

WATCHING SERVERS ACROSS DOMAINS

It is possible to watch connections across domains with SQL Sentry even when there is no trust
relationship between them. The best option to  achieve this depends on the resources available
and number of servers you wish to watch.

ONE MONITORING SERVICE

If you only have the resources to install one SQL Sentry Monitoring Service for your environment,
oronly have  a couple servers in non-trusted domains  you wishto  watch, pass-through
authentication can be set up on  each server in the other domain.  This requires each watched
server on the other domain to have a local Windows account that has the identical login and
password as the SQL Sentry Monitoring Service service's domain account.  This must also have
sysadmin privileges on the watched SQL Server instance.

MULTIPLE SERVER SERVICES

Another option is to install a SQL Sentry Monitoring Service in each domain where you have
servers you wish to watch. This only requires pass-through authentication to be set up for each
Monitoring Service to the machine where the SQL Sentry repository is installed. You could then
create separate sites for each Monitoring Service to ensure that they only polled the servers in
their domain. The Enterprise Architecture Diagram provides an illustration with this setup.

Hot Key List

HOT KEYS

Below are the hot keys that are available in SQL Sentry:

[tom ______________Jkeys _ [MNotes

Help F1or Ctrl +H Opens the User
Guide.

Save Ctrl+S Saves changes made
in the console.

Close Ctrl+ W Closes the active tab
in the console.

Exit Ctrl + Q Closes the console.

User Preferences Ctrl + O Opens the User
Preferences window.

Print Ctrl+P Opens the Print

window.


http://www.sqlsentry.net/help/qs/Pass-through_Authentication.html
http://www.sqlsentry.net/help/qs/Pass-through_Authentication.html

